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Chapter 1

Welcome to Live

1.1 The Ableton Team Says: Thank You

Live is the result of musicians wanting a better way to compose, improvise and perform music using
a computer. A lot of effort has been put into making Live easy and fun to use, yet still capable of
helping you create music with unlimited depth and sophistication. This effort continues, even as
you are reading these lines...in fact, a new, improved Live version might already be available for
download! Please check on our website now.

We hope you enjoy using Live and that it enhances your creative process. Should you have sugges-
tions about how we can improve Live, please let us know.

Your Ableton team.


http://www.Ableton.com/index.php?main=downloads
mailto:contact@Ableton.com
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1.2 What's New in Live 4?

1.2.1 MIDI Sequencing

e MIDI tracks and clips (see MIDI Clips and MIDI Files)

e MIDI recording (see Recording New Clips)

e QOverdub MIDI pattern build-up (see Overdub Recording MIDI Patterns)

e MIDI note editing and drawing (see Editing MIDI)

o Instruments and MIDI effects (see Working with Instruments and Effects)
e MIDI file import (see MIDI Files) and export (see Exporting MIDI Files)

e MIDI notes can be generated by the computer keyboard (see Playing MIDI With the Computer
Keyboard)

e MIDI clips can send bank and program changes (see Bank and Program Change)

1.2.2 Virtual Instruments and Plug-Ins

e Simpler, for sample-based sound creation (see Simpler)

® Impulse percussion sampler (see Impulse)

VST and Audio Units instrument support (see Using Plug-Ins)

Audio Units Plug-in effects supported (Mac 0S X) (see Audio Units Plug-Ins)

Improved plug-in window handling (see Showing Plug-In Panels in Separate Windows)
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1.2.3 Routing, Monitoring and Recording

® New, flexible track routing and I/0 (see Routing and I/0)

e Audio and MIDI input and output signals can be routed to and from tracks for submixes,
layering, etc. (see Internal Routings)

Up to twelve sends/returns per Live Set (see Return Tracks and the Master Track)

Simplified recording process (see Recording New Clips)

® Monitoring is managed in the track I/0 section (see Monitoring)

1.2.4 Clip Properties

e New launch options allow for automatic jamming (see Follow Actions)
® Groove setting for MIDI and audio clips (see Groove)

® Reverse button for reversing samples (see Reversing Samples)

The Clip View can be vertically resized for editing convenience

Follow option acts on Clip View as well as on Arrangement View

® Easier warping for multitrack samples (see Replacing the Clip's Sample)

1.2.5 Session View

o Session View scenes can store the tempo (see Tracks and Scenes)

o Session View scenes can be set up to advance automatically (see Tracks and Scenes)
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1.2.6 Miscellaneous

® Loop/Region markers are selectable objects for editing convenience (see The Arrangement
Loop)

¢ Working with the editing grid has been simplified (see Using the Editing Grid)

® Tracks can be created by dropping instruments, effects and files on empty mixer space (see
Audio and MIDI Tracks)

® New, integrated program lessons that cover the key features of Live (see Learn About Live)



Chapter 2

First Steps

When you have installed Live and run it for the first time, you will be presented with the Products
Preferences tab.

If you own Live, you can authorize your copy of the software by selecting it from the listed products
and clicking the “Unlock” button at the bottom of the window. Please see the chapter on unlocking
Live (see Unlocking Live) should you have questions or concerns that arise during the unlocking
process.

If you do not (yet) own Live, you can close the Preferences and proceed, as Live will run in Demo
Mode by default. In Demo Mode, you will be able to work with all of Live's features with the
exception of saving and exporting.
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2.1 Learn About Live

Live comes with a set of interactive “lessons” that take you step by step through the key features
of the program. The lessons can be opened via the Help menu or the Demos and Tutorials folder in
Live's File Browser. We highly recommend that you follow these lessons. Many users have told us
the lessons have helped them to get familiar with the program very quickly.

o i) &) (¥) Factory Content
@ Demaos and Tutorials
o Demo Sounds

1-Make Music with Live.als

. £Y  3-MIDI Instruments Fx.als

b | Sample Hits

@ i@l 4-Croating Patterns.als
()

We also recommend that you read the Live Basics chapter (see Live Basics), which encapsulates
everything that Live is and can do in a single chapter, and is therefore a worthwhile read for
both beginners and experienced users. The remaining chapters of this manual serve as an in-depth
reference for the material introduced in the Live Basics chapter.

2.1.1 Using the Info View and Index

Live's Info View tells you the name and function of the user interface element currently under the
mouse.

A Lesson in the File
Browser.
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If you require more information on a specific user interface element or topic, please consult this
reference manual. The index, found at the end of the reference manual, contains the names of all
user interface elements and will lead you to the relevant section.

2.2 The Main Live Screen

Most of your work in Live happens in the main Live screen. This screen consists of a number of
views. Each view manages a specific aspect of your project. As screen space is limited, the other
Live views cannot all be up at the same time.

Each one of the selector buttons at the screen borders calls up a specific view; click this one, for
instance, to access the Live devices.

)

To hide one of Live's views, thus freeing up screen space, click on the triangle-shaped button next

The Info View.

A View Selector.
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to it. To restore the view, click the button again.

You can run Live in Full Screen Mode by selecting “Full Screen” from the View menu. To leave Full
Screen Mode, click the button that appears in the lower right corner of the screen. Full Screen Mode
can also be toggled by pressing the F11 key.

You can adjust the main window’s horizontal split by dragging.

!»

You can select from among a set of “skins” (color schemes) for Live’s user interface using the Misc
Preferences Load Skin chooser. You can also select the system language from the Misc Preferences.

nlwav

nid.wav

rav

2.3 Set up Audio and MIDI Preferences

After learning about the interface and capabilities of the program, you will probably want to start
making music. You may want to configure a few preferences before doing so, in order to tell Live
about your studio hardware. Open the Live Preferences by going to the Options menu (or the Live
menu in Mac 0S X) and selecting the “Preferences” option.

® Please see the Audio Preferences chapter (see Audio Preferences Setup) for the steps to set-
ting up the “Audio” Preferences tab, which allows Live to run audio with your computer and
hardware setup.

e The “MIDI” Preferences tab is used to help Live recognize MIDI devices for three separate and
distinct purposes:

— Playing MIDI notes. To learn how to route an external device into Live for MIDI input,
please see the chapter on routing (see External MIDI In/Out).

A View Show/Hide Button.

Adjusting the Main Window
Split.
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— Controlling parts of the interface remotely. This subject is covered in detail in the chapter
on remote control (see MIDI and Key Remote Control).

- Syncing the program to an external sequencer or drum machine. Please see the manual
section on sync (see Synchronizing via MIDI) for details.



Chapter 3

Unlocking Live

Live is protected against illegal use by a copy protection scheme. This scheme has been designed to
meet the highest security standards while avoiding hassles for the customer. If you find this proce-
dure to be an inconvenience, please understand that the copy protection secures your investment:
It allows Ableton to provide you with support and continue developing Live.

Authorization of Ableton products takes place in the Preferences’ Products tab, which will appear
when you start Live for the first time. Here you can choose to authorize (“unlock”) or purchase any
Ableton products available to you, for example the Operator instrument (see Operator).

Please note that products such as Operator are sold separately from Live but are unlocked using the
same procedure described in the following sections. If they are available with your version of Live,
they will run in Demo Mode by default so that you can try them out.

10
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Products

This software incorporates 2 Ableton products that you can separately demo, buy
or unlock.

The Products Tab as it
Appears Upon Startup.

Clicking on any product listed in the Products tab will give you the option of unlocking or buying
that product. Please click the “Unlock” button here to complete the unlocking process in two steps.
If you have not yet purchased the product, you can do so online by clicking the “Buy” button.
You can always return to the Products Preferences tab later or visit the Ableton webshop to make a
purchase.


http://www.Ableton.com/index.php?main=shop

3.1. STEP 1: ENTERING YOUR SERIAL NUMBER

wversion

Complete Real-Time Music Production Platform

Ableton Live is the music-production solution that allows you to
spontaneously compose, record, remix, improvise and edit your musical
idaas. In Live 4, you will find a complete and inspiring approach to MIDI
sequencing, audio recording, drag-and-drop sampling, virtual instrument and
MIDI hardware support.

Live has not yet been uniocked and is therefore running in Dema Moda. In
Demo Mode, you can explore the product's functionality, but you cannot save
or axport your work.

Buy: Find out about buying options and buy Live onlina.

Uniock: Once you own Live, unlock Live using the Sarial Numbar you recaived
from Ableton

Demo: To continue using Live in Demo Moda, simply close this dialog.

3.1 Step 1: Entering Your Serial Number

12

As an owner of Live, you have received a Serial Number from Ableton, either via e-mail (if you

ordered Live directly from Ableton), or on a card as part of the Live package.

Selecting “Unlock” in the
Products Tab.
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Enter Your Serial Number

Please enter the Serial Number for Live which you received from Ableton

After selecting “Unlock” in the Products tab, you will be presented with six fields for typing in the
Serial Number. Each field holds four characters. The Serial Number is composed of numbers 0..9 and
letters A..F. If you accidentally type the wrong string into a field, the field turns red. When you have
successfully entered the Serial Number, click the “Ok” button to proceed.

The Serial Number identifies your ownership of Live. Because your Serial Number is a valuable good,
you should keep it in a safe place and out of reach of unauthorized hands. Please be aware that
sharing your Serial Number will render it unusable. The only way for Ableton technical support to help
vou get back your Serial Number if you lose it is via your registration data. Therefore, please register
your product, as otherwise you might lose your property!

3.2 Step 2: Unlocking Live

The second step of authorizing Live is called “unlocking.” Unlocking means associating your Serial
Number with a specific computer. Please be aware that the standard Live license grants you the right
to use Live on only one computer at a time. You can, however, unlock Live with your Serial Number
more than once under the legal and technical conditions described later (see Copy Protection FAQs).

3.2.1 The Unlock Key

For unlocking, you require an Unlock Key that can only be created by the Ableton server. Unlocking
therefore requires access to the internet. The computer from which you connect to the internet does

The Fields for Entering Your
Serial Number.


http://www.Ableton.com/index.php?main=register
http://www.Ableton.com/index.php?main=register
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not have to be the same computer for which you wish to unlock Live, but it does make things easier.

3.2.2 The Challenge Code

The Ableton server creates the Unlock Key from your Serial Number and a so-called Challenge Code.
The Challenge Code is a “fingerprint” that Live takes of your computer's components. For details,
please see the corresponding section (see Copy Protection FAQs).

3.2.3 Unlocking Online

Uniock Online

‘This method of unlocking Live is much faster and easier than unlocking
offline, as it is done automatically via the internet. if this computer is
connected to the internst, please press the ‘Unlock Onling’ button.

Unlocking Live Online.

If the computer you want to unlock Live for is connected to the internet, the only thing you need to
do is press the “Unlock Online” button. Live will then make a connection to the Ableton server, send
your Serial Number and Challenge Code to the server, and receive the Unlock Key from the server. No
information other than this is exchanged between your computer and the Ableton server.
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3.2.4 Unlocking Offline

C Cancel D Unlocking Live Offline.

If the computer you want to unlock Live for is not connected to the internet, you can use any other
computer to access the Ableton server's web interface. This is a website with fields for entering your
Serial Number and the Challenge Code, which you can copy from Live’s Unlock dialog.

Tour Serial Murmber:
RS e Y 6 1 SO ) N 1 P

Challenge Code of your computer:

The Live Unlocking Web
Site.

If you have entered your Serial Number and Challenge Code correctly, another website will appear to


http://www.Ableton.com/index.php?main=unlock
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provide you with the Unlock Key. There now are two options for transferring the Unlock Key to the
computer that is to be unlocked:

Follow the web link to download the Unlock Key as a file. Transfer the file to the target computer via
a diskette or CD-ROM. Then, press the Unlock dialog’s “Load Unlock Key” button to load the Unlock
Key file.

MAC: Please hold the Option key while clicking here and the Unloclk Key should
begin to download,

PC: Please right click here and save the Unlock kKey to disl,

Transfer the Unlocl Key (Unlock_ w0 mm-mm - m - tet) to the computer
where Live is installed. Start Live and in the Live unlock dialog press "Load Unlock
Key", Finally, load the Unlock Key in the file selection dialog.

Note: If transferring the file to the computer seems too inconvenient, and you are
already using Live 2.1, you can enter the Unlock Key manually,

The Unlock Key Can Be
Downloaded as a Text File.

OR it might be more convenient to print the webpage with the Unlock Key on it. On the target
computer, press the “Enter Unlock Key” button to open a dialog with fields for typing in the Unlock
Key. Typing it in is easier than it first appears because the fields turn red if you type the wrong
string.
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For sarme of vou it might be more convenient to manually enter the Unlock Key
instead of transferring it to the computer where Live is installed. with Live 2.1 you
can do this by pressing the "Enter Unlock Kevy" button in the unlock dialog and
entering the number below, Because it is such a lang nurmber you should print this
page to avoid any typing rmistakes.,

Note: The Unlock Key is case sensitive.

Unlock Key:

n?chDoén — REZEDWz - c@5PddH

EZFOECH - 7v?2zT0 - +4ceJE3

@JrfBevr — g4PFrMH - G&dIHCs

Ploasa enter your Unlock Kay

Manually Enter Your Unlock
Key.

3.3 Copy Protection FAQs

3.3.1 Can I Run Live Without a Serial Number?

If you do not (yet) own Live, you can work with Live in Demo Mode. Demo Mode offers Live's
complete functionality, but saving and exporting are disabled. Live will run in Demo Mode by
default if it has not been authorized.
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Complete Real-Time Music Production Platform

Ableton Live is the music-production solution that allows you to
spontansously compose, record, remix, improvise and edit your musical
ideas. In Live 4, you will find a complete and inspiring approach to MIDI
sequancing, audio recording, drag-and-drop sampling, virtual instrument and
MIDI hardware support.

Live has not yet been unlocked and is therafore running in Demo Maoda. In
Demo Mode, you can explore the product's functionality, but you cannot save
or axport your work.

Buy: Find out about buying options and buy Live onlina.

Unlock: Once you own Live, unlock Live using the Sarial Number you recelved
from Ablaton

Demo: To continue using Live in Demo Mode, simply close this dialog

El D Click Here if You Are

Interested in Buying Live.

If running Live in Demo Mode raises your interest in purchasing the full version of Live, please
select Live from the Products Preferences tab, and then click the “Buy” button, or visit the Ableton
webshop. This site contains information about Ableton’s distributor and dealer network. It also
offers you the opportunity to buy Live online.

3.3.2 What if I Change My Computer's Components?

If the Challenge Code of your computer changes for some reason, Live will indeed ask you to unlock
the software another time (see Can I Unlock Live More Than Once?). The Challenge Code does
not change, however, when computer peripherals are replaced (audio or MIDI hardware, printers,


http://www.Ableton.com/index.php?main=shop
http://www.Ableton.com/index.php?main=shop
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modems). The Challenge Code may change if the motherboard, processor or network card is replaced.
On some computers, reformatting a hard drive also changes the Challenge Code.

3.3.3 CanI Unlock Live More Than Once?

The standard Live license allows you to use Live on only one computer at a time. If you have
registered your product, the Ableton server will, however, provide you with two Unlock Keys in
good faith that you will use Live on only one machine at a time. Just proceed as described in the
corresponding section (see Step 2: Unlocking Live).

You can, therefore, run Live on both a studio desktop computer and a tour laptop, but not at the
same time. If you are using a Macintosh and switching back and forth between 0S 9 and 0S X, you
can unlock Live on both systems.

Should the Ableton server reject your demand for another Unlock Key, please contact Ableton’s
technical support. They can be reached by:

® E-mail;
o telephone: +49 (0)30 - 288 763 151 (available Monday to Friday 11 to 15hrs CET);
o fax: +49 (0)30 - 288 763 11.
To speed up the process, please:
® register your copy of Live;
¢ include a brief explanation of the circumstances.

To use Live on more than one computer at a time, you require a Secondary License or a Site License.
Ableton offers these licenses at special rates. Please contact the sales team for details.


http://www.Ableton.com/index.php?main=register
mailto:support@Ableton.com
http://www.Ableton.com/index.php?main=register
mailto:orders@Ableton.com
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3.3.4 CanI Play my Set From a Computer That Is not Unlocked?
In Demo Mode, you can load and perform a Live Set with no time limitation. You cannot, however,
save or export your work. When you go on tour, consider taking along your Live program CD and a

CD with the last state of your Live Set(s). In case of an emergency, you can install and run Live on
any computer available and play your backup Live Set(s).

3.3.5 What Do I Do About Problems or Questions Regarding Copy Protection?

Please contact technical support. They are happy to help!


mailto:support@Ableton.com

Chapter 4

Live Basics

This chapter introduces the essential concepts behind Live. We advise you to read this chapter early
in your Live career, as a solid understanding of the program’s basic principles will help you fully
exploit Live's potential for your music-making.

4.1 Live Sets

The type of document that you create and work on in Live is called a Live Set (see Creating and
Saving Sets). Live Sets can be opened either through the File menu’s Open command or via the
built-in File Browsers. Several Live Sets are installed with Live and show up in the Browser when
Live is first launched. Double-clicking a Live Set’s name opens that Live Set.

21
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4.2 Arrangement and Session

The basic musical building blocks of Live are called clips. A clip is a piece of musical material: a
melody, a drum pattern, a bass line or a complete song. Live allows you to record and alter clips,
and to create larger musical structures from them: songs, remixes, DJ sets or stage shows.

A Live Set consists of two environments that can hold clips: The Arrangement is a layout of clips
along a musical timeline; the Session is a real-time oriented “launching base” for clips. Every Session
clip has its own play button that allows launching the clip at any time and in any order. Each clip’s
behavior upon launch can be precisely specified through a number of settings (see Launching Clips).

Juw reved _.UW REVE] [cr2L [uwREVERB |
> ___ Clips in the Session View
e (Left) and in the

[ ezt |[Frrama | ] Arrangement View (Right).

The Arrangement is accessed via the Arrangement View (see Arrangement View) and the Session via
the Session View (see Session View); you can toggle between the two views using the computer’s
Tab key or their respective selectors. Because the two views have distinct applications, they each
hold individual collections of clips. However, it is important to understand that flipping the views
simply changes the appearance of the Live Set, and does not switch modes, alter what you hear or
change what is stored.

KEY | MIDI 34 %

T E
Master The Arrangement and

1 . 3
Session View Selectors.

Arrangement and Session interact in useful (though potentially confusing) ways. One can, for
instance, improvise with Session clips and record a log of the improvisation (see Recording Sessions
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into the Arrangement) into the Arrangement for further refinement. This works because Arrangement
and Session are connected via tracks.

4.3 Tracks

Tracks host clips and also manage the flow of signals, the creation of new clips through recording,
sound synthesis, effects processing and mixing.

3.3 3.4 4 4.2 4.3 4.4 5 52116 | & || 8
[ekzL ] [eiz.L | w1 .Audio o = el 1 i
TRawi  fweevess o (A 2Awde (@] (s]e] 2 |
[Mone [0 [0 4

A Track in the Arrangement
View.

..Track 0 ¥ 4 MIDI B EE 4 |

Session and Arrangement share the same set of tracks. The tracks are vertically laid out from left to
right in the Session View, and horizontally from top to bottom in the Arrangement View. A simple
rule governs the cohabitation of clips in a track:

A track can only play one clip at a time.

Therefore, one usually puts clips that should play alternatively in the same Session View column,
and spreads out clips that should play together across tracks in rows, or so-called scenes (see Tracks
and Scenes).
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The exclusivity of clips in a track also implies that one track, at any time, will either play a Session
clip or an Arrangement clip, but never both. So, who wins? When a Session clip is launched, the
respective track stops whatever it was doing before to play that clip. In particular, if the track was
playing an Arrangement clip, it will stop it in favor of the Session clip- even as the other tracks
continue to play what is in the Arrangement. The track will not resume Arrangement playback until
explicitly told to do so.

This is what the Back to Arrangement button, found in the Control Bar at the top of the Live screen,
is for. This button lights up to indicate that one or more tracks are currently not playing the
Arrangement, but are playing a clip from the Session instead.

We can click this button to make all tracks go back to the Arrangement. Or, if we like what we hear,
we can capture the current state into the Arrangement by activating the Record button. Disengaging
Record Mode or stopping Live using the Stop button leaves us with an altered Arrangement- as can
be verified by clicking the Play button to replay the Arrangement. (Note that you can also use the
computer’s space bar to start and stop.) Creating and refining Arrangements by improvising with
Session clips is one of Live's core applications.

A Scene in the Session
View.

The Play, Stop, Record and
Back to Arrangement
Buttons.
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4.4 Audio and MIDI

Clips represent recorded signals. Live is dealing with two types of signals: audio and MIDI. In
the digital world, an audio signal is a series of numbers that approximates a continuous signal as
generated by a microphone or delivered to a loudspeaker. A MIDI signal is a sequence of commands,
such as “now play a C4 at mezzo piano.” MIDI is a symbolic representation of musical material, one
that is closer to a written score than to an audio recording. MIDI signals are generated by input
devices such as MIDI or USB keyboards.*

It takes an instrument (see Working with Instruments and Effects) to convert MIDI signals into
audio signals that can actually be heard. Some instruments, such as Live’s Simpler, are for chromatic
playing of one sound via the keyboard. Other instruments, such as Live's Impulse, have a different
percussion sound assigned to each keyboard key.

Audio signals are recorded and played back using audio tracks, and MIDI signals are recorded and
played back using MIDI tracks. The two track types have their own corresponding clip types. Audio
clips cannot live on MIDI tracks and vice versa.

Information about inserting, reordering and deleting audio and MIDI tracks is found here (see Audio
and MIDI Tracks).

4.5 Audio Clips and Samples

An audio clip contains a reference to a sample (also known as a “sound file” or “audio file”). The
clip tells Live where on the computer’s drives to find the sample, what part of the sample to play
and how to play it.

When a sample is dragged in from one of Live’s built-in File Browsers (see Working with the File
Browsers), Live automatically creates a clip to play that sample. Prior to dragging in a sample, one

For an introduction to digital audio and MIDI, please see http://img.uoregon.edu/emi/emi.php and http://www.midi.org/
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can audition or preview it directly in the Browser; the switch in the Browser with the headphone
icon activates previewing.
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Samples are Dragged in
from Live’s File Browsers.

Live offers many options for playing samples in exciting new ways, allowing you to create an abun-
dance of new sounds without actually changing the original sample- all the changes are computed
in real time, while the sample is played. The respective settings are made in the Clip View (see Clip
View), which appears on screen when a clip is double-clicked.
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Many powerful manipulations arise from Live's warping (see Time-Warping Samples) capabilities.
Warping means changing the speed of playback independently from the pitch, or vice versa. The most
elementary use of this technique, and one that requires almost no manual setup, is synchronizing
sample loops to the chosen tempo. With a bit more setup, warping allows you to line up any sample
with the chosen tempo, such as a recording of a drunk jazz band’s performance, or to radically
change the sonic signature of a sound. To verify, change the project tempo while clips are playing
by clicking in the Control Bar's Tempo field and dragging up and down.
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4.6 MIDI Clips and MIDI Files

A MIDI clip contains musical material in the form of MIDI notes and controller envelopes. When
MIDI is imported from a MIDI file (see Working with the File Browsers), the data gets incorporated
into the Live Set, and the original file is not referenced thereafter. In the Live Browsers, a MIDI
file appears as a folder that can be opened to reveal its individual component tracks, which can be
selectively dragged into the Live Set.

An Audio Clip’s Properties
as Displayed in the Clip
View.

The Control Bar's Tempo
Field.
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As expected, a MIDI clip’s contents can be accessed and edited (see Editing MIDI Notes and
Velocities) via the Clip View, for instance to change a melody or “paint” a drum pattern.
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MIDI Files are Dragged in
from Live’s File Browsers.

A MIDI Clip’s Properties as
Displayed in the Clip View.
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4.7 Devices and the Mixer

A track can have, not only clips, but also a chain of devices (see Working with Instruments and

Effects) for processing signals. Double-clicking a track’s title bar brings up the Track View, which
shows the track’s device chain.
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an Audio Track’s Device
Chain.

Live's built-in audio effects (see Live Audio Effect Reference), MIDI effects (see Live MIDI Effect
Reference) and instruments (see Live Instrument Reference) are available from the Device Browser
and can be dragged from there into the Track View, or onto a Track Title Bar.
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You can also use plug-in devices (see Using Plug-Ins) in Live. VST and Audio Units (Mac OS X only)
plug-ins are available from the Plug-In Device Browser.
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Consider an audio clip playing in an audio track. The audio signal from the clip reaches the leftmost
device in the chain. This device processes (changes) the signal and feeds the result into the next
device, and so on. The number of devices per track is theoretically unlimited. In practice, the
computer’s processor speed does impose a limit on the number of devices you can use at the same
time, a topic that deserves separate discussion (see Managing the CPU Load). Note that the signal
connections between audio devices are always stereo, but the software’s inputs and outputs can be
configured to be mono (see Configuring Audio Device Channels).

When the signal has passed through the device chain, it ends up in Live’s mixer (see The Live Mixer).
As Session and Arrangement share the same set of tracks, so they share the mixer. The mixer can be
shown in both views for convenience. To optimize the screen layout, the individual mixer sections
can be shown or hidden using the View menu’s entries.



4.7. DEVICES AND THE MIXER 32

]

l | | Stop Clips

<l

The Live Mixer in the
Arrangement View (Above)
and Session View (Below).

-BERD

=
EEO

_—=
2] }C

=
-8

(l) n
€

The mixer has controls for volume, pan position, and sends, which adjust the contribution each clip
track makes to each return track’s input. Return tracks cannot host clips, only effects. Via their
sends, all tracks can feed a part of their signal into the return track and share its effects.

The mixer also includes a crossfader (see Using Live's Crossfader) that can create smooth transitions
between clips playing on different tracks. Live’s crossfader works like a typical DJ mixer crossfader,
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except that it allows crossfading not only two, but any number of tracks- including the returns.

Devices that receive and deliver audio signals are called audio effects. Audio effects are the only
type of device that fit in an audio track or a return track. Two more types of devices are available,
however, for use in MIDI tracks: MIDI effects and instruments.

Consider a MIDI track playing a clip. The MIDI signal from the clip is fed into the track’s device
chain. There, it is first processed by any number of MIDI effects. A MIDI effect receives and delivers
MIDI signals. One example is the Scale effect, which maps the incoming notes onto a user-defined
musical scale. The last MIDI effect in the chain is followed by an instrument. Instruments, for
instance Live's Simpler and Impulse, receive MIDI and deliver audio. Following the instrument, there
can be any number of audio effects- as in an audio track.

Live’s Crossfader.
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If a MIDI track has no instrument (and no audio effects), then the track’s output is a plain MIDI
signal, which has to be sent somewhere else to be converted into audio. In this case, the track’s
mix and Send controls disappear from the mixer.
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4.8 Routing

As we have seen, all tracks deliver signals, either audio or MIDI. Where do these signals go? This is
set up in the mixer’s In/Out section, which offers, for every track, choosers to select a signal source
and destination. The Session mixer’'s In/Out section, accessible through the View menu’s “In/Qut”
entry, is Live's “patchbay.” Its routing options (see Routing and I/0) enable valuable creative and
technical methods such as resampling, submixing, layering of synths, complex effects setups and

more.
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Signals from the tracks can be sent to the outside world via the computer’s audio and MIDI interfaces,
to other programs that are connected to Live via Relire (see Connecting via ReWire), or to other
tracks or devices within Live.

Likewise, a track can be set up to receive an input signal to be played through the track’s devices.
Again, tracks can receive their input from the outside, from a ReWire program, or from another track
or device in Live. The Monitor controls regulate the conditions under which the input signal is heard
through the track.
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4.9 Recording New Clips

Audio tracks and MIDI tracks can record their input signal, and thereby create new clips (see
Recording New Clips). Recording is enabled on a track by pressing its Arm button (Hold down
the (Cul ) (PC) / (G % (Mac) modifier to arm several tracks at once). When the Control Bar's
Record button is on, every armed track records its input signal into the Arrangement. Every take
yields a new clip per track.
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It is also possible to record into Session View slots, on the fly (see Recording Into Session Slots). This
technique is very useful for the jamming musician, as Session recording does not require stopping the
music. When a track is armed, its Session slots exhibit Clip Record buttons, and clicking one of these
commences recording. Clicking the Clip Record button again defines the end of the recording and
launches the new clip. As these actions are subject to real-time launch quantization, the resulting
clips can be automatically cut to the beat.

+| 322. 3. 3|p|m| 0| SN =],

Session recording in conjunction with the Overdub option and Record Quantization is the method of
choice for creating drum patterns, which are built up by successively adding notes to the pattern

An Armed Track, as Appears
in the Session View.

The Control Bar’s
Quantization Chooser.



4.10. AUTOMATION ENVELOPES 37

while it plays in a loop. It only takes a MIDI keyboard (or the computer keyboard) and a MIDI track
with Live’s Impulse percussion instrument to do this (see Overdub Recording MIDI Patterns).

4.10 Automation Envelopes

Often, when working with Live’s mixer and effects, you will want the controls” movements to become
part of the Arrangement. The movement of a control across the Arrangement timeline is called
automation (see Automation and Editing Envelopes); a control whose value changes in the course
of this timeline is automated. Automation is represented in the Arrangement View by breakpoint
envelopes, which can be edited and drawn.

e [ @ |[ 5

ci-2.1 ci-2.1 | ¥ 1 Audio

W BEVERR A 2 Aydia
|I Mizer | | 0 |r 2L

[Ealn Suman - 1 Mn!

Practically all mixer and effect controls in Live can be automated, even the song tempo. Creating
automation is straightforward: all changes of a control that occur while the Control Bar's Record
switch is on become automation.

Changing an automated control’s value while not in Record Mode is similar to launching a Session
clip while the Arrangement is playing: It deactivates the control’s automation (in favor of the new
control setting). The control will stop tracking its automation and rest with the new value until the
Back to Arrangement button is pressed, which will resume Arrangement playback.

The Automated Pan Control
and its Envelope.



4.11. CLIP ENVELOPES 38

4.11 Clip Envelopes

Envelopes cannot only be found in tracks, but also in clips. Clip envelopes (see Clip Envelopes)
are used to modulate device and mixer controls. Audio clips have, in addition, clip envelopes to
influence the clip’s pitch, volume and more; these can be used to change the melody and rhythm
of recorded audio. MIDI clips have additional clip envelopes to represent MIDI-controller data. Clip
envelopes can be unlinked from the clip to give them independent loop settings, so that larger
movements (like fade-outs) or smaller gestures (like an arpeggio) can be superimposed onto the
clip’s material.

4.12 MIDI and Key Remote

To liberate the musician from the mouse, most of Live's controls can be “remote-controlled” via an
external MIDI controller. The remote mappings are established in MIDI Map Mode (see Assigning
MIDI Remote Control), which is engaged by pressing the MIDI switch in the Control Bar.

In this mode, you can click on any mixer or effect control, then assign it to a controller simply by
sending the desired MIDI message (for example, by turning a knob on your MIDI control box). Your
assignments take effect immediately after leaving MIDI Map Mode. Session clips can be mapped to
a MIDI key or even a keyboard range for chromatic playing.

MIDI keys and controllers that have been mapped to Live’s controls are not available for recording
via MIDI tracks. These messages are filtered out before the incoming MIDI is passed on to the MIDI
tracks.

11]_Lm_/_]1]:'ﬂ°}u[)

Session clips, switches, buttons and radio buttons can be mapped to the computer keyboard keys as

The Key/MIDI Map Controls.
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well. This happens in Key Map Mode (see Keyboard Remote Control), which works just like MIDI Map
mode.

4.13 Saving and Exporting

Saving a Live Set saves everything it contains, including all clips, their positions and settings, and
settings for devices and controls. An audio clip can, however, lose the reference to its corresponding
sample if it is moved or deleted from disk. The links between samples and their clips can be
preserved with a special command, the Save Set Self-Contained command (see The Sounds Folder
and Self-Containing), which makes a copy of each sample and stores it in a “Sounds” folder along
with the Live Set.

A separate Save button in the Clip View saves a set of default clip settings (see Saving Default Clip
Settings with the Sample) along with the sample, so that each time the sample is dragged into the
program, it will automatically appear with these settings. This is especially useful if you have made
warp settings for a clip and want to use it in multiple Live Sets.

Exporting your work in Live can be done from both the Session and Arrangement Views. Live will
export the audio coming through on the Master output as an audio file of your specifications, via
Render to Disk (see Exporting Audio). Live can also export individual MIDI clips as MIDI files (see
Exporting MIDI Files).



Chapter 5

Audio Preferences Setup

To set up Live for audio input and output, you will need to configure a few preferences. This is a
process that only needs to be done once for a given hardware setup. Open Live's Preferences from
the Options menu (or the Live menu in Mac 0S X); then, click on the “Audio” tab.

In order to work with an audio application such as Live, your computer needs an audio driver
that allows communication between the software (in this case, Live) and the hardware (your audio
interface or soundcard). Audio driver type depends upon the computer platform and audio interface
in use. If you purchased a special audio driver or have one installed because it came with your
studio hardware, you can choose to use it with Live instead of the default audio driver that came
with your computer. Live supports the following audio driver types for each computer platform:

* Windows
- MME/DirectX (see MME/DirectX) (default)
— ASIO (see ASIO)

40
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- Direct I/0 (see Direct I/0) (for use with Digidesign products)
® Mac 0S X

- CoreAudio (see CoreAudio) (default)
® Mac 059

- Sound Manager (see Sound Manager) (default)

- ASIO (see ASIO)

- Direct I/0 (see Direct I/0) (for use with Digidesign products)

The Driver Type chooser in the Audio Preferences shows the currently selected audio driver type.
The Audio Preferences are different depending upon which driver type is being used. Go to the
appropriate section among the following to set up preferences for your driver type.

5.1 Audio Preferences by Driver Type

5.1.1 MME/DirectX

When using MME/DirectX, it is only possible to access one stereo input and one stereo output
channel of your audio interface, even if your interface provides multichannel capabilities. Therefore,
ASIO drivers are the preferred choice for any serious audio application. ASIO drivers are available for
almost every professional audio I/0 interface. Check with your audio hardware’s vendor if you are
unsure about whether your interface supports ASIO.

If you are using MME/DirectX, do the following to set up your Audio Preferences:

1. Select the audio device(s) that you want to use with Live from the Input and Output Audio
Device choosers. Your options in these choosers depend entirely on your individual software
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and hardware setup- you might be offered anything from your computer’s built-in soundcard
to an external audio interface.

2. Select the desired Sample Rate for recording. If you want to know more about this setting and
what Live does with it, please read the Sample Rate section (see Selecting a Sample Rate).

3. Please read the section on the Overall Latency adjustment (see Adjusting the Overall Latency)
to find out about this setting.

4. You can set up your audio device’s input and output in the Input and Output Configuration
dialogs (see Configuring Audio Device Channels). Note that, if you have a multichannel audio
device, MME/DirectX drivers will only allow you access to one stereo pair for input and one for
output.

5. The Input and Output Buffer Size controls are used to adjust for latency. The term latency
refers to the time it takes for sound from the audio device’s inputs to become available to the
software, and for sound generated or processed by the software to arrive at the audio device’s
outputs.

Latency is an undesirable, yet unavoidable fact of processing audio on a standard computer.
All calculations necessary for audio are handled by the CPU. Audio software reads and writes
audio in chunks, which are collected in buffers, in order to reduce the CPU load, and to have a
“reservoir” of incoming or outgoing audio available for times when the processor must attend
to some other task. Smaller buffers therefore create less latency but add stress to the CPU.
The Buffer Size controls allow finding the smallest possible buffer size that your computer can
handle without troublesome stress to the CPU.

Do the following to find a suitable Output Buffer Size setting for your setup:

(a) Start with an empty Live Set that has at least two audio tracks.



5.1. AUDIO PREFERENCES BY DRIVER TYPE 43

(b)

(c)
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Find a good sample to use for testing: We want to use a sustained sound rather than
a sound that contains a lot of silence. It is best not to use percussion, or sounds
containing distortion or noise, since what we will be listening for is clicking or popping
sounds. Drag the sample from the Browser into the first audio track, and launch the clip.
Now you should hear this clip and see its level in the level meter.

In the second track, switch off the Track Activator. Then, drag your test sample into this
track as well, and launch the clip. Now both clips will be playing, but you will only hear
the signal from the first track, as the second track is deactivated. (Notice that it has a
gray level meter.)
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Launching a Test Clip in the
First Track.

Switch the Second Track
Off, and Notice the Gray
Level Meter.
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(d) The second track will be used only to “simulate” CPU traffic. To do this, drag effects one
at a time from Live’s Device Browser into the track. While doing this, keep an eye on the
CPU Level Meter in the upper right corner. Add effects until this display shows a value
close to 70 percent.
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Master

Bringing the CPU Level up
to 70 Percent.
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(e) Open the Audio Preferences and set the Output Buffer Size control to its lowest value.
You will probably hear clicks or dropouts in the audio. Slowly increase the Output Buffer
Size until the clicks or dropouts become inaudible. Find a value just high enough that
the signal passes through undisturbed.

6. Now, to adjust the Input Buffer Size control, you will pass a sound from some external source
(an instrument, a CD player, etc.) to the physical input of your audio interface. This sound
should be of the same type used to adjust the Output Buffer Size control (i.e., no percussion,
distortion or noise). Once you have selected your external sound and made the appropriate
hardware connections, proceed as follows to adjust the Input Buffer Size control:

(a) Stop playback in both clips by pressing the square Clip Stop buttons at the bottom of
the tracks.

(b) Activate the second track (the one containing the effects) with its Track Activator switch.
Select “Ext. In” from its Input Type chooser.

(c) Select a channel on which to monitor from the Input Channel chooser. You will see small
level meters next to the entries that have incoming signals.

(d) Activate the “On” Monitor button. You should now hear the input signal being processed
by the effects you have inserted into the track.



5.1. AUDIO PREFERENCES BY DRIVER TYPE 45

ii M

(e) Set the Input Buffer Size slider to its lowest value. You will once again hear clicks
and dropouts in the audio. Slowly increase the Input Buffer Size until you no longer
hear dropouts or clicks. Find a value just high enough that the signal passes through
undisturbed.

Note that lower latencies add more stress to the CPU. In situations where adding a few more
plug-ins or tracks sends your system “over the edge,” increasing latency a little bit may allow
it to accommodate the extra load.

5.1.2 ASIO

If you are using ASIO, do the following to set up the rest of your Audio Preferences:

1. Select the audio device that you want to use with Live from the Audio Device chooser. Your
options in this chooser depend entirely on your individual software and hardware setup- you
might be offered anything from your computer’s built-in soundcard to a multichannel audio
interface.

2. Select the desired Sample Rate for recording. If you want to know more about this setting and

From Top to Bottom: The
Input Type and Channel
Choosers, Monitoring “On”
Switch and the Track
Activator Switch.
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what Live does with it, please read the Sample Rate section (see Selecting a Sample Rate).

3. Please read the section on the Overall Latency adjustment (see Adjusting the Overall Latency)
to find out about this setting.

4. If you have a multichannel audio device, you can set up your audio device’s inputs and outputs
in the Input and Output Configuration dialogs (see Configuring Audio Device Channels). These
dialogs determine which of your individual input and output channels appear as routing op-
tions in Live's track In/Out section (see Routing and I/0), and whether they appear as mono,
stereo or both.

5. The Clock Source setting is only available if your interface supports several audio clock sources.
Audio clocks each use different bases, so they eventually begin to run out of sync (just like
most clocks everywhere). Since an audio clock controls the sampling rate (in Hz), it might be
helpful to sync the audio clocks of two connected devices together when recording into Live.

This setting would be useful if, for example, you were using Live to record from a CD player
with a digital output via the digital input on your audio interface. You could define the digital
input of the interface (i.e., the CD player’s audio clock) as Clock Source, and thereby avoid
having the interface and CD player run out of sync.

6. Click on the Hardware Setup button. The contents of this dialog will depend entirely on
your audio device, however they should include a “buffer size” or “latency” setting. The term
latency refers to the time it takes for sound from the audio device’s inputs to become available
to the software, and for sound generated or processed by the software to arrive at the audio
device’s outputs.

Latency is an undesirable, yet unavoidable fact of processing audio on a standard computer.
All calculations necessary for audio are handled by the CPU. Audio software reads and writes
audio in chunks, which are collected in buffers, in order to reduce the CPU load, and to have a
“reservoir” of incoming or outgoing audio available for times when the processor must attend
to some other task. Smaller buffers therefore create less latency but add stress to the CPU.
The steps that follow will help you find the smallest possible latency or buffer size setting
that your computer can handle without troublesome stress to the CPU.
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If the Hardware Setup button is unavailable, or if nothing happens when you click this button,
vou need an external application or panel provided by your audio interface vendor to make
latency settings. For more information, please see the documentation that came with your
interface or consult the vendor directly.

(a) Start with an empty Live Set that has at least two audio tracks.

Launching a Test Clip in the
First Track.

(b) Find a good sample to use for testing: We want to use a sustained sound rather than
a sound that contains a lot of silence. It is best not to use percussion, or sounds
containing distortion or noise, since what we will be listening for is clicking or popping
sounds. Drag the sample from the Browser into the first audio track, and launch the clip.
Now you should hear this clip and see its level in the level meter.

(c) In the second track, switch off the Track Activator. Then, drag your test sample into this
track as well, and launch the clip. Now both clips will be playing, but you will only hear
the signal from the first track, as the second track is deactivated. (Notice that it has a
gray level meter.)
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(d) The second track will be used only to “simulate” CPU traffic. To do this, drag effects one
at a time from Live’s Device Browser into the track. While doing this, keep an eye on the
CPU Level Meter in the upper right corner. Add effects until this display shows a value
close to 70 percent.
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(e) Open the Audio Preferences’ Hardware Setup dialog, and set the “buffer size” or “latency”
control to its lowest value. One of three things will now happen:

® The quality of the sound will change, and you will probably hear clicks or dropouts in
the audio. If this is the case, slowly increase the “buffer size” or “latency” control
until the clicks or dropouts become inaudible. Find a value just high enough that
the signal passes through undisturbed.

® You will receive a message or dialog asking you to close the Hardware Setup panel.
If this is the case, close the panel and listen to the track you are playing. You will
probably hear clicks or dropouts in the audio. To find a suitable setting, reopen the
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Hardware Setup dialog, slightly increase the “buffer size” or “latency” control, close
the dialog again, and listen to the audible result. Repeat this process until you find
a setting just high enough that the signal passes through undisturbed.

¢ You will be prompted to close the Hardware Setup dialog and to deselect the audio
interface. If this is the case, close the dialog and set Live’s Audio Preferences Audio
Device chooser to “No Device.” Then, reselect the Audio Device so that you can
listen to the Live track you are playing. You will probably hear clicks or dropouts
in the audio. To find a suitable setting, reopen the Hardware Setup dialog, increase
the “buffer size” or “latency” control slightly, close the dialog again, deselect and
select the audio device, and listen to the audible result. Repeat this process until
you find a setting just high enough that the signal passes through undisturbed.

Note that lower latencies add more stress to the CPU. In situations where adding a few more
plug-ins or tracks sends your system “over the edge,” increasing latency a little bit may allow
it to accommodate the extra load.

5.1.3 CoreAudio

If you are using CoreAudio, do the following to set up your Audio Preferences:

1. Select the audio device(s) that you want to use with Live from the Input and Output Audio
Device choosers. Your options in these choosers depend entirely on your individual software
and hardware setup- you might be offered anything from your computer’s built-in soundcard to
a multichannel audio interface. Though CoreAudio allows you to select two different devices
for input and output, we recommend selecting the same device for both in order to avoid
potential problems.

2. Select the desired Sample Rate for recording. If you want to know more about this setting and
what Live does with it, please read the Sample Rate section (see Selecting a Sample Rate).
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3. Please read the section on the Overall Latency adjustment (see Adjusting the Overall Latency)
to find out about this setting.

4, If you have a multichannel audio device, you can set up your audio device’s inputs and outputs
in the Input and Output Configuration dialogs (see Configuring Audio Device Channels). These
dialogs determine which of your individual input and output channels appear as routing op-
tions in Live's track In/Out section (see Routing and I/0), and whether they appear as mono,
stereo or both.

5. The Buffer Size control is used to adjust for latency. The term latency refers to the time it
takes for sound from the audio device’s inputs to become available to the software, and for
sound generated or processed by the software to arrive at the audio device’s outputs.

Latency is an undesirable, yet unavoidable fact of processing audio on a standard computer.
All calculations necessary for audio are handled by the CPU. Audio software reads and writes
audio in chunks, which are collected in buffers, in order to reduce the CPU load, and to have a
“reservoir” of incoming or outgoing audio available for times when the processor must attend
to some other task. Smaller buffers therefore create less latency but add stress to the CPU.
The Buffer Size control allows finding the smallest possible buffer size that your computer can
handle without troublesome stress to the CPU. Do the following to find a suitable Buffer Size
setting for your setup:

(a) Start with an empty Live Set that has at least two audio tracks.
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(b)

(c)

1 Audio 2 Audio
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Find a good sample to use for testing: We want to use a sustained sound rather than
a sound that contains a lot of silence. It is best not to use percussion, or sounds
containing distortion or noise, since what we will be listening for is clicking or popping
sounds. Drag the sample from the Browser into the first audio track, and launch the clip.
Now you should hear this clip and see its level in the level meter.

In the second track, switch off the Track Activator. Then, drag your test sample into this
track as well, and launch the clip. Now both clips will be playing, but you will only hear
the signal from the first track, as the second track is deactivated. (Notice that it has a
gray level meter.)

1 Audio 2 Audio
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Launching a Test Clip in the
First Track.

Switch the Second Track
Off, and Notice the Gray
Level Meter.
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(d)

(e)

The second track will be used only to “simulate” CPU traffic. To do this, drag effects one
at a time from Live’s Device Browser into the track. While doing this, keep an eye on the
CPU Level Meter in the upper right corner. Add effects until this display shows a value
close to 70 percent.
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Open the Audio Preferences and set the Buffer Size control to its lowest value. You will
probably hear clicks or dropouts in the audio. Slowly increase the Buffer Size until the
clicks or dropouts become inaudible. Find a value just high enough that the signal passes
through undisturbed.

Note that lower latencies add more stress to the CPU. In situations where adding a few more
plug-ins or tracks sends your system “over the edge,” increasing latency a little bit may allow
it to accommodate the extra load.

5.1.4 Sound Manager

When using Sound Manager, it is only possible to access one stereo input and one stereo output
channel of your audio interface, even if your interface provides multichannel capabilities. Therefore,
ASIO drivers are the preferred choice for any serious audio application. ASIO drivers are available for
almost every professional audio I/0 interface. Check with your audio hardware’s vendor if you are
unsure about whether your interface supports ASIO.

If you are using Sound Manager, do the following to set up the rest of your Audio Preferences:

1. Select the audio device that you want to use with Live from the Audio Device chooser. Your
options in this chooser depend entirely on your individual software and hardware setup-

Bringing the CPU Level up
to 70 Percent.
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you might be offered anything from your computer’s built-in soundcard to an external audio
interface.

2. The Sample Rate setting for Sound Manager drivers is fixed at 44,100 Hz. However, if you
want to know more about this setting and what Live does with it, please read the Sample Rate
section (see Selecting a Sample Rate).

3. Please read the section on the Overall Latency adjustment (see Adjusting the Overall Latency)
to find out about this setting.

4. You can set up your audio device’s input and output in the Input and Output Configuration
dialogs (see Configuring Audio Device Channels). Note that, if you have a multichannel audio
device, Sound Manager will only allow you access to one stereo pair for input and one for
output.

5.1.5 Direct1/0

If you are using Direct I/0, do the following to set up the rest of your Audio Preferences:

1. Select the audio device that you want to use with Live from the Audio Device chooser. Your
options in this chooser depend entirely on your individual software and hardware setup- you
might be offered anything from your computer’s built-in soundcard to a multichannel audio
interface.

2. Select the desired Sample Rate for recording. If you want to know more about this setting and
what Live does with it, please read the Sample Rate section (see Selecting a Sample Rate).

3. Please read the section on the Overall Latency adjustment (see Adjusting the Overall Latency)
to find out about this setting.

4, If you have a multichannel audio device, you can set up your audio device’s inputs and outputs
in the Input and Output Configuration dialogs (see Configuring Audio Device Channels). These
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dialogs determine which of your individual input and output channels appear as routing op-
tions in Live's track In/Out section (see Routing and I/0), and whether they appear as mono,
stereo or both.

5. The Buffer Size control is used to adjust for latency. The term latency refers to the time it
takes for sound from the audio device’s inputs to become available to the software, and for
sound generated or processed by the software to arrive at the audio device’s outputs.

Latency is an undesirable, yet unavoidable fact of processing audio on a standard computer.
All calculations necessary for audio are handled by the CPU. Audio software reads and writes
audio in chunks, which are collected in buffers, in order to reduce the CPU load, and to have a
“reservoir” of incoming or outgoing audio available for times when the processor must attend
to some other task. Smaller buffers therefore create less latency but add stress to the CPU.
The Buffer Size control allows finding the smallest possible buffer size that your computer can
handle without troublesome stress to the CPU. Do the following to find a suitable Buffer Size
setting for your setup:

(a) Start with an empty Live Set that has at least two audio tracks.

1 Audio 2 Audio

Launching a Test Clip in the
First Track.

(b) Find a good sample to use for testing: We want to use a sustained sound rather than
a sound that contains a lot of silence. It is best not to use percussion, or sounds
containing distortion or noise, since what we will be listening for is clicking or popping
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(c)

(d)

(e)

sounds. Drag the sample from the Browser into the first audio track, and launch the clip.
Now you should hear this clip and see its level in the level meter.

In the second track, switch off the Track Activator. Then, drag your test sample into this
track as well, and launch the clip. Now both clips will be playing, but you will only hear
the signal from the first track, as the second track is deactivated. (Notice that it has a
gray level meter.)
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The second track will be used only to “simulate” CPU traffic. To do this, drag effects one
at a time from Live’s Device Browser into the track. While doing this, keep an eye on the
CPU Level Meter in the upper right corner. Add effects until this display shows a value
close to 70 percent.
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Open the Audio Preferences and set the Buffer Size control to its lowest value. You will
probably hear clicks or dropouts in the audio. Slowly increase the Buffer Size until the
clicks or dropouts become inaudible. Find a value just high enough that the signal passes

Switch the Second Track
Off, and Notice the Gray
Level Meter.

Bringing the CPU Level up
to 70 Percent.
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through undisturbed.

Note that lower latencies add more stress to the CPU. In situations where adding a few more
plug-ins or tracks sends your system “over the edge,” increasing latency a little bit may allow
it to accommodate the extra load.

5.2 General Audio Preferences

5.2.1 Selecting a Sample Rate

Settings

Sample Rate 44100 |

Overall Latency 1ms + 1ms + = 2 ms

Active Channals Inpul Config tput Confic

The Sample Rate setting determines sampling rate at which Live and the audio interface operate.

The term “sample rate” refers to the number of samples per second that are used to represent a
sound digitally. A digital representation of a sound is more accurate if a higher sample rate is
used. Unfortunately, higher sample rates add stress to the CPU, since it then has to perform more
calculations (read more samples) per second of audio.

The sample rate for CD-quality audio is 44,100 samples per second. 44,100 is therefore a suitable
Sample Rate setting and produces audio of the same quality as that of a CD recording.

Audio clips with an arbitrary sample rate can be read and used in Live because Live performs a
real-time sample-rate conversion. However, the sample rate of audio clips that are newly recorded
in Live will always be identical to the selected Sample Rate chosen in the Audio Preferences.

Depending on the selected Audio Device, this rate may be fixed (usually at 44,100 Hz).

The Sample Rate Setting in
the Audio Preferences.
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5.2.2 Configuring Audio Device Channels

The Input and Output Configuration buttons open dialogs which you can use to describe to Live the
audio connections from your computer to the rest of your studio.

Choosa which audio hardware inputs to make available to Live's tracks.
Every input pair can be used as one stareo in andfor two mono ins.
Deactivating inputs reduces the CPU load.

[ 3 (mono) & 4 (mono) ]

(__OK ) (_Cancel )

There are two switches per input/output channel pair. One sets the channel pair up for use as a
stereo channel and the other sets it up for use as two independent mono channels.

e If, for instance, input 15/16 is always connected to the DAT recorder, then you only need to
check the stereo option for channels 15 and 16. If, however, inputs 15 and 16 are connected
to two mono microphones, then you only need the mono option.

e You can check both options, saving the decision about how to use the channel pair for the
moment when you are actually using it. This is useful for connections that change frequently.
For instance, when working with the computer’s built-in stereo hardware interface, you might

The Input/Output
Configuration Settings
Determine Which Physical
Ins and Outs Are Made
Available to Live’s Tracks, as
Mono and/or Stereo Pairs.
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record in mono from a microphone and reconnect only a few minutes later to record in stereo
from turntables.

e If you are not using a channel pair, turn off both switches. Disabling unused channels opti-
mizes CPU performance.

Note: Sound Manager and DirectX/MME drivers limit the use of all but one stereo input channel
and one stereo output channel, regardless of what interface or soundcard you may be using. For
serious audio applications, audio interfaces with ASIO drivers can be purchased for both Mac 0S 9
and Windows.

5.2.3 Adjusting the Overall Latency

The Overall Latency setting is only relevant when recording audio with monitoring set to “Off” (see
Monitoring). This would be the case if you were, for example, recording an acoustic instrument and
“monitoring” through the air. We will first present a procedure for making this setting, and then, for
the curious, explain its necessity by expounding on the connection between recording, monitoring
and latency.

1. Connect an audio cable to short-circuit Live's output 1/2 to Live's input 1/2. It does not
matter whether this is an analog or a digital connection; it is important, however, that you
use a “real” hardware connection.

2. Create a new Live Set by choosing “New” from the File menu.



5.2. GENERAL AUDIO PREFERENCES

L

on
DI

MID

Mon

.*b
8 —
1 Audio 2 Audio
9 -
| o
4 Audio From Audio From
f IDtt In || | A
TEE mie A
Monitor Monitor
Audio To Audio To s

I il
O O] “
] a]
S -]
6
1 2

w B | B

59

3. Choose a one-shot percussion sample that has a signal peak right at the sample start, and

drag this sample into a Session slot of audio Track 1.

4, Check “In/Qut” from the View menu to bring up the mixer’'s In/Out section. Make sure audio

Track 2 is set up to receive its input from External In 1/2, as shown.
5. Set Track 2's Monitor radio button to “Off".

6. Arm Track 2 by pressing its Arm button.

7. Click the Control Bar's Stop button twice to make sure Live is set to Arrangement position

Preparing to Adjust the
Correct Overall Latency.
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10.

11.

12.

13.

14.

15.
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1.1.1.

. Click the Control Bar's Record switch.

. Launch the percussion clip in Track 1 by clicking its Launch button. Live will start recording.

Stop playback and switch to the Arrangement View.

Now, Track 2 contains an approximate copy of the clip in Track 1, delayed by an amount of
time that corresponds to the overall latency.

Double-click the new clip; in the Clip View, turn off the Warp switch.

Move the Clip Loop/Region start marker to the right. In the Arrangement display, you can
observe the percussion hit's waveform in Track 2 moving left. Keep moving right until the
percussion hit reaches the song start (zoom in if needed to get as close a match as possible).
You have now offset the region start of the clip in Track 2 to compensate for the delay between
the original and the copy.

From the Clip View's Start value boxes, read out the value in milliseconds.

Type this value into the Audio Preference’s Overall Latency field.
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Finding the Offset.

If desired, you can delete the recording from Track 2 and repeat the test above to verify that there
is no offset between the original clip in Track 1 and the recorded copy in Track 2.

Caution: Dry Theory! What does the Overall Latency setting achieve and why do we need it? Imagine
that you are recording a drummer into Live. The drummer plays along to Live’s metronome or music
from the Live Set. Monitoring is turned off on the tracks you are recording. The signal that Live
receives from the drummer is late with respect to Live’s own time base due to the latency incurred by
the audio hardware: the time it takes the metronome or music signal from Live to reach the speakers
(and thus the drummer’s ears) plus the time it takes the drum signals from the microphones to reach
Live.
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Live compensates for these latencies by moving the recorded samples ahead in song time. To do
this, it needs to have precise information about the actual input and output latencies in the system.
The latency value reported to the software by the audio hardware drivers is not always completely
accurate, however. The Overall Latency setting is a way to tell Live about any deviations from the
reported values.

Why does all this only matter when monitoring is off? Suppose monitoring is on, and the drummer
is wearing closed headphones through which he can now hear both Live’s metronome and his own
playing. The same latencies still apply, and the drummer is, in fact, hearing the result of his playing
late. If latencies are low enough (a few milliseconds), then the drummer will (usually unconsciously)
compensate for the latencies by hitting the drums a bit earlier, and the recorded samples will be in
time with Live's time base.



Chapter 6

Managing Files and Sets

6.1 Relevant Types of Files

6.1.1 Sample Files

A sample is a standard WAV or AIF sound file. On the Macintosh, Live is capable of reading samples
in Sound Designer II format as well. Live can combine mono or stereo samples of any length, sample
rate or bit depth without prior conversion. As Live plays the samples directly from disk, you can
work with a large number of (large) samples without running into RAM memory limitations.

63
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6.1.2 Analysis Files (.asd)

An analysis file is a little file that Live creates when a sample is recorded or dragged into the
program for the first time. The analysis file contains data gathered by the program to help optimize
the stretching quality and speed up the waveform display.

In addition, an analysis file can store a Default Clip for the sample: Clicking the Clip View's Save
button (see Saving Default Clip Settings with the Sample) will store the current clip’s analysis file
with the sample. Next time the sample is dragged into Live, it will appear with those clip settings.
This is particularly useful for retaining the Warp Marker settings (see Time-Warping Samples) with
the sample.

The analysis file’s name is the same as the associated sample, but with an added “.asd” extension.
Live puts this analysis file in the same folder as the sample.

fre Samples that have an .asd file are displayed like this in the Browser.
i Samples without an .asd file look like this.

The analysis files themselves do not appear in Live's Browsers.

Note that you can suppress the creation of .asd files by turning off the Create Analysis Files option
in the Misc Preferences. All data (except for the Default Clip) can be recreated by Live if the .asd
file is missing.

6.1.3 MIDI Files

A MIDI file contains commands that prompt MIDI-compatible synthesizers or instruments, such as
Live's Simpler (see Simpler), to create specific musical output. MIDI files are exported by hardware
and software MIDI sequencers. Importing MIDI files into Live works differently than with samples:
MIDI file data is incorporated into the Live Set, and the resulting MIDI clips lose all reference to the
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original file. MIDI files appear as folders in the File Browser; opening the folders gives you access
to the file’s individual tracks (also called “voices” or “instruments”).
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6.2 Working with the File Browsers

6.2.1 Searching the Folder Hierarchy

Samples and MIDI files are searched and imported from disk using Live’s on-board Browsers, which
can be pointed to any folder location on the computer.

T midi

rack 19

The File Browser’s Folder-Up
1 Audio Button.

The Folder-Up button moves up one step in the disk hierarchy. Clicking this enough times will take
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you to your computer’s desktop. Now you can browse through the disk’s folders.

T 43 -@.‘l-r.'.

The File Browser’s Root
rack 19

1 Ao Button.
After locating the folder with the files you want to use, you may optionally make this folder the
Browser root by clicking the Root button. Note that there are three File Browsers which you can set
up to point to commonly used folders.
As described in the next section, you have the option of previewing your samples before importing
them. To import samples or MIDI files, simply drag them from the Browser into your open Live Set.
6.2.2 Previewing Samples
A oe
_ soundfiles
EI PHOEMNIX. aif The Preview Switch.

Live allows you to preview samples in the File Browser before they are dragged into the program.
Previewing is activated using the Browser’s Preview switch.

Click on the samples (or use and (f] ) to select and listen to them.
Previewing plays samples as if they had been dragged into a track in the Live Set, that is to say:

o If a default clip has already been stored with the sample’s analysis file (see Saving Default Clip
Settings with the Sample), then the sample is played according to the default clip’s settings.

e QOtherwise, the sample is played according to the Default Preferences’ clip defaults settings.

You can adjust the previewing volume using the Preview Volume knob in the mixer.
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O
If your audio hardware offers multiple audio outs, you can privately audition, or cue, samples via

headphones connected to a separate pair of outs— while the music continues to play. To learn how
to set up Live for cueing, please refer to the appropriate manual section (see Soloing and Cueing).

6.2.3 Renaming and Deleting Files

You can use Live's File Browsers to rename and delete files:
e To rename a sample or MIDI file selected in Live’s Browser, choose Rename from the Edit menu.

e To delete the selected sample or MIDI file, choose the Edit menu’s Delete command or press
your computer’s Backspace or Delete key. Deleting samples or MIDI files within Live moves
them to the system trash where they can be recovered if needed.

Note that, while you can rename or delete entire MIDI files via the Browser, this is not possible with
the individual MIDI tracks contained within them.

6.3 Creating and Saving Sets

Use the File menu’s New command to create new Live Sets, and the Open command to open existing
ones.

The Preview Volume Knob.
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The File menu’s Save command saves the current Live Set exactly as it is, including all clips and
settings, except for perhaps those belonging to plug-in devices.

You can also use the Save As command to save the current Live Set under a different name and/or in
a different directory location, or the Save a Copy command to create a copy of the current Live Set
with a new name and/or new directory location. Saving a Live Set leaves the samples referenced by
that Live Set’s clips in their current locations. If the samples are later moved, Live will attempt to
help you find them (see Offline and Lost Samples) when next you open that particular Live Set. The
File menu’s Save Set Self-Contained command (see The Sounds Folder and Self-Containing) can help
you avoid missing samples altogether.

6.4 Template Sets

Use the Default Preferences’ Template Set Save button to save the current Live Set as a template
Live Set. Live will use these settings as the initialized, default state for new Live Sets. You can use
this to pre-configure:

e Your multichannel input/output setup.

e Preset devices, like EQs and Compressors, in every track.

® Computer key mapping.

e MIDI mappings.

The template Live Set “Template.als” is located in Live's Preferences folder and can be copied or
deleted from there. The easiest way to locate this folder is to search your disk for Template.als.
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6.5 Offline and Lost Samples

When loading a Live Set that references samples missing from their referenced locations, Live issues
a warning message and asks whether you want to locate the missing samples.

If you don't, the Live Set will open anyway, with the missing samples marked “Offline.” The Live Set
will play silence in place of the offline samples. You can find the missing files by selecting a clip
that is referencing an offline sample and clicking the Clip View's Replace button (see Replacing the
Clip’s Sample).

6.6 The Sounds Folder and Self-Containing

The Sounds folder is a Live Set’s private location for storing samples. All samples that are recorded
into a Live Set end up in this Live Set’s Sounds folder. Live offers a convenient method for gathering
all samples that are referenced by a Live Set in this folder: When you choose the File menu’s Save Set
Self-Contained command, Live copies all externally referenced samples there. After self-containing
the files, there are no longer references to samples spread over one or more hard drives. You can
backup the Live Set along with its Sounds folder, or send them to collaborators via the Internet, and
all samples used in the project will be included.

The Sounds folder for “My Live Set” is called “My Live Set Sounds.” It is located next to (in the same
folder as) “My Live Set.”

6.7 Exporting MIDI Files

Live MIDI clips can be exported as Standard MIDI files. To export a MIDI clip, use the File menu’s
Export Selected MIDI Clip command. This command will open a file-save dialog, allowing you to
choose the location for your new MIDI file.
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6.8 Exporting Audio

The File menu’s Render to Disk command allows exporting Live's Master audio output as a new sample.
The resulting file can be used to burn an audio CD for listening purposes or a data CD, which could
serve to as a backup of your work or be used with other digital audio applications.

6.8.1 What signal will be rendered?

Render to Disk will always render the signal at Live's Master output. If you are monitoring the
Master output, you can be sure that the rendered file will contain exactly what you hear. To export
individual tracks, deactivate all other tracks other than the ones you want to export by turning off
their Track Activator switches (see The Live Mixer) in the mixer.

When Render to Disk is invoked while the Arrangement View is up, Live will render the selected time
range. If you would like to render the current Arrangement loop, choose the Select Loop command
from the Edit menu prior to choosing Render to Disk. Keep in mind that the selection of tracks is
irrelevant: The signal to be rendered is the Master output.

If you choose Render to Disk while the Session View is up, Live will ask you to specify the length
of the sample to be rendered. The Render to Disk dialog will come up with a bars-beats-sixteenths
field where you can type in the length. Live will capture audio from the Master output starting at
the current play start position for whatever duration you specified.

6.8.2 Rendering Options

The Render to Disk command opens a dialog that offers several rendering options:

o Normalize. If activated, the sample resulting from the render process will be normalized (i.e.,
the file will be amplified so that the highest peak attains the maximum available headroom).
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® Render as Loop. If activated, Live will create a sample that can be used as a loop. For example,
suppose your Live Set uses a delay effect. If Render as Loop is on, Live will go through the
rendering process twice: The first pass will not actually write samples to disk, but add the
specified delay effect. As the second pass starts writing audio to disk, it will include the delay
"tail" resulting from the first pass.

e File Type, Bit Depth, Sample Rate. These options specify the type of sample to be created.

® (reate Analysis File. If activated, Live will create an .asd file that contains analysis information
about the rendered sample. If you intend to use the new sample in Live, check this option.

e (Convert to Mono. If activated, Live will create a mono file instead of a stereo file.
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Arrangement View

The Arrangement View displays the Arrangement, which contains music laid out along a song timeline,
like a multitrack tape.
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The Arrangement View is a powerful editing tool that easily lets you combine and arrange musical
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material of all types: MIDI, loops, sound effects and complete pieces of music.

7.1 Navigation

Live offers several fast methods for zooming and scrolling the Arrangement display:

] 11 ]p[m]e (B et o[ L 24 2 b~ Joa]~] ]

1. To smoothly change the zoom level, click and drag vertically in the song time ruler above the
track display (you can also drag horizontally to scroll the display).

2. To zoom in and out around the current selection, use the computer keyboard’s + and - keys. To
“pan” the display, click and drag while holding the (PC) / (Mac)

modifier.

3. The Arrangement Overview is like a “bird’s-eye view” of your music. It always shows the

Navigating the Arrangement
View.
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complete piece, from start to end. The black rectangular outline represents the part of the
Arrangement that is currently displayed in the Arrangement display below. To scroll the display,
click within the outline and drag left or right; to zoom out and in, drag up and down.

4. To change the displayed part of the Arrangement, drag the outline’s left and right edges.

5. To see a specific part of the Arrangement in more detail, click on it in the Overview and drag
downwards to zoom in around that part. Note that you can also drag horizontally to scroll
the display. Using this method, you can zoom and scroll to focus around any part of the
Arrangement with just one mouse motion.

6. To have the Arrangement display follow the song position and scroll automatically, turn on
the Follow switch, or use the Follow command from the Options menu.

7.2 Transport

There are a number of ways to control Live's transport.
Using the computer keyboard, you can:
® Toggle playback on and off by pressing the space bar;

e Continue playback from the position where it last stopped by holding while pressing
the space bar;

e Play what is currently selected, or play from the flashing insert mark, by pressing (PC)
/ (Mac) and the space bar.
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Using the mouse, you can:

1. Start Arrangement playback by clicking the Control Bar's Play button;

2. Stop playback by clicking the Stop button;

3. Set the Arrangement playback position by dragging the Arrangement Start marker, or have
the Start marker jump to a specific point in the Arrangement without “picking it up” first
by Shift-clicking at the desired position along the beat ruler- this also works while Live is

playing;

4. Adjust the song position numerically using the Arrangement Position fields.

The Control Bar's Arrangement Position fields show the song position in bars-beats-sixteenths. To

change the values:

e Click and drag up or down in any of these fields.

e Click and type a number, then hit the Enter or Return key.
e (lick and decrement or increment the value with and (1 .

Controlling the Transport.
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Notice that any computer keyboard key or MIDI message can be mapped to the transport controls,
as described in the respective chapter (see MIDI and Key Remote Control).

7.3 The Arrangement Loop

'—\__/— 4. 0.0 KEY | nMIDI

The Control Bar’s Loop
Switch.

For Live to repeatedly play a section of the Arrangement, activate the Arrangement Loop by clicking
on the Control Bar's Loop switch.

x Ld -’_ KEY | miCi The Loop Start Fields (Left)

and the Loop Length Fields
(Right).

You can set the Loop/Region markers numerically using the Control Bar fields: The left-hand set of
fields determines the loop start position, while the right set of fields is the length of the loop.

The Edit menu’s Loop Selection command accomplishes all of the above at once: It turns the
Arrangement loop on and sets the Arrangement Loop/Region markers to match whatever timespan
is selected in the Arrangement.

1 Rhodes

3 Bass The Arrangement’s

v
¥ 2 Percussiol
v
w 4 Chords Loop/Region Markers.
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The Loop/Region markers can be selected with the mouse and manipulated with commands from the
computer keyboard:

. and nudge the loop/region to the left/right by the current grid setting (see Using
the Editing Grid).

o and shift the loop/region left/right in steps the size of its length.

e The (PC) / (Mac) modifier used with the arrow left and right keys shortens
or lengthens the loop/region by the current grid setting (see Using the Editing Grid).

e The [Ctl ] (PC)/ (& & (Mac) modifier with the arrow up and down keys doubles or halves
the loop/region length.

You can also drag the Arrangement’s Loop/Region markers: Dragging the left and right ends sets the
loop start and end points; dragging between the ends moves the loop without changing its length.

7.4 Moving and Resizing Clips

A piece of audio or MIDI is represented in the Arrangement View by a clip sitting at some song
position in one of Live's tracks (see Tracks).

N

A8y
Moving a Clip.

Dragging a clip moves it to another song position or track.

o]
1 Changing a Clip’s Length.

Dragging a clip’s left or right edge changes the clip’s length.
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7.5

Selecting Clips and Time

With the exception of moving and resizing clips, Arrangement editing in Live is selection-based: You
select something using the mouse, then execute a menu command (e.g., Cut, Copy, Paste, Duplicate)
on the selection. This editing method lends itself to an efficient division of labor between the
two hands: One hand operates the mouse or trackpad, while the other hand issues the keyboard
shortcuts for the menu commands. The menu eventually is only used as a reference for looking up
the keyboard shortcuts.

Here is how selection works:

Clicking a clip selects the clip;

Clicking into the Arrangement background selects a point in time, represented by a flashing
insert mark;

Clicking and dragging selects a timespan.

To access the time within a clip for editing, “unfold” its track by clicking the triangular button
next to the track name.

SR @ 1 Avso | [ 5] &1
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_i_
WS | ® zAwio [ [5][8]

Notice that you can adjust the height of the unfolded track by dragging the split line below the
Unfold Track button. Clicking and dragging in the waveform display below the clip’s horizontal
strip allows you to select time within the clip. Note that you can actually unfold all of your
tracks at once by holding down the (PC) / (Mac) modifier when clicking the
Unfold Track button.

Adjusting an Unfolded
Track’s Height.
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e Clicking on the Loop/Region markers is a shortcut for executing the Edit menu’s Select Loop
command, which selects all material included within the loop.

® Holding Shift while clicking extends an existing selection in the same track or across tracks.

Clicking the Loop/Region
Markers to Select the Loop
for Editing.

7.6 Using the Editing Grid

To ease editing, the cursor will snap to grid lines that represent the meter subdivisions of the song
tempo. Generally, the grid is zoom-adaptive, but you can modify it by using the following shortcuts
to Option menu commands:

e Use (cul )] (PC)/ (Mac) to narrow the grid, doubling the density of the grid
lines (e.g., from eighth notes to sixteenth notes).

e Use (Cul J2. (PC)/ (& %2) (Mac) to widen the grid, halving the density of the grid lines
(e.g., from eighth notes to quarter notes).

e Use (PC) / (Mac) to toggle triplets mode; this would, for instance,
change the grid from eighth notes to eighth note triplets.
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e Use [Ctl (4] (PC) / (G %)(4]) (Mac) to turn grid snapping on or off. When the grid is off,
the cursor does not snap to meter subdivisions.

The current spacing between adjacent grid lines is displayed at the right-hand side of the song time
ruler.

7.7 Using the ...Time Commands

Whereas the standard commands like Cut, Copy and Paste only affect the current selection, their “..
Time” counterparts act upon all tracks by inserting and deleting time.

e (ut Time cuts a selection of time from the Arrangement, thereby moving any audio or MIDI on
either side of the cut area closer together in the timeline. This command reduces the length of
your Arrangement by whatever amount of time you have cut. Note that the Cut Time command
affects all tracks, not only the selected ones.
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Paste Time places copied time into the Arrangement, thereby increasing its overall duration by
the length of time you have copied.

Duplicate Time places a copy of the selected timespan into the Arrangement, thereby increasing
its overall duration by the length of the selection.

Delete Time deletes a selection of time from the Arrangement, thereby moving any audio or
MIDI on either side of the deleted area closer together in the timeline. This command reduces
the length of your Arrangement by the amount of time you have deleted. Note that the Delete
Time command affects all tracks, not only the selected ones.

Insert Silence inserts as much empty time as is currently selected into the Arrangement, before
the selection.

A Gap Between (lips Has
Been Deleted by First
Selecting it, Then Executing
the Delete Time Command.
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7.8 Splitting Clips

The Split command can divide a clip or isolate part of it.
To split a clip in two halves,
1. unfold the track;
2. in the waveform or MIDI display, click at the position where you want the clip to be split;
3. execute the Split command.
To isolate a part of a clip,
1. unfold the track;
2. in the waveform or MIDI display, drag a selection over the part of the clip you want to isolate;

3. execute the Split command to divide the original clip into three pieces.

v . 3 - 5
| minimai minimal |
w The Result of Splitting a
Clip.

7.9 Consolidating Clips

The Consolidate command replaces the material in the Arrangement View selection with one new clip
per track. This is very useful for creating structure.
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Suppose you have, by editing or improvising, come up with a layout of clips that sound good
in Arrangement Loop Mode (see The Arrangement Loop). Selecting that part of the Arrangement,
for instance by using the Edit menu’s Select Loop command, and then executing the Consolidate
command creates a new clip that can be treated as a loop. You can now, for instance, drag the clip
edges to create more repetitions. You might also want to drag the new loop via the Session View
selector into a Session View slot for real-time arrangement purposes.

When operating on audio clips, Consolidate actually creates a new sample for every track in the
selection. The new samples are essentially recordings of the time-warping engine’s audio output,
prior to processing in the track’s effects chain and mixer. Hence, the new sample incorporates the
effects of in-clip attenuation, time-warping and pitch shifting, and of the respective clip envelopes
(see Clip Envelopes); however, it does not incorporate the effects. To create a new sample from the
post-effects signal, please use the Render to Disk command (see Exporting Audio).

The new samples can be found in the “Sounds” folder, a disk location specific to the Live Set in
which you are working. Please see the relevant section of this manual (see The Sounds Folder and
Self-Containing) for more information.

Consolidating Several Clips
Into a New Looping Clip.
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Session View

In the Live’s Arrangement View (see Arrangement View), as in all traditional sequencing programs,
everything happens along a fixed song timeline. For a number of applications, this is a limiting
paradigm:

e When playing live, or when DJing, the order of pieces, the length of each piece and the order
of parts within each piece is generally not known in advance.

e In the theatre, sound has to react to what happens on stage.

e When working along with a piece of music or a film score, it can be more efficient and
inspirational to start with an improvisation, which is later refined into the final product.

This is exactly what Live’s unique Session View is for.

84
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8.1 Session View Clips

1 Audio 2 Audio 3 MDY

[ Jreoare] [ eagieg [qwoiiase]

| [ [rracks |

The Controls for a Session
Vg I | View Clip.

1. Each clip in the Session View has a triangular button at the left edge. Click the button with the
mouse to “launch” clip playback at any time, or pre-select a clip by clicking on its name, and
launch it using the computer’s Return or Enter key. You can then move on to the neighboring
clips using the arrow keys. Please refer the manual section on clip launch settings (see The
Launch Box) for details on how to customize this behavior.

2. Click on a square Clip Stop button to stop a running clip, either in one of the track’s slots, or
in the Track Status field below the Session grid.

Clips can be controlled remotely (see MIDI and Key Remote Control) with the computer keyboard or
a MIDI controller. They can even be mapped to MIDI note ranges so that they play chromatically.

Clips can be played at any time and in any order. The layout of clips does not predetermine their
temporal succession; the Session grid offers random access to the clips it contains.

Notice that, even if you stop playback for a Session View clip, the Play button in the Control Bar will
remain highlighted, and the Arrangement Position fields will continue running. These fields keep
a continuous flow of musical time going, so that you can always know your position in song time
during a live performance or while recording into the Arrangement (see Recording Sessions into the
Arrangement), regardless of what your individual Session clips are doing.

You can always return the Arrangement Position fields to 1.1.1 and stop playback for the entire Live
Set by pressing the Control Bar's Stop button twice.
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P-E. — 4 b The Arrangement Position

Fields and the Stop Button.

8.2 Tracks and Scenes

Each vertical column, or track (see Tracks), can play only one clip at a time. It therefore makes
sense to put a set of clips that are supposed to be played alternatively in the same columns: parts
of a song, variations of a drum loop, etc.

A Session View Scene.

The horizontal rows are called scenes. The Scene Launch buttons are located in the rightmost column,
which represents the Master track (see Return Tracks and the Master Track). To launch every clip
in a row simultaneously, click on the associated Scene Launch button. This can be very useful in
organizing the live performance of a song with multiple parts.

The scene below a launched scene will automatically be selected as the next to be launched unless
the Select Next Scene on Launch option in the Misc Preferences is set to “Off." This allows you
to trigger scenes from top to bottom without having to select them first. Computer keys or a
MIDI controller can be used to launch scenes and scroll between them (see Relative Session View
Navigation).

Scenes can be renamed using the Edit menu’s Rename command. One can quickly rename several
scenes by executing the Rename command and using the computer’s Tab key to move from one scene
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to the next.

Each scene can actually store a tempo setting as part of its name, so that it changes the project
tempo upon launch; this is accomplished by selecting the scene and renaming it with a viable tempo
(e.g., “96 BPM"). Any tempo can be used, as long as it is within the range allowed by Live’s Tempo
control (20 - 999 BPM).

1 Audio 2 Audio 3 MiDi 4 MIDJ Master

This Scene Will Change the
ch2.L a1 4 Tempo to 96 BPM.

8.3 The Track Status Fields

You can tell a track’s status by looking at the Track Status field just above the active track’s mixer
controls:

-“ ||| A Track Playing a Looping
M w1 l(M & Session Clip. . .

The pie-chart icon represents a looping Session clip (see Sample Loop/Region). The number to the
right of the circle is the loop length in beats, and the number at the left represents how many times
the loop has been played since its launch.

MMM F ... A One-shot Session
£l £ Clip. ..
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The progress-bar icon represents a one-shot (non-looping) Session clip. The value displays the
remaining play time in minutes:seconds.

I T

MO From MIDI From

A microphone icon appears in an audio track that is set to monitor its input (see Monitoring). A
keyboard icon appears in a MIDI track under these same circumstances.

(o]

Audio From Audio F

If the track is playing clips from the Arrangement, a miniature display representing the Arrangement
clips being played appears.

8.4 Configuring the Grid

Clips can be moved around the Session grid by drag-and-drop. To move several clips at once, select
them by using the (& ] -or (Ctn ] (PC) / (Mac)-modifier before dragging. You can
also click into an empty slot and “rubber-band” select from there. Scenes can be reordered by
drag-and-drop as well.

... Monitoring the Input. ..

... Playing the
Arrangement.
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fd r7-d #3 @108.L
fed r7-d 23 @106.R

Dropping Multiple Clips Into
the Session View.

>

fid ré-d@116 okeas.R

Of course, you can also drag in new clips from the Browser (see Working with the File Browsers).
If you are dragging multiple clips into the Session View, Live defaults to arrange them vertically, in
one track. Hold down (ctl ] (PC) / (Mac) prior to dropping them so as to lay the clips
out in one scene.

8.4.1 Select on Launch

By default, clicking a Session View clip’s Launch button also selects the clip, since you will typically
want the Clip View to show the newly launched clip. However, some power-users don’t want the
current focus (e.g., a return track’s devices) to disappear just because a clip has been launched,
especially when starting a clip in order to try it with the return track device settings. Turn off the
Select on Launch option from the Misc Preferences if you prefer the view to remain as is when you
launch clips or scenes.



8.4. CONFIGURING THE GRID 90

8.4.2 Removing Clip Stop Buttons

1 Avdio 2 Audio 3 Auvdio 4 Moy

47
f IQ

You can add and remove Clip Stop buttons from the grid using the Edit menu’s Add/Remove Stop
Button command. This is useful for pre-configuring the scene launch behavior: If, for instance, you
don't want scene 3 to affect track 4, remove the scene 3 / track 4 Stop button.

8.4.3 Editing Scenes

There are a number of useful commands in the Edit and Insert menus that apply to scenes:

® (ut Scenes cuts out scenes with selected slots from the Session View, thereby reducing the
total number of scenes. Please note that the Cut Scenes command affects all tracks, not only
those containing selected slots.

e Paste Scenes works like Paste, but inserts blank scenes before pasting. Live inserts enough
scenes to fit the material from the clipboard. The new scenes will be inserted behind the
current selection.

e Duplicate Scenes works like Duplicate, but inserts blank scenes before pasting. Live inserts
enough scenes to fit the material from the clipboard.

e Delete Scenes deletes all scenes with selected slots from the Session View, thereby reducing
the total number of scenes. Please note that the Delete Scenes command affects all tracks,
not only those containing selected slots.

Slots Without Clip Stop
Buttons.
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e Insert Scene inserts an empty scene below the current selection.

e (apture and Insert Scene inserts a new scene below the current selection, places copies of the
clips that are currently running in the new scene and launches the new scene immediately
with no audible interruption. This command is very helpful when developing materials in the
Session View. You can capture an interesting moment as a new scene and move on, changing
clip properties and trying clip combinations.

8.5 Recording Sessions into the Arrangement

Your Session View playing can be recorded into the Arrangement, allowing for an improvisational
approach to composing songs and scores.

oe | EX b 3. 3 'EEQ— 118 &

1 Audio 2 Audio 3 Moy 4 MiDi
[ [rracks | [¥solo Swed The Control Bar’s Record
| |r%-n:~?‘:|'l—i'|| | RAIN 1 |u|'.|IIJI 1.1l-c;\| Button_

When the Record button is on, Live logs all of your actions into the Arrangement:
e the clips launched;
e changes of those clips’ properties (see Clip View);

e changes of the mixer and the devices’ controls, also known as automation (see Recording
Automation).

To finish recording, press the Record button again, or stop playback.
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8 % ]

o

To view the results of your recording, bring up the Arrangement View. As you can see, Live has
copied the clips you launched during recording into the Arrangement, in the appropriate tracks and
the correct song positions. Notice that your recording has not created new audio data, only clips.

The Session clips and the Arrangement clips in one track are mutually exclusive: Only one can play
at a time. When a Session clip is launched, Live stops playing back the Arrangement in favor of the
Session clip. Clicking a Clip Stop button causes the Arrangement playback to stop, which produces
silence.

2 Audio 3 MDY 4 Moy

Arrangement playback does not resume until you explicitly tell Live to resume by clicking the “Back
to Arrangement” button, which lights up to remind you that what you hear differs from the Arrange-
ment.

b
7
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To disable all Arrangement clips simultaneously, click on the Stop All Clips button in the Master Track
Status field.

(L1 1]

The Arrangement Selector.

The Back to Arrangement
Button.

The Stop All Clips Button.
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The clips in the Arrangement and in the Session View exist independently from one another, which
makes it easy to improvise into the Arrangement over and over again until it's right.

Furthermore, you can move clips not only within the Session grid, but also from the Session View
to the Arrangement and vice versa by using Copy and Paste, or by dragging clips over the @' or

@ selectors.

When pasting material from the Arrangement into the Session View, Live attempts to preserve the
temporal structure of the clips by laying them out in a matching top-to-bottom order. Moving
through the scenes from the top down, you can reconstruct the original arrangement. This is useful
for taking a composed piece of music back to the improvisational stage.



Chapter 9
Clip View

The Clip View is where clip properties can be set and adjusted.

Clicking the Clip Overview

The Clip View is opened by clicking on the Clip Overview or double-clicking a clip in the Session or
Arrangement Views.

94
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| Clicking a Session View

Track Status Field Opens

Mitaml the Clip View:

In the Session View, clicking on a Track Status Field opens the Clip View for editing the clip that is
currently running in the track.

MIDI clips and audio clips in Live have different sets of properties and, consequently, do not share
the same set of Clip View controls. The two types of clips do have the following in common:

e The Clip box contains basic clip settings.

e The Envelopes box and the Envelope Editor manage the clip’s envelopes, which are used to
modulate the effects, mixer, and clip or MIDI controls. Clip envelopes and their associated
Clip View components are covered in detail in a separate manual chapter (see Clip Envelopes).

e The Launch box controls clip launch behavior and, as such, only appears for Session View clips.
Setting Session View clip launch properties is covered in detail in a separate manual chapter
(see Launching Clips).

Audio clips have these additional Clip View controls:

® The Sample Display toggles with the Envelope Editor on the right-hand side of the Clip View,
and controls Live's sample-warping capabilities (see Time-Warping Samples).

e The Sample box contains settings pertaining to how the clip plays its sample and displays it
in the Sample Display.
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The Clip View for an Audio
Clip.

MIDI clips have these additional Clip View controls:

o The MIDI Editor toggles with the Envelope Editor on the right-hand side of the Clip View, and
allows editing and creating MIDI notes and velocities (see Editing MIDI Notes and Velocities).

e The Notes box contains settings pertaining to how Live plays a MIDI clip and what it displays
in the MIDI Editor.
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To make best use of the screen real estate, you can show or hide the Launch, Envelopes, and Sample
or MIDI boxes using the Clip View Box selector in the Clips box. You can also toggle between the
Sample Display/MIDI Editor and the Envelope Editor by clicking in the title bars of the Sample/Notes
box and the Envelopes box, respectively.
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The Clip View Box Selector
Shows and Hides Various
Clip View Components.

The Clip Box.



9.1. THE CLIP BOX 98

9.1.1 Clip Name and Color
The Clip Name field allows naming the clip. By default, a clip’s name matches the name of the file it
references but, in general, the clip name is independent from the file name.

Renaming an audio clip does not rename the referenced sample file. To rename a file, select it in
Live’s File Browsers, and then choose the Edit menu’s Rename command.

The Clip Color chooser allows choosing a clip color.

9.1.2 C(lip Signature

Using the Clip Signature fields, you can specify the signature of an audio clip’s sample. This setting
is relevant only for display; it does not affect sample playback.

9.1.3 Groove

The Clip Groove chooser selects the type of groove used for the clip. “Swing 8,” for example, applies
an 8th-note groove.

AP 1 b1 4 -Z-i EX b

The Global Groove control defines the amount of the groove for every clip in the Live Set.

So, how does it work? Imagine a simple one-bar MIDI clip that has a time signature of 4/4. Our
MIDI clip is made up of 8th notes- eight of them- that play either on or between each of the four
beats. With a Clip Groove setting of Swing 8, the timing of our one-bar clip becomes a bit like
a rubber-band that is pinned down at each beat but flexible in between. The 8th notes that fall
between beats can shift slightly forward. With a Global Groove setting of 50, for example, the notes

The Control Bar’s Global
Groove Control.
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will wait until 2/3 of the way through the beat to play, where an 8th-note triplet would normally
fall.

16th- and 32nd-note swing works similarly, but on a smaller scale: Every other note shifts forward,
toward the nearest 16th- or 32nd-note triplet position.

Returning to our rubber-band analogy, we can see that Swing 8 can actually affect more than just 8th
notes. Actually, any notes that do not lie directly on a beat will be affected when the rubber-band
is stretched- including 16th and 32nd notes. By the same token, Swing 16 (where our rubber-band
is anchored to positions just an 8th note apart) can affect 32nd notes.

Groove can be applied to both MIDI clips and audio clips. Applying groove to audio clips does require
that the Warp switch be activated and a Warp Mode (see Adjusting for Good Stretching Quality) other
than Re-Pitch selected. If an audio clip is in Beats Mode, the Transients setting must be greater
than or equal to the Clip Groove chooser’s swing setting (e.g., with a Transients setting of 1/16,
Swing 8 and Swing 16 can be used, but not Swing 32).

Because of this feature’s dependency on note timing, we recommend that you quantize (see Ar-
ranging and Quantizing Notes) MIDI clips prior to applying groove- provided you want predictable
results. For audio clips, any swing contained within the original sample can be removed by appro-
priately setting Warp Markers (see Manipulating Grooves) prior to applying the “artificial” swing of
the Groove setting.
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9.2 The Sample Box

9.2.1 Warp Controls
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When the Warp switch is off, Live plays the sample at its original, “normal” tempo, irrespective of
the current Live Set tempo. This is useful for samples that have no inherent rhythmic structure:
percussion hits, atmospheres, sound effects, spoken word and the like. Turn the Warp switch on
to play rhythmically structured samples (such as sample loops, music recordings, complete music
pieces, etc.) in sync with the current song tempo.

A NS0 4 ; 4 [50 | 0w | Ex =

To verify this, note that a warped sample’s speed follows the tempo as you change the Control Bar's
Tempo control.

Live offers a number of controls to adjust the time-warping engine for optimal stretching quality
(see Adjusting for Good Stretching Quality). For accurate warping, Live needs to know the sample’s
metrical structure. For properly prepared loops, tempo and duration are calculated automatically;
most of the time this is accurate enough that the sample is immediately ready for use in Live. For
other samples, you will have to provide some hints (see Time-Warping Samples).

The Clip Warp Controls.

The Control Bar’s Tempo
Control.
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9.2.2 Sample Loop/Region

Sample

To have the clip’s region played as a (potentially infinite) loop, turn on the Loop switch. Activating
the loop also activates warping; unwarped clips cannot be played as loops.

Zooming and scrolling the Clip View's Sample Display works just like in the Arrangement (see
Navigation). Note that you can use the Sample Display itself for zoom-scrolling. The Clip Overview
serves as a sample overview with added zoom/scrolling functionality.

You can adjust the loop, or region, using the Clip Loop/Region markers in the Sample Display. The
brace that runs between the Clip Loop/Region markers can be selected with the mouse, and the
markers can then be manipulated with commands from the computer keyboard:

. and ] nudge the loop/region to the left/right by the current grid setting (see Using
the Editing Grid).

o and (%] shift the loop/region left/right in steps the size of its length.

J (PC) / (& F[E P (Mac) shortens or lengthens the loop/region by the current
grid setting (see Using the Editing Grid).

J (PC) / (Mac) doubles or halves the loop/region length.

The Clip Loop/Region
Controls.
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The region or loop can also be moved by simply clicking and dragging it left or right.
i

163, (164 17
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To change the region or loop start or end point, drag the left or right edge.

P |

The Offset Marker is visible only if the clip is set to loop. It represents the point in the sample where
the clip starts playing. To adjust this, drag the Offset Marker left or right. You may have noticed
that, as you move the clip loop, the Offset Marker jumps so that it stays within the loop. If the loop
size is set to one, two, four, eight, etc. bars, any jump remains locked to the rhythm, allowing you
to play with the loop in a musical way.

The loop or region can also be adjusted numerically using the respective value fields. For warped
clips, these fields display values as bars-beats-sixteenths; for unwarped clips, the display is in
minutes-seconds-milliseconds. The little arrow buttons are useful for bringing the loop/region’s
start, end, offset or complete expanse (length) into view without zooming or scrolling. If the
Start/Position switch is set to Start, values entered in the respective value fields affect the loop /

Changing the Region or
Loop End.

The Offset Marker.
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region’s start point only; if set to Pos, changing this value moves the complete region/loop.

9.2.3 Clip Pitch and Gain

Sample +

0st adem

Detune

[Oct 4 00008 | .

The Clip Pitch and Gain
Controls.

The Transpose control shifts the clip pitch in semitones.
The Detune field fine-tunes the clip in cents (100 cents = one semitone).

The Clip Gain slider, calibrated in dB, changes the clip gain.

9.2.4 Destructive Sample Editing

Sample

The Launch Sample Editor
Button.
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The Launch Sample Editor button opens the sample in a sample editing application, as specified
in the Misc Preferences. To process a sample in an external program, you will have to stop Live’s
playback. Upon returning to Live, the edited version of the sample will be played back. The current
set of Warp Markers is retained only if the sample length remains the same as before. Remember
that changes to one sample may affect other clips playing the same sample.

9.2.5 Replacing the Clip’s Sample

To replace the sample referenced by the clip with a different sample, drop the new sample directly
from the File Browser into the Clip View. Clip settings like pitch and volume will be retained. The
Warp Markers will be retained only if the new sample has the exact same length as the old sample.

Tip: When bringing multitrack audio from another program into Live for remixing, it is convenient
to set Warp Markers for only one of the composite samples and copy the same set of Warp Markers
to the other tracks. This can be easily done provided the individual samples have the exact same
length (which usually is the case if they all have been exported from several tracks in one go): Pick
the sample with the clearest rhythmical pronunciation and set the Warp Markers for this sample as
described elsewhere (see Time-Warping Samples). Next, make enough copies of this clip to hold all
the individual samples, and drop the samples from the Browser into the clips. The Warp Markers will
be retained, because the samples all have the same length.

Sample

The Replace Sample button is for replacing a sample throughout the entire Live Set. All clips that
reference the “old” sample will reference the “new” sample, which is selected using a file-chooser
dialog. Live retains the clip properties; the Warp Markers (see Time-Warping Samples) are kept if
the new sample has the same or a greater length as the old sample and discarded otherwise. This

The Replace Sample Button.
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function is also useful for locating missing samples that are marked “offline” (see Offline and Lost
Samples).

9.2.6 Saving Default Clip Settings with the Sample

Sample

40

— The Save Default Clip
Button.

The Save Default Clip button saves the current clip’s settings with the sample. Once saved, Live will
restore the current clip settings whenever you drop the sample into a Live Set. This is especially
useful with regards to the Warp Markers, which have to be set correctly for Live to play long files in
sync. Note that you can use the Save button without affecting any existing clips; Save just saves
default settings for future clips using this sample. The clip data becomes part of the analysis file
(see Analysis Files (.asd)) that accompanies the sample.
9.2.7 High Quality Interpolation

Sample

g8 aoe o The High Quality Switch.

If the High Quality switch is on, Live uses an advanced sample-rate conversion algorithm that
provides better sound quality at the expense of a higher CPU load. Samples processed with the
Hi-Q algorithm generate less distortion, particularly at high frequencies, when transposing a sample
and/or matching an imported sample’s sampling rate to the system’s sampling rate. Note: This
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feature involves only sample rate conversion, not the time-stretching quality. There are dedicated
controls for adjusting the stretching properties (see Adjusting for Good Stretching Quality).

9.2.8 Clip Start and End Fades

Sample

=

The Clip Fade switch, when enabled, applies a short fade to the clip start and end to avoid clicks at
the clip edges. The length of the fade is signal-dependent and ranges from 0-20 milliseconds. Live
attempts to start a fade-in, or a crossfade, early enough so that there is no attack smearing at the
clip start. Likewise, fade-outs are set up so that they end with the clip end.

9.2.9 Clip RAM Mode

Sample

If the RAM Mode switch is on, Live is loading the audio referenced by the clip into the computer’s

memory rather than reading it from disk in real time. RAM Mode can help with these problems:

® Your computer’s hard disk is too slow to deliver audio for as many tracks as desired in real
time. For more information on disk-related problems, please refer to the respective section
(see Managing the Disk Load).

The Clip Fade Switch.

The RAM Mode Switch.
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® You are experiencing audio dropouts when playing clips in Legato Mode (see Legato Mode).

Use RAM Mode with care, as RAM is usually a scarce resource. Your computer is using the hard disk
for swapping out RAM contents that have not been used in a while. The more clips you are running
in RAM Mode, the higher the likelihood for them to be swapped out. Live can handle disk overloads
more gracefully than swapped-out audio arriving late: Disk overloads result in unwanted mutes,
whereas RAM overload results in both mutes and rhythmical “hiccups.”

9.2.10 Reversing Samples

Sample

This function creates a new sample by reversing the sample referenced by the current clip. It then
reapplies the old clip’s settings (according to some rules that we will explain in a moment), and
replaces the original sample with the reversal in the Clip View. The new sample is stored in your
temporary recording folder until you save your Live Set, at which point it is moved to your Sounds
folder (see The Sounds Folder and Self-Containing). The reversed sample has an “R” appended to the
end of its name so that it is easily distinguishable from the original.

There are a few rules for the reversing process. First, any Warp Markers (see Time-Warping Samples)
will remain fixed to their positions in the sample. This means that a Warp Marker on the downbeat
of the second bar of a clip will end up on the downbeat of the second-to-last bar after reversal. Clip
Loop/Region markers are similarly flipped. Second, clip envelopes (see Clip Envelopes) remain fixed
to their position in time. Therefore, a mixer volume envelope that lowers the volume of the first half
of a clip will continue to do exactly that after reversal.

The reversal process is quite fast (about as fast as copying), but for very long samples it might
take a little time. When this is the case, the Status Bar in the lower portion of the Live screen will

The Reverse Button.
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give you a progress display, and further actions in the program will be temporarily locked (though
running clips will continue to play). You can play the reversed clip and perform other actions in the
program as soon as Live begins to draw the new waveform into the Sample Display. Once a sample
is reversed, a link to the reversed sample will be maintained until the you quit the program, and
reversing the same clip again (or a copy) will be instantaneous.

It is not recommended that you reverse clips in a live performance situation, as a slight glitch can
sometimes occur while Live reapplies the warp and loop settings.

9.3 The Notes Box

Launch
COrig. BPM m m MIC
@ @ | [ 1000 i
Bank End @) g
3 T |
Sub-Bank | Length  (®)
130/ [ 9| regie
Program  Offset @ i

I

The Notes Box.
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9.3.1 Tempo Controls

The “Orig. BPM” field displays Live’s interpretation of the tempo at which the clip’s MIDI was
recorded. When dragging up or down in the Original BPM field, or clicking the :2 and *2 buttons,
you will see that the notes in the MIDI Editor are correspondingly stretched or compressed. This is
useful for aligning notes that you have recorded without a tempo reference, like Live’s metronome
(see Recording in Sync).

9.3.2 Bank and Program Change

Live can send MIDI bank/program change messages to external devices. According to the settings
in these controls, launching a clip also sends its bank/program change message. If you are using
Live to send MIDI to your synth, this means that each MIDI clip in your Live Set can play a different
sound on your synth. Live offers messages for 128 banks with 128 sub-banks, each of which has 128
programs. Please see the documentation that came with your synthesizer to determine how many of
these messages it can use. If you do not want your clip to send program or bank change messages,
simply set the bank/program choosers to “None.”

9.3.3 MIDI Loop/Region

These controls manage how the contents of a MIDI clip are played and shown in the MIDI Editor.
They work the same way as those for audio clips (see Sample Loop/Region).

9.4 Clip Defaults and Update Rate

You can change the rate at which Live applies your Clip View settings to a running clip. Clip
View changes will be quantized by the rate selected from the Clip Update Rate chooser in the Misc
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Preferences.

Certain clip settings, such as Launch Mode and Warp Mode, can be set up as defaults for all new
clips. This is done in the the Default Preferences.



Chapter 10

Tempo Control and Warping

Unlike music stored on tape or in a traditional digital audio workstation, the music in Live remains
“elastic” at all times. Live is capable of time-warping samples while streaming them from disk so
as to synchronize them to the current project tempo. This happens without affecting the pitch,
which can be changed independently. Mixing and matching audio from different origins is therefore
extremely easy.

10.1 Tempo

10.1.1 Setting the Tempo

111

The Control Bar’s Tempo
Field.
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The Control Bar’s Tempo field allows you to change the playback tempo of your Live Set at any
time, in real time. You can even automate the tempo (see Editing the Tempo Automation) to create
smooth or sudden tempo changes along the song timeline.

You can have an external sequencer (or drum machine) play along with Live or have Live play along
with the sequencer. The respective settings are made in the MIDI Preferences, and the EXT switch
next to the tempo control is activated to have Live follow an external MIDI clock source. Please
refer to the section on synchronization (see Synchronizing via MIDI) for details.

10.1.2 Tapping the Tempo

You can use Live’s Tap Tempo function to set the tempo at any time. As you click the Control Bar’s
Tap Tempo button once every beat, the tempo of the Live Set will follow your tapping.

1= 03|~ 1 @mn

It's better to assign the Tap button to a computer key than using the mouse. Click on the Control
Bar’s KEY switch to enter Key Map Mode; then select the Tap button; press the key you would like to
use for tapping; click the KEY switch again to leave Key Map Mode. The assignment will take effect
immediately. The Tap button can also be assigned to a MIDI note or controller, like a foot switch, in
a similar fashion (see MIDI and Key Remote Control).

Although Live responds to your tapping immediately, it does apply some degree of inertia to prevent
sluggish behavior in the software. The more taps Live receives in a row, the more precisely it will be
able to conclude the desired tempo.

The Tap Button.

The Key Map Mode Switch.
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You can also use tapping to count in: If you are working in a 4:4 signature, it takes four taps to
start song playback at the tapped tempo.

10.2 Time-Warping Samples

Live’s ability to play any audio sample in sync with a chosen tempo is a unique and important
feature. In addition, you can “warp” any sample’s rhythmic flow, which can change the sample’s
“feel” or even move notes to other meter positions.

Think of a sample as a rubber-band that you want to pin to a (musical time) ruler. In Live, the pins
are called Warp Markers. A Warp Marker forces the software to arrive at a specific point in the sample
at a specific musical time. You can use any number of Warp Markers to create an arbitrary mapping
of the sample’s inherent rhythm to a musical meter.

When working with your sample, you can have Live scroll the Sample Display to follow playback. Use
the Control Bar’s Follow switch to activate this feature. It also might be helpful to vertically resize
the Sample Display by dragging on the split line between the Clip View and the Session View track
area.

EEnOO0E:
|

Note: For a tip on how to apply the same set of Warp Markers to several multitrack samples, please
see here (see Replacing the Clip’s Sample).

In the following sections, we will look at a couple of applications for time-warping samples.

The Follow Switch in the
Control Bar.



10.2. TIME-WARPING SAMPLES 114
10.2.1 Syncing Straight Loops

When you import a sample that represents a well-cut musical loop of 1,2,4 or 8 bars in length, Live
usually makes the correct assumptions to play the loop in sync with the chosen tempo. It places
two Warp Markers, one at the sample’s beginning and one at the end.

T = 123 1.3 133 14 143 [z
I ' A One-Bar Loop as It

Appears in the Clip View, by
lo:00.500 " oo " Tooisoo " ooz Default.

1] 1

0:00

The “Orig. BPM” field displays Live’s guess of the loop’s tempo. Sometimes Live’s guess of the
original tempo is wrong by half or double. If so, correct this by clicking on the buttons labeled *2
and :2, respectively. The sample plays at double speed when you press :2 because you are changing

Live's interpretation of the sample’s tempo, which serves as a point of reference for determining the
required time-stretch factor.

The Reset To Default
Button.

The Reset To Default button restores the Warp Marker settings, just as if the sample had been dragged
into the Live Set over again.



10.2. TIME-WARPING SAMPLES 115

10.2.2 Syncing Uncut Loops

When importing a loop that has not been edited into a well-cut loop, Live will play it out of sync.
Suppose there is a portion of silence at the sample beginning, prior to the first beat. You can easily
correct this by moving the Warp Marker labeled with a “1” to the first beat’s onset. Likewise, you can
eliminate silence after the actual loop end by moving the Warp Marker at the sample’s right edge.

>
1.2 [1] 12 13 1.
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lo01 — lgoz " Tgoa” for a Badly Cut Loop.
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10.2.3 Syncing 0dd-Length Loops

If you import a sample that contains a seven-bar loop, Live initially assumes the loop is eight bars
long (or four, depending on its length) and plays it out of sync. For correct playback, the last marker
needs to show a eight, not a nine. To achieve this do the following:

1. Double-click on the last Warp Marker to delete it.
2. Double-click on the eight to create a new Warp Marker.
3. Drag the new Warp Marker to the sample end.

If Live’s initial guess had been a four-bar loop, the eight would not have been accessible. In that
case, you could initially drag the Warp Marker at the end toward the left until the eight became
visible.
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Theoretically this should have done the job for our seven-bar loop. Practically, though, it is very
likely that moving the markers led to a change of the loop start and end points. This is because the
loop is tied to the meter grid and therefore moves with the Warp Markers, which define the meter
grid. Live makes sure the loop fits in the sample, and therefore has to change its length if required
by a Warp Marker change.

10.2.4 Manipulating Grooves

You can now create any number of Warp Markers by double-clicking on one of the gray grid markers.
Drag in a “straight” looped sample, set a few Warp Markers, and move them around to see what
happens. Warp Markers really serve two purposes:

1. to provide a “correct” interpretation of the flow of musical time in the sample;
2. to mess up the flow of time in the sample.

If a single event in a percussion loop comes late, just pin it to the Warp Marker, which shows the
beat position at which you actually want to hear that event. You may want to pin the adjacent beat
positions as well, to avoid affecting neighboring regions in the sample.

3
I [ 12 1 9] [14] 2] 23] [24] 3]

“Removing” a sample’s natural groove by applying Warp Markers is an interesting creative method,
particularly in conjunction with Live’s ability to impose an artifical groove onto clips in real time

Using Warp Markers to
Manipulate the Groove.
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(see Groove).

10.2.5 Syncing Longer Pieces

Once you are familiar with the basic concept of warping, you are ready for a slightly more complicated
task: warping longer pieces.

Drag a long sample into a Session View slot. When you drag in a sample that is too long
to justify the assumption that it contains a loop, Live will play the sample “unwarped” by
default. Double-click on the clip to view its properties in the Clip View. Make sure the Warp
switch is off.

To get a reasonable initial tempo guess for the piece, we will use Live's tapping facility (see
Tapping the Tempo). Play the unwarped clip, with everything else muted, and tap along with
the beat for a bar or two. Tapping sets the Live Set’s tempo without affecting the unwarped
clip’s playback speed; tapping along with the unwarped clip syncs Live to the sample’s original
tempo.

Now turn on the Warp switch. Note that the Original BPM field shows the same value as the
Control Bar's tempo field. Live has used the current song tempo as a guess for the sample’s
original tempo.

Turn on the Clip View’s Loop switch.

Initially, there is just one Warp Marker (labeled “1”). Drag that marker to where you believe
the first downbeat is. Start playback to test if your assumption is right; if it is not, move
the Warp Marker and try playing it again until you find the first downbeat. Incidentally, you
can zoom in and out around the loop start (which now coincides with the Warp Marker we are
moving) by pressing the computer’s + and - keys.
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-
M
1 WWWW The First Downbeat Has

Been Identified.

e When you have found the downbeat, you are ready to match the tempo. Activate the
metronome. Alternatively, you could drop a simple loop into another track and play along
with that.

e Set the loop length of the clip to be warped to 1, 2 or 4 bars; the easiest way to do this is to
type the value directly into the leftmost Length value field.

e While playing, drag one of the gray markers above the clip waveform horizontally until the
loop sounds in sync with the metronome or your reference loop. Once this loop sounds right,
advance the loop by one loop period. The easiest way to do this is to click on the loop braces
and press .

MWWWMW
MWWWMW Dragging the “2” Marker to

lorssoo © 7 Tozo © 7 7 Tozosoo T 7 loz T 7 T lozie Match the Sample’s Tempo.
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e Now, as you listen to the looping sample along with the metronome or your reference loop,
move the gray marker at the loop start to make sure it matches with respect to the tempo.
Use the + and - keys to zoom around the loop start. Once it's right, “pin” the gray marker at
the loop start by double-clicking. You have now created the second Warp Marker.

e Keep moving forward through the sample by selecting the loop braces and pressing (4 ; for
each consecutive loop position, adjust the gray marker at the loop start, and then pin it by
creating a Warp Marker. Repeat this procedure until you have reached the end of the sample.

® Now your sample has one Warp Marker per loop period. With a little practice, you will soon
find it is not necessary to create a Warp Marker for every loop position. If the sample’s tempo
is stable, you may use longer loop lengths and set fewer markers; if the tempo changes very
often, you will likely want to use a one-bar loop, and set a Warp Marker at every bar.

® Once you are done setting Warp Markers, don't forget to turn off the Loop switch and to set
the region start and end correctly.
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Of course, your Warp Markers will be saved with the Live Set. In addition, you probably want to save
them with the sample, so that they are reconstructed the next time you drag the sample into Live.
To do this, click the Clip View's Save button (see Analysis Files (.asd)).

If you frequently warp long pieces, you will learn to set Warp Markers very quickly. Some Live users
prefer different ways to warp, like “real-time warping,” where you set the Warp Markers in one go,

The Result of Setting Warp
Markers for the Piece.
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while the complete piece is running unlooped. We found that the method described above allows
for faster-than-real-time warping: You can “loop-hop” through the sample at any speed desired.
Loop-hopping can be an interesting thing to do in the course of a performance, too!

10.3 Adjusting for Good Stretching Quality

Live offers a number of time-stretching methods to accommodate all sorts of audio material. The

time-stretching method, and additional controls for each method, are set up in the Clip View's “Warp”
box.

The Warp Modes are different varieties of granular resynthesis techniques. Granular resynthesis
achieves time compression and expansion by repeating and skipping over parts of the sample (the
“grains”). The Warp Modes differ by the selection of grains, as well as by the details of overlapping
and crossfading between grains.

Let's investigate which Warp Modes work best for different types of signals and how to adjust the
warping controls for “clean” stretching. It’s also fun to “misuse” these controls to achieve interesting
artifacts instead of correct stretching.

10.3.1 Beats Mode

Beats Mode works best for samples where rhythm is predominate (e.g., drum loops as well as most
pieces of electronic dance music). The granulation process is optimized to preserve transients
(attacks, note onsets) in the audio material.

Use the Transients control to guide Live’s assumptions about where to find transients in the sample.
If there is no rhythmical activity at odd 16th notes, choose 8th, etc. For some interesting rhythmic
artifacts, choose large transient values in conjunction with pitch transposition.
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10.3.2 Tones Mode

Tones Mode serves well for stretching samples with a more or less clear pitch structure, such as
vocals, monophonic instruments and basslines.

Grain Size provides rough control over the average grain size used. The actual grain size is determined
in a signal-dependent way. For signals with a clear sense of pitch contour, a small grain size works
best. Larger grain sizes help avoid artifacts that can occur when the pitch contour is unclear, but
the tradeoff can be audible repetitions.

10.3.3 Texture Mode

Texture Mode works well for complex sound textures with an ambiguous pitch contour (e.g., poly-
phonic orchestral music, all sorts of noise, atmospheric pads, etc.). It also offers rich potential for
manipulating all kinds of sounds in a creative way.

The Grain Size control determines the grain size used; unlike in Tones Mode, this is a setting that
Live will use unaltered, without factoring in the signal’s characteristics.

Fluctuation introduces randomness into the process. Larger values give more randomness.

10.3.4 Re-Pitch Mode

In Re-Pitch Mode, Live doesn't really time-stretch or compress the sample; instead, it adjusts the
sample playback rate to create the desired amount of stretching. In other words, to speed up the
sample by a factor of 2, it's transposed up an octave. This is like the “DJ stretching method” of
using variable-speed turntables to sync two records, or what happens to samples in samplers when
they're transposed.

The Transpose and Detune controls have no effect in Re-Pitch Mode.
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Editing MIDI Notes and Velocities

A MIDI clip in Live contains notes and controller data for playing a MIDI instrument. This instrument
can be a virtual instrument in a MIDI track’s device chain (see Working with Instruments and Effects)
or an external synth fed via the track’s output routing (see Routing and I/0). The MIDI clip (see
MIDI Clips and MIDI Files) provides the device with a musical score to play, specifying note pitch,
length, position and dynamics (referred to as velocity in the MIDI lexicon). MIDI is composed and
edited in Live’s MIDI Editor.

11.1 Creating an Empty MIDI Clip

MIDI clips are created
® by means of recording (see Recording New Clips);

® or by double-clicking an empty Session slot in a MIDI track;

122
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® or by selecting an empty Session slot in a MIDI track and choosing the Insert menu’s Insert
MIDI Clip command;

® or, in the Arrangement View, by selecting a timespan in a MIDI track and choosing the Insert
menu'’s Insert MIDI Clip command.

11.2 The MIDI Editor

To bring up the MIDI Editor, double-click a MIDI clip to open the Clip View. You can use the Clip
View Box selector to make sure the Notes box (see The Notes Box) is showing, then click in the title
bar of the Notes box to bring up the MIDI Editor on the right-hand side of the screen.

Nores + Envelopes *
[27.3 274 (28
-—
+ + §lc4
. - | = =3
| — = == |
> ] * =
-_—
[ ——— — — — — —]
[—] j——]
i~ ~ ] —
o - == ==
----- -+ j + |
127
54_
.

——1 4-MID s

The MIDI Editor.

The MIDI Editor is comprised of two editing windows: the upper Note Editor and the lower Velocity
Editor. You can resize the Velocity Editor by dragging on the split line that runs between it and
the Note Editor. You can also show and hide the Velocity Editor using the triangular button on the
left-hand side of the split line.
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Switch to Draw Mode by activating the Control Bar's Draw Mode switch. You can now draw MIDI notes
into the Note Editor with the mouse. Deactivating Draw Mode allows notes to be selected and moved
around by clicking and dragging, either vertically to change their transposition, or horizontally to
change their position in time.

Note velocity is adjusted in the Velocity Editor, by clicking and dragging on the associated markers.
You can also use Draw Mode in the Velocity Editor: It will draw identical velocities for all notes
within a grid “tile.”

After drawing a few notes and moving them around, you will probably want to know how to get
around in the Note Editor. So, before we get into detailed editing information, we will first explain
MIDI Editor navigation.

The Control Bar’s Draw
Mode Switch.
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11.3 Navigation and Resizing the Editor
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The MIDI Editor has both vertical and horizontal navigation. Along the horizontal axis lies a time
ruler, which shows note position along a musical timeline. The vertical axis contains both the note
ruler, displaying octaves CO - C10, and a representation of a piano keyboard (the piano roll).
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1. To smoothly change the time-zoom level, click and drag vertically in the time ruler. Drag
horizontally in the time ruler to scroll from left to right.

MIDI Editor Navigation.

2. Click and drag vertically in the note ruler to change which octaves are shown, or drag hori-
zontally to change the vertical zoom size of MIDI notes and the keyboard.

3. Click and drag over one or more notes to define a selection. Then, double-click on the note
ruler to automatically zoom in on your selection. If no notes are selected, double-clicking the
note ruler will zoom in on the area from the lowest to the highest note in the clip.

4. To zoom in and out around the current selection, use the computer keyboard’s + and - keys.

5. The Clip Overview just beneath the MIDI Editor can also be used for navigation. It always
shows the complete contents of the selected MIDI clip. The black rectangular outline repre-
sents the part of the clip that is currently displayed in the Editor above. To scroll, click within
the outline and drag left or right; to zoom in and out, drag up and down.
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6. Change the length of what is shown in the Editor by dragging the left or right edges of the
outline in the Clip Overview.

7. To quickly change what is shown in the Editor, click on a section that you want to examine in
the Clip Overview, then drag downwards to zoom in, or scroll by dragging left and right.

8. The Page Up and Page Down keys on your computer keyboard scroll the Note Editor vertically.
The (PC) / (Mac) modifier will change this to horizontal scrolling.

"-Pl.Ei—
|

The area displayed in the Note Editor can be set to scroll with playback using the Follow switch from
the Control Bar.

As you work with MIDI, you may find yourself needing extra screen space. You can click and drag
vertically on the window split between the Session or Arrangement Views and the Clip View to enlarge

the MIDI Editor.
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The Control Bar’s Follow
Switch.

Enlarge the MIDI Editor by
Dragging the Window Split
Between Session and Clip
Views.
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11.4 Editing MIDI

11.4.1 Non-Destructive Editing

You can always return your MIDI clip to its previous state by using the Edit menu’s Undo command.
Furthermore, if the MIDI clip being edited originated in a MIDI file on your hard drive, none of your
editing will alter the original MIDI file, as Live incorporates its contents into your Live Set when
importing.

11.4.2 Folding and Looping

An important feature of the MIDI Editor is the Fold button, located in the upper left corner. Ac-
tivating this button will immediately hide all rows, or key tracks, that do not contain MIDI notes.
This is very useful when working with percussion kits, for example, which are oftentimes mapped out
along a keyboard in sections corresponding to percussion type (e.g., snares grouped together two
octaves down from hi-hat cymbals, etc.). When working with a MIDI file created by such a mapping,
sometimes only one or two of each type of percussion sound is used, and it becomes unnecessary to
view the entire keyboard range.

A Il = 1
>
>
| N N [ The Fold Button Extracts
& 8 Key Tracks Containing
- Notes.

When editing MIDI, you might find that you want to change which part of the clip you are listening
to, or loop the clip in order to listen to it repeatedly. You can use the Clip Loop/Region markers
(see Sample Loop/Region) for this.
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11.4.3 Grid Snapping

Most functions in the MIDI Editor are subject to grid snapping (see Using the Editing Grid). You
can hold down the (PC) / (Mac) modifier while performing an action to bypass grid
snapping.

Note movements will also snap to an “offset,” which is based on the original placement of the note
relative to the grid. This is useful for preserving a groove or loose playing style that you do not
necessarily want to “set straight.”

11.4.4 Arranging and Quantizing Notes

As we have seen, notes in the MIDI Editor can be moved both horizontally (changing their position
in time) and vertically (changing their transposition). They can be moved either by clicking and
dragging, or with the arrow keys on your computer keyboard; in either case, they are subject to
grid and offset snapping. If you are playing the clip while you move notes, you can listen to them

Use the Clip/Loop Region
Markers to Select a Specific
Region of the Clip to Play.
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play in their new assignments as you drag them, without waiting until you have released the mouse
button.

Multiple notes can be selected and moved in unison: “Rubber-band” select more than one note with
one mouse motion by clicking in empty space, then dragging diagonally upward or downward to
enclose the notes in the dotted line that appears.

You can use the (& ] modifier to click and add individual notes or additional “rubber-band”
selections to your current selection. You can also remove a single note from your selection by
holding down and clicking on it. Holding and clicking on the piano roll selects
all notes in a single key track.

If you are working with an imported MIDI file or one that was recorded into Live, you may find
while editing that you want to quantize all or some of the MIDI notes. Notes in Live are quantized
according to the visible grid, which you can modify using a number of handy shortcuts (see Using
the Editing Grid). After choosing a quantization setting, rubber-band select the notes and choose
“Quantize” from the Edit menu, or use the (PC) / (Mac) hotkey. The selected
notes will promptly be aligned with the specified meter subdivisions.

11.4.5 Creating and Editing Notes

Selecting a note (or notes) makes it subject to commands from the Edit menu, such as Copy and
Paste. You can use the (Ctl ] (PC) / (At -5 (Mac) modifier to click and drag a copy of a note to
a new location.

The Edit menu’s Select Loop command selects all notes that begin within the Clip Loop/Region
markers. The Select Loop command can also be executed without the menu by simply clicking
the loop braces. This command can speed up editing when coupled with Clip Loop/Region marker
behavior (see Sample Loop/Region). Let’s say you have arranged a nice 1-bar loop in the Note
editor, and you want to duplicate it a couple of times. You can click the loop braces to select the
notes that begin within the loop, execute the Edit menu’s Copy command, shift the loop to the right
by one loop length with , and execute the Edit menu’s Paste command.
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As we have already seen, creating new MIDI notes is as simple as activating Draw Mode and drawing
them into the Note Editor. MIDI notes can also be added and deleted by double-clicking when Draw

Mode is inactive. You can click on the piano roll to “play” the keyboard and listen to the results.

Vertical movements in Draw Mode correspond to velocity changes. This means that, with one hor-
izontal motion and one vertical motion, you can draw multiple notes and their velocities without
releasing the mouse button. If you change velocity with this vertical movement, Live will remember

the change and use your new velocity on any notes that you draw afterward.

Copying (Above) and
Pasting (Below) a Loop.
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You may sometimes, by dragging or by drawing, place a new note on top of one that already exists.
If the new note overlaps with the beginning of the original note, the original note will vanish. The
original note is invisible, but still exists, and will reappear intact if the new note is moved away
again. If the new note overlaps with the “tail” of the original, the original note’s length will change
so that it lasts just until the new note’s beginning. This, too, is not an irreversible action, and the
old note length will be restored if the new clip is again moved.

11.4.6 Changing Note Length

Clicking and dragging on a note’s left or right edges changes its length. Note length can only be
changed when Draw Mode is inactive, and will be quantized unless the (Alt (PC) / (Mac)
modifier is held down while dragging.

(16 [16.2

Tip: To set a group of notes to the same length, select them all, grab the end of the longest one,
drag them all down to zero length and then extend them.

11.4.7 Editing Velocities

To change velocity for a MIDI note, click and drag on the associated marker in the Velocity Editor.
(To help you locate the velocity marker belonging to a MIDI note that may be stacked vertically with
others, Live highlights the velocity marker for whichever note your mouse is hovering over.) Velocity
changes will be shown numerically in a small display in the time ruler.

Changing Note Length.
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| 3 /3 |

As in the Note Editor, you can select multiple velocity markers to change by clicking with the

modifier held down.

Tip: To set a group of notes so that they all have the same velocity, select their markers in the
Velocity Editor, drag them up to maximum velocity and then decrease velocity to the desired value.

As we saw earlier, Draw Mode allows drawing identical velocities for all notes within a grid tile.
Velocity drawing can be limited to only those notes that are currently selected if the
modifier is held. To draw markers individually (as you would want to with a crescendo, for instance)
deactivate the grid display switch in the upper right corner of the MIDI Editor, or simply hold down
the (PC) / (Mac) modifier.

Changing Note Velocity.
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Tip: To draw a velocity ramp with notes that are all in the same key track, press and click

Drawing Identical Velocities
(Above) and a Crescendo
(Below).
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on the piano roll to select all notes within the desired key track, make sure Draw Mode is activated
and draw the ramp into the Velocity Editor while holding the modifier, so that you affect
only the selected notes.

Notes in the Note Editor display their velocity in their coloring- light notes play softly, and vice
versa. To change the velocity of notes without the Velocity Editor open, click any selected note and
drag vertically while pressing the the (PC) / (Mac) modifier.



Chapter 12

Launching Clips

The Live Session View is set apart by the fact that it gives you, the musician, an spontaneous
environment that encourages performance and improvisation. An important part of how you take
advantage of the Session View lies within how you configure your various Session View clips. This
chapter explains the group of settings used to define how each Session View clip behaves when
triggered, or “launched.”

12.1 The Launch Box

Remember that clips in the Session View are launched by their Clip Launch buttons (see Session View
Clips) or remote control (see MIDI and Key Remote Control). Clip launch settings are made in the
Launch box. The Launch box only applies to Session View clips, as Arrangement View clips are not
launched but played according to their positions in the Arrangement.

136
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To view the Launch box, open the Clip View (see Clip View) of a Session View clip by double-clicking
the clip, then activating the leftmost Clip View Box selector panel.

Clip Launch Sampie -+
BICSAMPL || Launch Mode  83CSAMPLAIF (4R Warp Loop
Trigge: 29.4 kHz 16 Bit 2 Ch | Orig. BPM | |[FOS -
Signatune Legato Edit ) (Repl (Save
4 |1 4 Quantization Hi-Q | |[Fade RAM 2% (%2 | End >
Groave slobal Transpose
Swing 8 0. -
Follow Action m r 3]
0 0 sl T
@@o u [ Detune 7 il
0 Dct 0.00 dB C e
Use the Clip View Box
Selector to Bring up the
Launch Box.
12.2 Launch Modes
Clip Launch Sample
OLYMP Fan g Launch Mode | oL yvP anp
T X .
44.1 kHz Orig. BEM The Clip Launch Mode
CHEL Edit) (Repl

Signaiure

Chooser.

The Launch Mode chooser offers a number of options for how clips behave with respect to mouse
clicks, computer keyboard actions or MIDI notes:

e Trigger: ‘down’ starts the clip; ‘up’ is ignored.
® (Gate: ‘down’ starts the clip; ‘up’ stops the clip.

® Toggle: ‘down’ starts the clip; ‘up” is ignored. The clip will stop on the next down.
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e Repeat: As long as the mouse switch/key is held, the clip is triggered repeatedly at the clip
quantization rate.

12.3 Clip-Level Quantization

Clip Launch Sample
WYMP FAN aunch Mode HYMP FAN. 2l (4 Warp
Trigge 44,1 kHz 16 BL 1 Ch | Cirig. BPM
Signature Legato Edit) (Repl) (Save
4 |if 4 | Quantization Q| [Fade |Ram
g Iranspose The Clip Quantization
warnoe T | Chooser.

The Clip Quantization chooser lets you adjust an onset timing correction for clip triggering. To
disable clip quantization, choose “None.”

To use the Control Bar's Global Quantization setting, choose “Global.”

Note that any setting other than “Global” or “None” will quantize the clip’s launch when it is
triggered by Follow Actions (see Follow Actions).
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12.4 Velocity

Clip Launch Sample
Launch Mode OLYMP FAN aifl 4=

44 1 EHZ 16 Bil

yaiure Legato Edit

_\-’el-_ﬂﬁ’% 1
m The Velocity Amount Field.

The Velocity Amount control allows you to adjust the effect of MIDI note velocity on the clip’s
volume: If set to zero, there is no influence; at 100 percent, the softest notes play the clip silently.
For more on playing clips via MIDI, see the respective section (see MIDI Remote Control).

12.5 Legato Mode

Clip Launch Sample
; FA aunch Mode HYMP FAN. 2l (4
Tl 44 1 kHz 16 Bit 1 Ch
Signalure | Edit) (Repl) (Save
4 |i[ 4 | "Quantzation |Hi-G] [Fade| [RAM The Legato Mode Switch.

Suppose you have gathered, in one track, a number of looping clips, and you now want to toggle
among them without losing the sync. For this you could use a large quantization setting (one bar or
greater), however, this might limit your musical expression.

Another option, which works even with quantization turned off, is to engage Legato Mode for the
respective clips. When a clip in Legato Mode is launched, it takes over the play position from
whatever clip was played in that track before. Hence, you can toggle clips at any moment and rate
without ever losing the sync.
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Legato Mode is very useful for creating breaks, as you can momentarily play alternative loops and
jump back to what was playing in the track before.

Unless all the clips involved play the same sample (differing by clip settings only), you might hear
dropouts when launching clips in Legato Mode. This happens because you are unexpectedly jumping
to a point in the sample that Live has had no chance to pre-load from disk in advance. You can
remedy this situation by engaging Clip RAM Mode (see Clip RAM Mode) for the clips in question.

12.6 Follow Actions

Follow Actions allow creating chains of clips that can trigger each other in an orderly or random way
(or both). A clip’s Follow Action defines what happens to other clips in the same group after the clip
plays. A group is defined by clips arranged in successive slots of the same track. Tracks can have an
unlimited number of groups, separated by empty slots.

Clip Launch Sample -+
MNP aunch Mode S3CSAMPLAIF (4 Warp Loop
Trigoe 29.4 KHz 16 Bit 2 Ch 1. BPI Pos -+
Signalure Legalo Edit) (Repl) (Save
1 4 |if 4 Tuantization Hi-Q | [Fade| |RAM 2)("2)  End +
rOOVE slobal Transpose bese 5
SwinG 8 jod 1 [ Beals engt -
Follow Action m T —
S rora| b e e
M :IIl 1 ¢l 0.00 dB
3

1. The Follow Action Time control defines when the Follow Action takes place in bars-beats-

sixteenths from the point in the clip where play starts. The default for this setting is one
bar.

The Follow Action Controls.
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2. The Follow Action choosers allow selecting two different Follow Actions, A and B.

3. The Chance A and Chance B controls set the likelihood of each of the two Follow Actions
occurring. If a clip has Chance A set to 1 and Chance B set to 0, Follow Action A will occur
every time the clip is launched. As we can see from this example, a Chance setting of 0 means
that an action will never happen. Changing Chance B to 10 in this scenario makes Follow
Action A occur much less often- approximately once out of every ten clip launches.

There are eight Follow Actions available:
» “Play Clip Again” restarts the clip.

+ “Play Next Clip” triggers the next clip down in the group. If a clip with this setting is last in a
group, this Follow Action triggers the first clip.

+ “Play Previous Clip” triggers the previous clip (the one above the current one).
# “Play Any Clip” plays any clip in the group.

m “Stop” simply stops the clip after it has played for the chosen Follow Action Time. Note that
this overrides clip loop/region settings.

= “Play First Clip” launches the first (top) clip in a group.
= “Play Last Clip” launches the last (bottom) clip in a group.
There is also the possibility to choose no Follow Action by leaving the chooser blank.

Note that a Follow Action happens exactly after the duration that is specified by the Follow Action
Time controls unless clip quantization is set to a value other than “None” or “Global.” Follow Actions
circumvent global quantization but not clip quantization.

So, why do you need these things? Music is repetition and change. Music based on loops or short
melodic fragments has a tendency to sound static. Follow Actions allow you to create structures that
will repeat but can also be surprising. Remember that you can always record (see Recording New
Clips) the results of your experiments, so this can provide a good source for new material.
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In the following sections we will look at some practical examples and ideas for Follow Actions.

12.6.1 Looping Parts of a Clip

Let’s say that you want to play a longer clip, but then you want only the last eight bars to loop. You
can set this up using Follow Actions:

1. Drag the clip into the Arrangement View and make sure that the Clip View’s Loop switch is not
activated. Use the Edit menu’s Split command (see Splitting Clips) to split the clip between
the non-looping and looping parts.

2. Click and drag the resulting two clips into the Session View by letting the mouse cursor hover
over the Session View selector. Drop the two clips into a track. They now form a Follow Action

group.
2 Audio 3Audic |4 MIDI
2w [Tiesiesd] =
= | [[orsiient™]
] ] ]
] ] ]
Follow Adction (T)
s dld !
7 [0 ] : Creating a Group With the

Two Clips.

3. Set up Follow Actions for the first clip. You will want to make Follow Action Time equal to the
clip’s length. Set the Follow Action A chooser to “Play Next Clip,” with a Chance setting of 1,
leaving Follow Action B alone. Now this clip is set up to advance to the looping clip after it

plays.
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4. Activate the Loop switch for the second clip.

The first clip will now proceed to the second after it has played in its entirety; the second clip will
simply play in a loop until it is stopped.

12.6.2 Using Multiple Warp Modes

Live has several Warp Modes (see Adjusting for Good Stretching Quality), each of which is useful
for time-stretching samples containing certain types of musical material. Follow Actions allow
combining Warp Modes when one is dealing with a sample containing various types of sounds.

Imagine that you have a long clip containing mostly material that sounds best when set to Beats
Mode. However, there is a violin solo in the middle of the clip that sounds better in Tones Mode.
In this case, you can use the Arrangement View's Split command, as explained earlier (see Looping
Parts of a Clip), to separate the clip into multiple clips— those that you want to play in Beats Mode
and the solo that you want to play in Tones Mode.

These clips can then be lined up as a Follow Action group in the Session View. They can be set up
to flow together just as the original clip did by setting the Follow Actions to “Play Next Clip” and
the Follow Action Times to match their respective lengths. The only audible difference between this
group of clips and the original piece will be that the clip containing the violin solo can now have
its own Warp Mode settings.

12.6.3 Creating Cycles

One of the most obvious possibilities that Follow Actions open up is using a group of samples to
form a musical cycle. If we organize several clips as a group and use the “Play Next Clip” Follow
Action with each clip, they will play one after the other ad infinitum, or until we tell them to stop.

Cycles can be peppered with occasional rearrangements through the addition of other Follow Actions,
such as “Play Any Clip,” with smaller relative Chance settings.
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12.6.4 Temporarily Looping Clips

There are some interesting applications of Follow Actions when it comes to creating temporary
musical loops.

The default setting for Follow Action is actually a 1:0 chance that “Nothing” happens after the
Follow Action Time, which means that there is effectively no Follow Action. But now, imagine a
group consisting of one single clip. Follow Action A is set to “Play Clip Again,” with a Chance of 8.
Follow Action B is set to “None,” with a Chance of 1. The clip uses a long sample, and Follow Time
is set to one bar. Clicking on the clip will play the first bar, after which it will be very likely that it
will play the first bar again. However, after a few repetitions, it will eventually come to Action B-
“Nothing”- and continue playing the rest of the sample.

Or, a clip can be played from its start to a specific point, when its Follow Action tells it to “Play
Next Clip.” The same file can be used in the next clip in the group, but this one can be set to loop.
This second clip can have any manner of Follow Action settings, so that it might then play forever,
for a specified time or until random chance leads to the next clip in the group.

12.6.5 Adding Variations in Sync

Paired with clip envelopes (see Clip Envelopes) and warping (see Time-Warping Samples), Follow
Actions can be used to create all sorts of interesting variations within a group of similar clips.
You could, for example, use Follow Actions to randomly trigger clips with different MIDI-controller
clip envelopes, so that fine variations in pitch bend or modulation of an instrument or synth could
occur as the clips in a group interacted. Audio clips could morph between different effect or clip
transposition settings.

Using Follow Actions and Legato Mode together provides a powerful way of gradually changing a
melody or beat. Imagine that you have several identical clips of a melody that form a group, and
they are set up to play in Legato Mode (see Legato Mode). Whenever their Follow Actions tell them
to move on to another clip in the group, the melody will not change, as Legato Mode will sync the
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new play position with the old one in beat-time. The settings and clip envelopes of each clip (or
even the actual notes contained in a MIDI clip) can then be slowly adjusted, so that the melody
goes through a gradual metamorphosis.

12.6.6 Mixing up Melodies and Beats

You can let Follow Actions perform unpredictable remixes and solos for you: Use a clip containing a
beat or melody, and copy it so that there are several instances of it forming a group. Alternatively,
you can use several different beats or melodies that you want to mix together. The Clip Loop/Region
markers (see Sample Loop/Region) for each clip can be set differently, as can clip envelopes (see
Clip Envelopes) and other clip settings. As long as Follow Action Time in each clip is equal to the
length of the clip that you want to play, you can set up two Follow Actions with different Chance
values in each clip, launch a clip, and surprise yourself.

12.6.7 Creating Nonrepetitive Structures

Follow Actions are great when it comes to sound installations, as they allow you to create structures
that play for weeks or months and never exactly repeat. You can set the Follow Action Time controls
in a series of clips to odd intervals, and the clips will interact with each other so that they never
quite play in the same order or musical position. Remember that each clip can have two different
Follow Actions with corresponding Chance settings. . . have fun!



Chapter 13

Routing and I/0

In the context of Live, “routing” is the setup of the tracks” signal sources and destinations (i.e.,
their inputs and outputs). Routing happens in the mixer's track In/Out section, which offers, for
every track, choosers to select a signal source and destination. The mixer’s In/Qut section is Live’s
“patchbay.”

The mixer’s In/Out section is available only from the Session View. You can check the “In/Qut” View
menu entry or use the Mixer Section selector to access the In/Out section.

146
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For every track (except the Master), the In/Out section has the same layout:

® The upper chooser pair (“Audio/MIDI From”) selects the track’s input. Audio tracks have an
audio input, and MIDI tracks have a MIDI input. Return tracks receive their input from the
respective sends (see Return Tracks and the Master Track).

e The “Monitor” radio button selects the monitor mode, or the conditions under which the track’s
input is heard through the track.

® The lower chooser pair (“Audio/MIDI To”) selects the track’s output. All tracks have audio
outputs, except for MIDI tracks without instruments. Remember that instruments convert
MIDI to audio (see Devices and the Mixer).

Within a chooser pair, the upper chooser selects the signal category (“Ext.,” for instance, for external
connections via an audio or MIDI interface), and is called the Input/Output Type chooser. If this
signal type offers sub-selections or channels, they are available from the lower chooser, or the
Input/Output Channel chooser. In our “Ext.” example, these would be the individual audio/MIDI
inputs and outputs.
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13.1 Monitoring

“Monitoring,” in the context of Live, means passing a track’s input signal on to the track’s output.
Suppose you have set up an audio track to receive its input signal from a guitar. Monitoring then
means that the signal from your live guitar playing actually reaches the track’s output, via the track’s
device chain. If the track’s output is set to “Master,” you can hear the guitar signal, processed by
whatever effects are used, and delayed by whatever latency the audio hardware interface incurs (see
Adjusting the Overall Latency), over your speakers.

The In/Out section offers, for every audio track and MIDI track, a Monitor radio button with the
following three options:

e The default Auto-monitoring setting does the right thing for most straightforward recording
applications: Monitoring is on when the track is armed (record-enabled) (see Recording New
Clips), but monitoring is inhibited as long as the track is playing clips.

Imll
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e To permanently monitor the track’s input, regardless of whether the track is armed or clips are
playing, choose On. This setting effectively turns the track into what is called an “Aux” on
some systems: The track is not used for recording but for bringing in a signal from elsewhere
(for instance, a ReWire slave program). With this setting, output from the clips is suppressed.

e For audio tracks, software monitoring can be turned off altogether by choosing the Off option.
This is useful when recording acoustic instruments which are monitored “through the air,” when
using an external mixing console for monitoring or when using an audio hardware interface
with a “direct monitoring” option that bypasses the computer so as to avoid latency. Generally,

Audio and MIDI Track Arm
Buttons.
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it is preferable to work with an audio interface that allows for negligible latencies (a few
milliseconds). If you are recording into Live with monitoring set to “Off,” you may want to
make the Audio Preferences’ Overall Latency adjustment (see Adjusting the Overall Latency).

13.2 External Audio In/OQut

An audio interface’s inputs are selected by choosing “Ext. In” from the Input Type chooser of an
audio track. The Input Channel chooser then offers the individual input channels. Entries in this
chooser each have meters next to their names to help you identify signal presence and overload
(when the meter flashes red). Setting up the audio interface’s outputs works the same way via the
output chooser pair.

The list of available inputs and outputs depends on the Audio Preferences (see Audio Preferences
Setup), which can be reached via the Input and Output Channel choosers “Configure...” option. Note
that the Audio Preferences also provide access to the Channel Configuration dialogs (see Configuring
Audio Device Channels) which determine which inputs and outputs are used, and whether they are
available to Live as mono or stereo pairs. Essentially, the Channel Configuration dialog tells Live
what it needs to know about how the computer is connected to the other audio components in your
studio.

13.2.1 Mono/Stereo Conversions

When a mono signal is chosen as an audio track’s input, the track will record mono samples; otherwise
it will record stereo samples. Signals in the track’s device chain are always stereo, even when the
track’s input is mono or when the track plays mono samples.

Mono is turned into stereo simply by using the identical signal for left and right channels. When a
track is routed into a mono output, the left and right signals are added together and attenuated by
6 dB to avoid clipping.
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13.3 External MIDI In/Out

MIDI from the outside world is routed into Live just like audio. From the Input Type chooser of a
MIDI track, you can either select a specific MIDI input device or “All Ins,” which is the merged input
of all external MIDI devices. The Input Channel chooser offers the individual input channels of the
selected MIDI device and the merged signal of all channels, “All” As is the case with audio inputs,
the Input Channel chooser also has meters next to every entry to represent activity on the respective
in channel.

13.3.1 The Preferences’ Active MIDI Device List

Audic MIDI / Sync Plug-n Defaults Misc
Input Qutput
|Computer Keyboard [FiroWire 410
| FireWire 410

| [
- I >

You can configure which MIDI devices are made available to Live using the Active Devices section in
the MIDI Preferences. Live, by default, uses every available MIDI device. Reasons to exclude devices
from the list include eliminating troublemakers (unstable drivers and such), or leaving a device to
another application (applies only to Windows, where a single MIDI input device can only be used by
one application at a time).

The MIDI Device List in the
Preferences.
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13.3.2 Playing MIDI With the Computer Keyboard

Among the devices in the Active Devices list, you can see the “Computer Keyboard.” This is a pseudo-
device that generates MIDI notes from computer keyboard strokes. Using this pseudo-device, you
can generate MIDI even without a “real” MIDI input device.

The center row of letter keys on the keyboard will play notes corresponding to the white keys on
a piano, beginning on the left with the note C5. The black keys on a piano correspond to the
upper row of computer keys. The four leftmost letters on the lower row of the keyboard are used to
transpose the note range and to set velocity. The results of changing these values are displayed in
the Status Bar at the bottom of the Live screen.

As it happens, when the computer keyboard is set to send notes between C3 and C4, the keys are
mapped to MIDI notes such that the center row of the keyboard (ASDF...) addresses the Impulse
percussion sampler’s sample slots (see Impulse). This means that you can play and record drum
patterns right off the computer keyboard.

Note that this pseudo-MIDI device has nothing to do with Live’s ability to map controls to computer
keys (see MIDI and Key Remote Control) and that computer keys assigned to remote control will no
longer generate MIDI notes.

13.3.3 Connecting External Synthesizers

Routing MIDI to an external synthesizer is straightforward: The Output Type chooser is set to
whatever MIDI port the synthesizer is connected to; the Output Channel chooser is used to select
which MIDI channel to send on.

Important: If you are using a keyboard synthesizer both as a master keyboard to play into Live and
as a sound generator, then please make sure to check the synthesizer's “Local Off” function. Every
synthesizer has this function, which effectively separates the keyboard from the sound generator,
allowing you to treat both components as if they were separate devices. This allows you to use Live
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as the hub of your MIDI studio, which receives MIDI from the keyboard and dispatches the incoming
MIDI, as well as the MIDI from the clips, as appropriate.

13.3.4 MIDI In/Out Indicators

Live’s Control Bar contains three pairs of indicator “LEDs” that tell you about incoming and outgoing
MIDI. These indicators tell you not only about the presence of signals, but also about their use. In
every pair, the upper indicator flashes when a MIDI message is received, and the lower indicator
flashes when a MIDI message is sent.

ﬁ | 1.2 2p m|e =1 o|e o] 4 ﬁ ﬁ

The three indicator pairs represent:

1. MIDI Clock and Timecode signals that are used for synchronizing Live with other sequencers
(see Synchronizing via MIDI);

2. MIDI messages that are used for remote-controlling Live's user-interface elements (see MIDI
and Key Remote Control);

3. MIDI messages coming from and going to Live’s MIDI tracks.

MIDI messages that are mapped to remote-control Live's user-interface elements are “eaten up” by
the remote-control assignment and will not be passed on to the MIDI tracks. This is a common cause
of confusion that can be easily resolved by looking at the indicators.

13.4 Master and Cue Outs

The Master track (see Return Tracks and the Master Track) is the default destination for audio signals.
The Master track, in turn, is routed to the external audio outputs.

The Control Bar's MIDI
Indicators.
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The Cue/Preview Out can be independently routed to allow, for instance, for previewing samples and
cueing tracks via headphones (see Soloing and Cueing).

13.5 ReWire Slave Routing

Live can send MIDI to, and receive audio from, any ReWire slave application installed on the same
computer.

MIDI From
[anins

MIDI To
[Reason =] |[Master |

[MHXT 1

= ||

.

The following example shows how to send MIDI from one of Live’s MIDI tracks into an instrument
within Propellerhead’s Reason, and then route the audio result back into an audio track:

1. First, start Live.
2. Then, start Reason and set up the Reason rack as desired.

3. Select “Reason” from the MIDI track’s Output Type chooser.

An Audio Track Receiving
Audio From and a MIDI
Track Sending MIDI to
Reason.
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4, The Output Channel chooser presents you with a list of the instruments that you currently
have in your Reason rack; select the instrument you want to address.

5. Select “Reason” from the audio track’s Input Type chooser.

6. From the audio track’s Input Channel chooser, select the audio channel that corresponds to
the instrument to which you are sending MIDI.

7. Set the audio track’s Monitor radio button to “On.”
8. Select “All Ins” from the MIDI track’s Input Type chooser.
9. Arm the MIDI track.

Now, any MIDI that you are playing into Live will arrive in Reason, which will generate the corre-
sponding audio back into the audio track, ready for further processing in Live’s mixer and effects. If
you want to continue work on the project without reopening Reason, simply record Reason’s audio
by arming the audio track and engaging Record Mode.

13.6 Resampling

Live's Master output can be routed into an individual audio track and recorded, or resampled. Resam-
pling can be a fun and useful tool, as it lets you create samples from what is currently happening
in a Live Set that can then be immediately integrated. It can be used to record tracks that include
processor-intensive devices, so as to delete the devices, or for quickly previewing before rendering
to disk (see Exporting Audio).

The “Resampling” option in any audio track’s Input Type chooser will route the Master output to
that track. You can then decide on what exactly you will be resampling and mute, solo or otherwise
adjust the tracks that are feeding the Master output. You will probably want to use the Master
Volume meter to make sure that your level is as high as possible without clipping (indicated by red
in the meter). Then you can arm the track and record into any of its empty clip slots (see Recording
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Into Session Slots). Note that the recording track’s own output will be suppressed while resampling
is taking place, and will not be included in the recording.

Samples created by resampling will be stored in the Live Set’s Sounds folder (see The Sounds Folder
and Self-Containing).

13.7 Internal Routings

Live allows for inter-track routings. These routings, albeit potentially confusing, enable many valu-
able creative and technical options. Inter-track routing can work two ways:

1. Track A is set up to send its output signal to Track B. This is possible because every track that

can receive an output signal of the appropriate type from Track A shows up in its Output Type
chooser.

2. Track B is set up to receive its input signal from Track A. This works because every track that
delivers a signal of the appropriate type appears in Track B’s Input Type chooser.

! Track A 2Track B 3 Audio

1 Track A 2 Track B 3 Audio
Audio m Audio m Audio m

Audio From Audio From udio From

I Sl
Monitor Monitor | ii Tral:k ml
Onl (80| [GF (G| [Eita) (G Man -
Audio To udio To Audio To On| |Auto| (O |On| |Auto| (O
iaster Audio To Audio To Audio To
Master Master Master Two Ways to Route Track A
b || ~ . m into Track B.

Both approaches result in Track A's output being fed into Track B. Approach 1 leaves Track B's in/out
settings alone, and we can, at any time, add more tracks that feed their output into Track B. This
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is the method of choice for “many-to-one” routings such as submixes or several MIDI tracks playing
the same instrument.

Approach 2, on the other hand, leaves Track A unaffected except for Track B tapping its output. We
can easily add more tracks like Track B that all tap Track A's output. Instrument layering is a good
example of such a “one-to-many” routing setup.

The rest of this section presents internal routing examples in more detail.

13.7.1 Post-Effects Recording

Let’s say that you are feeding a guitar into Live, building up a song track by track, overlaying take
onto take. It is certainly powerful to have a separate effects chain per track for applying different
effects to different takes- after the fact. You might, however, want to run the guitar signal through
effects (a noise gate or an amp model, for instance) before the recording stage, and record the
post-effects signal.

3 Audio 4 Guitar < Audio & Audio ¥ Pad

l l l
Audio From  Audio From  Audio From |, 0
[Ext. In || [4-Guiltar  =||[4-Guitar _ =||;
[i12(nfa) _=||[fi Track Out_]| i Track Out_][;

Audio From

Maonitor Monitor Maonitor Monitor l
O [Auto] (G [Gal[Auta][C] [Gn] [Auta] o |5, 5
Audio To Audio To Audio To VDI To
[Master =| | [Master || [Master =y

| | | |
i i i i
MOHrEFOrOrdin
This is easily accomplished by devoting a special audio track for processing and monitoring the
incoming guitar signal. We call this track “Guitar” and drag the desired effects into its device chain.

Audio To

11 11]

An Example Setup for
Pre-Effects Recording.
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We do not record directly into the Guitar track; instead we create a couple more tracks to use for
recording. Those tracks are all set up to receive their input from the Guitar track.

As for monitoring, we set the Guitar track’s Monitor radio button to On, because we always want to
listen to our guitar through this track, no matter what else is going on in Live. The other tracks’
Monitor radio buttons are set to Off.

13.7.2 Recording MIDI as Audio

When working with MIDI and complex software instruments, it is sometimes more useful to record
the resulting audio than the incoming MIDI. A single MIDI note can prompt, for example, Native
Instruments” Absynth to produce something that sounds more like a piece of music than a single
tone. This output lends itself more to representation as an audio waveform than a single note in a
MIDI clip, particularly when comparing the editing options.

IETaka 1 sl @
o

=]
O 4z3 ||m |

Audio From | MIDI From
[3-Absynin =] [Computer kKe]
[l Track Oul_||[1 a1 Chann=]
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Audio To Audio To
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Recording the Output of a
Complex Instrument in
Audio Tracks.
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A setup similar to the one described above (see Post-Effects Recording) accomplishes the task. We
have one MIDI track hosting the virtual instrument, and we use additional audio tracks to record the
audio result of playing the instrument.

13.7.3 Creating Submixes

1 Snare 2 Bass 3 Hi-Hats 4 Submix 5 Audio
| |'lal-ce 1 | | |'late-5
[ [oryme ¢4

| I |
Audic From  Audio From  Audio From  Audio From
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[z <|i[1zinie | Il |

Monitor Monitor Monitor oaltor
[Gn] [Auto] [Off] [On] [Auto] [Off] On| [ B ) 0 [
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[4-Submix =] [4-Submix <||[4-Submix <||[Master <[
[Track In || [Track In || [Track In i
||
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q q L] L] q
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Drums of a Drum Kit.

Suppose we have the individual drums of a drum kit coming in on separate tracks for multitrack
recording. In the mix, we can easily change the volumes of the individual drums, but adjusting the
volume of the entire drum kit against the rest of the music is less convenient. Therefore, we add a
new audio track to submix the individual drums. The drum tracks are all set to output to the submix
track, which outputs to the Master. The submix track gives us a handy volume control for the entire
drum kit.
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13.7.4 Several MIDI Tracks Playing the Same Instrument

Consider a MIDI track containing a virtual instrument- a Simpler (see Simpler) playing a pad sound,
for example. We have already recorded MIDI clips into this track when we realize that we would like
to add an independent, parallel take for the same instrument. So we add another MIDI track. We
could now drag another Simpler into the new track, but we would really like to reuse the Simpler
from the pad track, so that changing the pad’s sound affects the notes from both tracks.

&8 Pad 9 Pad 2

B___ ST

MIDI From
] [aning

MIDI From
| [AllIng |
[1 4 Chann=| [ Al Channw|
Monitor Monitor
[Gn| [Gn|
Audio To MIDI To
[Master || [8-Pad |
] | |[1-Simpler -
Track In

|| e
ON.
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This is accomplished by setting the new MIDI track’s Qutput Type chooser to “Pad.” Note that the
Output Channel chooser now offers a selection of destinations: We can either feed the new track’s
output into the input of the pad track, or we can directly address the Simpler. The “Track In” option
in the Output Channel represents the pad track’s input signal (the signal to be recorded), which is
not what we want. We instead select “Simpler Ch. 1" to send the new track’s MIDI directly to the
Simpler, bypassing the recording and monitoring stage. With this setup, we can choose to record
new takes on either track and they will all play the same pad sound.

Feeding an Additional MIDI
Track Into an Existing MIDI
Track to Reuse its
Instrument.
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We might be bothered by the fact that muting the pad track (by turning off its Activator switch)
also mutes the other MIDI track. To be precise, the other track keeps playing, but its MIDI is played
by an instrument that is out of the mix. This can be easily remedied by cutting the clips from the
pad track and pasting them into a third track that can be independently muted (and that can hold
its own MIDI effects). The original pad track now acts as a mere instrument container. As we are not
recording new clips into this track, we can set its Input Type chooser to “No Input,” which makes its
Arm button disappear and helps to avoid confusion when the mixer’'s In/Out section is hidden.

13.7.5 Tapping Individual Outs From an Instrument

Some software instruments, like Live’s Impulse percussion sampler (see Impulse), offer multiple
audio outputs for the signals they produce. By default, Impulse mixes the output of its eight sample
slots internally and delivers the mix at the instrument’s audio out. Any audio effects following
Impulse in the same track process the composite signal. Sometimes it is desirable to take an
individual drum sound out of the mix for individual effects processing and mixing. This is possible
because Impulse offers its sample slots as audio sources to other tracks.

The Instrument Has Been
Isolated in a Dedicated
Track.
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We simply create an audio track and select from its Input Type chooser the track with the Impulse.
The Input Channel chooser now offers, in addition to “Track Out” (the audio signal at the end of the
track’s device chain), Impulse’s eight individual outputs, labeled according to the sample used in
each slot. Notice that routing an individual output from Impulse into another track automatically
takes this signal out of Impulse’s own internal mix. This convenience is not standard behavior of
most plug-in instruments, however.

13.7.6 Using Multi-Timbral Plug-In Instruments

Many plug-in instruments support multi-timbral operation. A multi-timbral instrument is like several
instruments in one, with each component “part” (or whatever term the manufacturer uses) receiving

Using Impulse’s Individual
Outs to Separately Process
Sample Slots.
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MIDI on a separate MIDI channel. Usually, the multi-timbral instrument offers individual outputs so
that the parts can be separately routed into the mixer. Or, the instrument might offer a submixer of
its own.

Audio From | Audio From | MIDI From MIDI From MIDI From
[3-Leas =|l[3-Lead <]|[anins =] |[an ns =] |[an Ins =|
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[Master =] |[Master =||[Master =||[F-lead  <||[3lead <]
| 11 i J|[2-Kontakt_<]|[10-Kontakt <]
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Sending MIDI to a multi-timbral instrument is a variation of a case described above (see Several
MIDI Tracks Playing the Same Instrument). One MIDI track hosts the multi-timbral instrument, and
additional MIDI tracks are used to feed its individual parts. Each additional MIDI track has its Qutput
Type chooser pointed to the track that contains the instrument, and its Output Channel chooser
referencing the target MIDI channel. Additional audio tracks can then be used to tap the instrument’s
individual outputs, as described earlier (see Tapping Individual Outs From an Instrument).

13.7.7 Feeding Sidechain Inputs

Some effects have so-called “sidechain inputs.” A vocoder, for instance, imposes spectral character-
istics taken from one signal (say, spoken word) onto another signal, for instance a string pad. The
vocoder is inserted as an audio effect into the string track. It has a sidechain input for the speech
signal, which has to be delivered from another track. So, we create an additional audio track named

Tracks Feeding MIDI to and
Tapping Audio From the
Parts of a Multi-Timbral
Instrument.
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“Speech” and set its Output Type chooser to the “Strings” track. From the Output Channel chooser,
we select the vocoder’s sidechain input.

1 Speech 2 Strings 3 MIDy¥ 4 MiDi
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Routing a Speech Signal
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Some vocoder plug-ins include a built-in synthesizer to generate the “carrier” signal. In this case,
the only difference from the above procedure is that the vocoder instrument is dragged into a MIDI
track. Feeding the side-chain audio input works as described above.

13.7.8 Layering Instruments

Suppose that we have a MIDI track containing an instrument playing a string sound, which we would
like to “lubricate” by adding a brass sound playing the same notes. This can be easily done by adding
a MIDI track that contains an instrument playing the brass sound and setting its Input Type chooser
to tap the string track’s output signal.



13.7. INTERNAL ROUTINGS 164

3 Audio 4 Strings 5 Brass & MDY

[ N

Audio From MIDI From MIDI From
Mo Input |5'Erasss Vl |NI Ins all Ins

Manitor
On| | Auta

Audio To MiDI To

[No Output_=||[No Dutput_=]fi, & 501
[ Il | Using an Auxiliary MIDI
- I H - . Track to Layer Instruments.

Perhaps you wonder why this works, given that the string track’s output is audio and not MIDI. When
routing MIDI in from another track, we are tapping the MIDI at the latest possible stage, which is
just before the instrument.



Chapter 14

Mixing

14.1 The Live Mixer

Live includes a mixer section that is accessible from two views:
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In the Arrangement View, the mixer appears as a horizontal strip to the right of the track area. To
display all mixer controls for a track, unfold the track using the triangular button next to its name,

and adjust its height accordingly.

5

Stop Clips

The Session View is a standard vertical mixer layout. You'll likely find the Session View mixer more
intuitive than the Arrangement mixer, which comes in handy when you work with automation (see
Automation and Editing Envelopes). Note that the Tab key toggles between the Arrangement and

Session Views.

The View menu options listed below show or hide mixer components. You can use different mixer

The Arrangement View
Mixer.

The Session View Mixer.
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view setups in the Session View and in the Arrangement View:

e (Clips

In/Out

Sends

® Returns

* Mixer

Crossfader

Uncheck “Clips” from the View menu to hide the clips from the Session View mixer, thus creating a
more spacious mixer layout that fits more tracks on screen.

The Mixer Section selector on the right-hand side of the screen makes it possible to quickly show or
hide different mixer components.

Let’s look at the mixer controls:

The Mixer Section Selector.
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i 1;;
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The Meter shows the track’s RMS (average) and peak output level. While monitoring, however,
it shows the input level.

1

The Mixer Controls.

: ?ﬂ?

2. The Volume control adjusts the track’s output level.

3. The Pan control positions the track’s output in the stereo field. To reset the pan control to
center, click on the little triangle.

4. To mute the track’s output, turn off the Track Activator switch.

5. The Solo switch solos the track by muting all other tracks, but can also be used for cueing (see
Soloing and Cueing). Tracks can only be soloed one at a time unless the Exclusive Solo option
in the Misc Preferences is deactivated. Alternatively, you can hold down the (Ctl ) (PC) /

(Mac) modifier to solo more than one track.

6. If the Arm Recording button is on, the track is record-enabled (see Recording New Clips).
Tracks can only be armed one at a time unless the Exclusive Arm option in the Misc Preferences
is deactivated. Alternatively, you can hold down the (Cul | (PC) / (@ % (Mac) modifier
to arm more than one track.

14.2 Audio and MIDI Tracks

Audio and MIDI tracks in Live are for hosting and playing clips, as explained earlier (see Tracks).
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You can add new audio and MIDI tracks to your Live Set’s mixer at any time using the appropriate
Insert menu commands. Tracks can also be created by dragging objects from the Browser into empty
mixer or clip space according to the following rules:

e A MIDI track will be created if a MIDI effect or an instrument is dragged into empty space in
the mixer.

® An audio track will be created if an audio effect is dragged into empty space in the mixer.

® Any devices or files dragged into empty space in the clip area will create a track of the
appropriate type.

A track is represented by its Track Title Bar. You can click on a Track Title Bar to select the track
and then execute an Edit menu command, such as “Rename,” on the track. One can quickly rename
a series of tracks by executing this command and then using the Tab key to move from Title Bar to
Title Bar.

2 Audio Master

You can also drag tracks by their Title Bar to reorder them.

Tracks are deleted using the Edit menu’s Delete command.

14.3 Return Tracks and the Master Track

In addition to tracks that play clips, a Live Set has a Master track and up to twelve return tracks;
these cannot play clips, but allow for more flexible signal processing and routing.

The return tracks and the Master track occupy the right-hand side of the Session mixer view and the
bottom end of the Arrangement View. Note that you can hide and show the return tracks using the

Tracks are Represented by
Track Title Bars.
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Returns command in the View menu.

Like the “normal” clip tracks, the returns and the Master can host any number of effects (see Working
with Instruments and Effects). However, whereas a clip track’s effect processes only the audio within
that track, return tracks can process audio sent to them from numerous tracks.

For example, suppose you want to create rhythmic echoes with a delay effect. If you drag the effect
into a clip track, only clips playing in this track will be echoed. Placing this effect in a return track
lets it receive audio from any number of tracks and add echoes to them.

Sends Sands Sends Sarlda

| GD C) GD
MO OFOH (UII

A clip track’s Send control regulates how much of the clip track’s output feeds the associated return
track’s input. What's more, even the return track’s own output can be routed to its input, allowing
you to create feedback. Please use this feature with care, as runaway feedback can boost the level
dramatically and unexpectedly.

Every return track has a Pre/Post toggle that determines if the signal a clip track sends to it is
tapped before or after the mixer stage (i.e., the pan, volume and track-active controls). The “Pre”
setting allows you to create an auxiliary mix that is processed in the return track, independently of
the main mix. As the return track can be routed to a separate output (see Routing and I/0), this
can be used to set up a separate monitor mix for an individual musician in a band.

The Master track is the default destination for the signals from all other tracks. Drag effects here
to process the mixed signal before it goes to the master output. Effects in the Master track usually
provide mastering-related functions, such as compression and/or EQ.

You can create multiple return tracks using the Insert menu’s Insert Return Track command, but by

The Send Controls and
Pre/Post Toggle.
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definition, there is only one Master track.

14.4 Using Live’s Crossfader

Live includes a crossfader that can create smooth transitions between clips playing on different
tracks. Live's crossfader works like a typical DJ-mixer crossfader, except that it allows crossfading
not only two, but any number of tracks- including the returns.

The crossfader is accessed via the Session View mixer.

M

&7
|

The Crossfader.

The crossfader is a horizontal slider that can be mapped to any continuous MIDI controller (absolute
or incremental).

mll
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A Track’s Crossfade Assign
Buttons.
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Each track has two Crossfade Assign buttons, A and B. The track can have three states with respect
to the crossfader:

e If neither Assign button is on, the crossfader does not affect the track at all.

e If Ais on, the track will be played unattenuated as long as the crossfader is in the left half of
its value range. As the crossfader moves toward the right across the center position, the track
fades out. At the crossfader’s rightmost position, the track is muted.

o Likewise, if B is on, the track’s volume will be affected only as the crossfader moves left across
its center position.

The crossfade-assign section is treated like one control with respect to MIDI mapping; please see
the MIDI mapping section for details (see MIDI and Key Remote Control).

It is important to understand that the Crossfade Assign buttons do not affect the signal routing: The
crossfader merely influences the signal volume at each track’s gain stage. The track can be routed to
an individual output bus regardless of its crossfade assignment. In studio parlance, you can think of
the crossfader as an on-the-fly VCA group.

As with almost everything in Live, your crossfading maneuvers can be recorded into the Arrangement
(see Automation and Editing Envelopes) for later in-depth editing. To edit each track’s crossfade
assignment, please choose “Mixer” from the Envelope Device chooser and “X-Fade Assign” from the
Control chooser. The crossfader’s automation curve is accessible when “Mixer” is chosen from the
Master track’s Device chooser and “Crossfade” is selected from its Control chooser.

14.5 Soloing and Cueing

By default, soloing a track simply mutes all other tracks. The signal from the soloed tracks is heard
through their respective outputs, with the pan setting of each track preserved. Soloing a clip track
leaves the return tracks unaffected (solo in place). Soloing a return track affects all other tracks.
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Live allows you to replace the standard soloing operation with a cueing operation that lets you
preview tracks as though you were cueing a record on a DJ mixer. This allows choosing clips and
adjusting effects without the audience hearing, before bringing tracks into the mix.

In order to set Live up for cueing, you must be using an audio interface with at least four dedicated
outputs (or two dedicated stereo outputs). The respective settings are accessible in the Session
View mixer. Make sure you have “Mixer” and “In/Out” checked from the View menu.
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1. The Master Out chooser selects the output on your interface to be used as the main output.

2. The Cue Out chooser selects the output on your hardware interface to be used for cueing. This
has to be set to an output other than that selected for the Master. If the desired outputs
don't show up in these choosers, please check the Audio Preferences (see Audio Preferences
Setup).

3. Activate cueing by setting the Solo/Cue Mode switch to “Cue.”

4. The tracks” Solo switches are now replaced by Cue switches with headphone icons. When
a track’s Cue switch is pressed, that track’s output signal will be heard through the output

The Cueing-Related Session
Mixer Controls.
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selected in the Cue Out chooser. Note that the Track Activator switch on the same track still
controls whether or not the track is heard at the Master output.

5. The Cue Volume control adjusts the volume of the cueing output.

Note that when cueing is set up and activated, the output of audio files that you are previewing in
the Browser is also heard through the Cue Out.



Chapter 15

Recording New Clips

This chapter is about recording new clips from audio and MIDI input signals. Note that this is a
different kind of recording than the capturing of Session clips into the Arrangement (see Recording
Sessions into the Arrangement).

15.1 Setting up Preferences

For successful audio recording, please make sure the audio preferences are set up properly (see Audio
Preferences Setup). Also, keep in mind that devices such as microphones, guitars and turntables do
not operate at line level, meaning that they will need to have their levels boosted before they can
be recorded. For these devices, you must therefore use either an audio interface with a preamp, or
an external preamp.

The following Misc Preferences are relevant to the sample files that are created by recording:

175
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e The sample file type you would like Live to create can be chosen from the Record File Type
chooser in the Misc Preferences.

e The bit depth of the sample file you will create by recording can be chosen from the Record
Bit Depth chooser in the Misc Preferences.

® The Audio Record Folder selected in the Misc Preferences is the disk location where Live will
put the samples you record into an unnamed Live Set. When the Live Set is saved, Live will
attempt to move (space permitting) all samples from the temporary record folder to the saved
Live Set’s Sounds folder (see The Sounds Folder and Self-Containing).

You can save time by setting up reasonable defaults for the clips you are recording in the Defaults
Preferences tab. In particular, it is smart to indicate the rough category of sound to be recorded
by choosing the appropriate default Warp Mode. If you decide later on a different song tempo, the
program will automatically maintain good sound quality (see Adjusting for Good Stretching Quality),
usually without further adjustment.

15.2 Recording in Sync

Live keeps the audio and MIDI you have recorded in sync, even when you later decide on a different
song tempo. In fact, Live allows you to change the tempo at any time before, after and even during
recording. You could, for instance, cheat a bit by turning down the tempo to record a technically
difficult part, and pull it up again afterwards.

It is important to record in sync to make sure everything will later play in sync.
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The easiest way to record in sync is to play along with or to use the built-in metronome, which is
activated via its Control Bar switch and will begin ticking when the Play button is pressed or a clip

The Metronome Switch.
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is launched.
M

To adjust the metronome volume, use the mixer's Preview Volume knob.

Notice that Live’s metrical interpretation of the audio being played can be edited, at any time, using
the Warp Markers (see Time-Warping Samples). Warp Markers can be used to fix timing errors and
to change the groove or feel of your recordings. Using Warp Markers, you can fix things in your
recordings that would otherwise require complicated editing or could not be done at all. Likewise,
the metrical interpretation of recorded MIDI can be changed after recording, using the MIDI clip’s
Original BPM controls (see The Notes Box).

15.3 Recording Quantized MIDI Notes

If you will be recording MIDI, you have the option of automatically quantizing MIDI notes while
recording. The Record Quantization chooser in the Edit menu allows selecting the meter subdivisions
with which your recorded notes will align. When recording into Session slots (see Recording Into
Session Slots) or into the Arrangement (see Recording Into the Arrangement), record quantization
is an independent step in Live’s Undo history. This means that if, for example, you recorded with
Record Quantization set to “Eighth Note Triplet Quantization” and then changed your mind, using
the Edit menu’s Undo command would undo only the quantization and leave your recording otherwise
intact.

For Session and Arrangement recording, the Record Quantization setting cannot be changed mid-
recording.

The Preview Volume Knob.
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When overdub recording (see Overdub Recording MIDI Patterns) with the Clip View Loop activated,
changes to the Record Quantization take effect immediately, and they cannot be separately undone
with the Edit menu command.

Recorded MIDI notes can also be quantized post-recording with the Edit menu’s Quantize command,
as described in the chapter on editing MIDI (see Arranging and Quantizing Notes).

15.4 Choosing an Input

A track will record whatever input source is shown in its In/Out section, which appears in the Session
View when the View menu’s “In/Out” option is checked.
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Audio tracks default to recording a stereo signal from the external input pair “1/2.” MIDI tracks
default to recording all MIDI that is coming in through the active external input devices (see The
Preferences’” Active MIDI Device List). The computer keyboard is, by default, activated as a pseudo-
MIDI input device (see Playing MIDI With the Computer Keyboard), allowing you to record MIDI even
if no MIDI-controller hardware is currently available.
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For every track, you can choose an input source other than the default: any mono or stereo external

Track In/Out Section in the
Session View.
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input, a specific MIDI channel from a specific MIDI-in device, audio from ReWire slave programs or
a signal coming from another track. The Routing chapter (see Routing and I/0) describes these
options in detail.

15.5 Arming (Record-Enabling) Tracks
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To select a track for recording, click on its Arm button. It doesn’t matter if you click a track’s Arm
button in the Session View or in the Arrangement View, since the two share the same set of tracks
(see Tracks).
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By default, armed tracks are monitored, meaning that their input is passed through their device
chain and to the output, so that you can listen to what is being recorded. This behavior is called
“auto-monitoring” and you can change it to fit your needs (see Monitoring).

Clicking one track’s Arm button unarms all other tracks unless the (PC) / (Mac)
modifier is held. Arming a track selects the track so you can readily access its devices in the Track
View (see Working with Instruments and Effects).

Track Arm Buttons in the
Session (Left) and
Arrangement (Right)
Mixers.
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15.6 Recording

Recording can be done in both the Session and the Arrangement Views. If you want to record onto
more than one track simultaneously and/or prefer viewing the recording linearly and in-progress,
the Arrangement View may be the better choice. If you want to break your recording seamlessly into
multiple clips or record while you are also launching clips in Live, use the Session View.

15.6.1 Recording Into the Arrangement

EXT p 9. 4 =+ | Bar &

3 21 n
¥ 1 .Audio alfs|[®]]|1 ji
¥ 2 Audio a] H . 2 ii
& 3 MiDI q][s JE' 3 i
¥ 4 MDY a] ] ® 4

1. Recording commences when the Control Bar's Record button is activated and the Play button
is pressed.

Recording Into the
Arrangement.
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2. Recording creates new clips in all tracks that have their Arm button on.

3. When the Overdub switch is on, the new clips contain a mix of the signal already in the track
and the new input signal. The Overdub option only applies to MIDI tracks.

4, To prevent recording prior to a punch-in point, activate the Punch-In switch. This is useful
for protecting the parts of a track that you do not want to record over and allows you to set
up a pre-roll or “warm-up” time. The punch-in point is identical to the Arrangement Loop’s
start position.

5. Likewise, to prevent recording after the punch-out point, activate the Punch-Out switch. The
punch-out point is identical to the Arrangement Loop’s end position.

6. When you are recording into the Arrangement Loop (see The Arrangement Loop), Live retains
the audio recorded during each pass.

You can later “unroll” a loop recording, either by repeatedly using the Edit menu’s Undo command
or graphically in the Clip View: After loop recording, double-click on the new clip. In the Clip View's
Sample Display, you can see a long sample containing all audio recorded during the loop-recording
process. The Clip View's Clip Loop/Region markers (see Clip View) define the audio taken in the last
pass; moving the markers left lets you audition the audio from previous passes.

15.6.2 Recording Into Session Slots

You can record new clips, on the fly, into any Session slots.
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1. Set the Global Quantization chooser to any value other than “None” to obtain correctly cut
clips.

2. Activate the Arm button for the tracks onto which you want to record. Clip Record buttons
will appear in the empty slots of the armed tracks.

3. Click on any of the Clip Record buttons to commence recording. A new clip will appear in the
slot with a red Clip Launch button that shows it is currently recording. To go from recording
immediately into loop playback, press the clip’s Launch button.

4, Alternatively, you can click a Clip Stop button or the Stop button in the Control Bar to stop
recording, leaving the new clip silent.

Note that, by default, launching a Session View scene (see Tracks and Scenes) will not activate
recording in empty record-enabled slots belonging to that scene. However, you can use the Start

Recording a New Clip Into
the Session View.
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Recording on Scene Launch option from the Misc Preferences to tell Live that you do want empty
scene slots to record under these circumstances.

15.6.3 Overdub Recording MIDI Patterns

Live makes pattern-oriented recording of drums and the like quite easy. Using Live’s Impulse (see
Impulse) instrument and the following technique, you can successively build up drum patterns while
listening to the result. Or, using an instrument such as Simpler (see Simpler), which allows for
chromatic playing, you can build up melodies or harmonies, note by note.

1.
2.

Set the Global Quantization chooser to one bar.

To automatically quantize the notes you are about to record, choose an appropriate value for
Record Quantization (see Recording Quantized MIDI Notes).

. Double-click any of the Session View slots in the desired MIDI track (the one containing the

Impulse or other instrument). A new, empty clip will appear in the slot. The new clip will
default to a loop length of one bar, but you can change that by double-clicking the clip and
changing its loop properties (see The Notes Box).

Arm the track.

. Launch the clip.

. The notes you play are added into the looping clip, and you can observe your recording in the

Clip View.

. By default, the Control Bar's Overdub switch is activated, so that you can build your pattern

layer by layer. However, if you would like to pause recording for a moment to rehearse, you
can deactivate the Overdub switch. The contents of the clip will continue to play, but you can
play along without being recorded. When you are ready to record again, simply turn on the
Overdub switch.

Stop recording by pressing a Clip Stop button or the Stop button in the Control Bar.
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Note that holding (PC) / (Mac) while double-clicking the empty slot to create a
new clip will implicitly arm the track and launch the clip.

At any time while overdub recording is going on, you can use the Undo command to remove the last
take, or even draw, move or delete notes in the Clip View's Note Editor.

Note that you can also add notes to existing Session clips while the Overdub switch is on.

15.7 Using Remote Control for Recording

Using Key Map Mode and MIDI Map Mode (see MIDI and Key Remote Control), you can operate Live’s
recording functions without using the mouse.

You can map the Control Bar's Record and transport controls as well as the track Arm buttons. For
recording into the Session slots, you can map the individual slots as well as the relative navigation
controls to initiate recording remotely; for instance:

2 Audio 3 My M
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One key is used to jump to the next scene...
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...and another key to start and end recording in the respective track.

The Scene Up/Down
Buttons.

A Track Launch Button.



Chapter 16

Working with Instruments and Effects

Every track in Live can host a number of devices. These devices can be of three different sorts:
e MIDI effects act upon MIDI signals and can only be placed in MIDI tracks.

® Audio effects act upon audio signals and can be placed in audio tracks. They can also be
placed in MIDI tracks as long as they are “downstream” from an instrument.

e Instruments are devices that reside in MIDI tracks, receive MIDI and output audio.
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Devices in the Track View.

The Track View is where you insert, view and adjust the devices for the selected track. To select a
track and open the Track View to access its devices, double-click the track’s name. The Track View
appears in the bottom area of the Live screen.
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16.1 Using the Live Devices
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Click on the Live Device Browser selector to access the palette of Live’s built-in devices. You will
notice that MIDI effects, audio effects and instruments each have their own folders in the Browser.

To place one instance of a device in a track, click on the desired device and drag it into the Track
View of an appropriate track. You can also select a track by clicking on its Track Title Bar, then
double-click a device in the Browser to add it to the selected track. Note: If you are using an
external input signal to feed your Live track using the default settings, you will need to activate the
track’s Arm button in the mixer in order to hear the input through the devices in your track’s device

The Live Device Browser
Selector.
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chain. This is how you would play live instruments through effects on a track, for example, or use a
MIDI keyboard's input to play a track’s instrument. Note that you can easily move from this setup
into recording new clips (see Recording New Clips) for further use in Live. If you have alternative
monitoring preferences, please see the appropriate manual section (see Monitoring) for information
on how to make these settings.

Imll
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Play with the device’s controls to change the result, or get more “hands-on” by assigning device
controls to MIDI or key remote control (see MIDI and Key Remote Control). To learn what a de-
vice does and how to operate it, consult the Live Audio Effect Reference chapter (see Live Audio
Effect Reference), Live MIDI Effect Reference chapter (see Live MIDI Effect Reference) or the Live
Instrument Reference chapter (see Live Instrument Reference).

To add another device to the track, simply drag it there or double-click its name to append it to the
device chain. Signal processing travels from left to right on the track.

e You can drop audio effects in at any point in an audio track’s device chain, keeping in mind
that the order of effects determines the resulting sound, as effects on the left will pass altered
signals on to those on the right.

e The above also applies to a MIDI track’s device chain.

e If you drop an instrument into a MIDI track’s device chain, signals following (to the right of)
the instrument are now audio signals, available only to audio effects. Signals preceding (to
the left of) the instrument are available only to MIDI effects. This means that it is possible
to have a MIDI track device chain consisting of all three types of devices: first a MIDI effect,
then an instrument, and finally an audio effect.

MIDI and Audio Track Arm
Buttons
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To remove a device from the chain, click on the name and either press your computer’s Delete or
Backspace key, or select Delete from the Edit menu. To change the order of devices, drag a device
by its name and drop it between any of the other devices in the Track View, or drag it onto another
track in the mixer to place the device in that track. Generally, devices can be placed, reordered and
deleted without interrupting the audio stream.

0 38 1

1 uto Filter

Devices can be turned on and off using their Activator switches. Turning a device off is like tem-
porarily deleting it: The signal remains unprocessed, and the device does not consume CPU cycles.
Live devices generally do not load down the CPU unless they are active. For more information, please
refer to the CPU load section (see Managing the CPU Load).

Devices in Live's tracks have input and output level meters. These meters facilitate finding a prob-
lematic device in the device chain: Low or absent signals will be apparent in the level meters

A MIDI Track’s Device Chain
Can Contain All Three
Device Types.

A Device Activator Switch.
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between devices, and relevant device settings can then be adjusted, or the device can be turned off
or removed. Note that no clipping can occur between devices because there is practically unlimited
headroom. Clipping can occur when an overly strong signal is sent to a physical output or written
to a sample.

Further information about track types in Live can be found in the Routing and I/0 chapter (see
Routing and 1/0), including information on using return tracks to distribute the effect of a single
Live device amongst several tracks. After reading about using devices in Live, it might also be
interesting look into clip envelopes (see Clip Envelopes), which can modulate individual device
settings on a per-clip basis.

16.1.1 Live Device Presets

Every Live device can store and retrieve particular sets of parameter values as Presets. Two buttons
for managing the device presets are located at the top right of each device.
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To audition presets for possible selection, click once on the Recall Preset button to make the preset
chooser appear. Use and to go through the existing presets while listening to their effect
and watching the device settings change. To select a preset by name, click on the chooser to open
it. The available presets will be listed and sorted alphabetically:

® Factory Settings is the device’s default state when it is inserted from the Live Device Browser.
This preset is always at the top of the list.

Recalling a Preset.
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e Below the factory settings are the Factory Presets, which are installed with the program. These
presets are updated as new versions of Live become available.

® The User Presets are listed below the factory presets. You can create any number of user presets
that are not bound to a particular instance of the device or to the current Live Set. They will
be available in any other instance of the device and any other Live Set as well.

oy 38 1
Random 11-
Chance Sian
A\ Bl The Preset Save Button.

The Preset Save button is for saving, overwriting and deleting user presets. Clicking on this button
opens a dialog window.

Usar Presets to Overwrite or Delete

Bass Boost
Mid Cut

Preset Name:

[Hi Cut] |

(Gave (Delele (Close The Preset Save/Delete
L - | Dialog.

To overwrite an existing user preset, select it from the list of user presets and click the Overwrite
button.

To save a user preset, type a preset name into the text edit field and click the Save button. If a
preset with that name already exists, you will be asked if you want to overwrite that preset. If not,
choose a different name and try again. Otherwise, click on “ok” to overwrite.

To delete a user preset, select it and click the Delete button.

To leave the preset dialog, choose Close.
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16.2 Using Plug-Ins

The collection of devices that you use in Live can be extended with plug-ins. Live supports Steinberg
Media’s VST Plug-ins and Apple Computer’s Audio Units Plug-ins (Mac 0S X only).

Working with VST and Audio Units Plug-ins is very much like working with Live devices. VST and
Audio Units instruments can only be placed in Live MIDI tracks and, like Live instruments, they will
receive MIDI and output audio signals. Plug-in audio effects can only be placed in audio tracks
or following instruments. Please see the section on working with Live devices (see Using the Live
Devices) for general information about working with devices in Live.
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Audio Units and VST Plug-ins are browsed and imported using the Plug-In Device Browser, which
is accessed via its selector. Plug-in instruments can be differentiated from plug-in effects in the

The Plug-In Device Browser
Selector.
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Browser, as they appear with a keyboard icon, while effects have a plug-shaped icon.

Note: The first time you start Live, no plug-ins will appear in the Plug-In Device Browser, as you
must first “activate” your plug-in sources. Activating your plug-in sources tells Live which plug-ins
you want to use and where they are located on your computer. Information on activating (and
deactivating) plug-in sources can be found later in this chapter, by plug-in type, in the sections
on the VST Plug-in folder (see The VST Plug-In Folder) and Audio Units Plug-ins (see Audio Units
Plug-Ins).

If you install/de-install a plug-in while the program is running, Live will not detect your changes or
implement them in the Plug-In Device Browser until the next time you start the program. Use the
Re-Scan button in the Plug-In Preferences to re-scan your plug-ins while Live is running, so that
newly installed devices become immediately available in the Plug-In Device Browser.

Hint: You can also use Re-Scan if you believe that your plug-in database has somehow become

corrupted. Holding down the (PC) / (Mac) modifier while pressing Re-Scan will
delete your plug-in database altogether and run a clean scan of your plug-ins.

16.2.1 Plug-Ins in the Track View
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A VST Plug-In in the Track
View.
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Once a plug-in is dragged from the Browser into a track, it will show up in the track’s Track View.
The original plug-in panel graphics will be replaced with a Live panel, which will usually represent
all of the plug-in parameters accurately and completely, unless they are simply too numerous or are
not modifiable in real time. When this is the case, the plug-in’s original editor panel can be opened
in a separate window (see Showing Plug-In Panels in Separate Windows).

You can view or hide the VST Plug-in’s parameters by toggling the triangle-shaped button in the
plug-in’s title bar.

The X-Y control field can be used to control two plug-in parameters at once and is therefore especially
well-suited for live control. To assign any two plug-in parameters to the Live panel X-Y field, use the
drop-down menus directly beneath it.

Once a plug-in is placed in a track, you can use it just like a Live device:

¢ You can edit all of its parameters and drag it to different locations in the device chain or to
other tracks, according to the rules of audio effects and instruments.

® You can map MIDI-controller messages to its parameters (see MIDI and Key Remote Control).
® You can modulate its continuous parameters with clip envelopes (see Clip Envelopes).
® You can also use the multiple I/0 features of some plug-ins by assigning them as sources or

targets in the routing setup of tracks. See the chapter on routing (see Routing and I/0) for
details.

The Plug-In Unfold Button.
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16.2.2 Showing Plug-In Panels in Separate Windows

S
The Plug-In Edit button opens a floating window that shows the original VST or Audio Units Plug-in

panel. Changing parameters on the floating window has the same effect as changing them in the
Live panel, and vice versa.

If the Multiple Plug-In Windows option in the Plug-In Preferences is activated, you can open any
number of plug-in windows at once. Even with this option off, you can hold down the (Ctrl ] (PC)
/ (Mac) modifier when opening a new plug-in window to keep the previous window(s) from
closing.

Using the Auto-Hide Plug-In Windows preference, you can choose to have Live display only those
plug-in windows belonging to the track that is currently selected.

You can use the View menu’s Show/Hide Plug-In Windows command or the [Cul ]P) (PC) /
(& ¥ [P) (Mac) shortcut to hide and show your open plug-in windows. Notice that the name
of the track to which the plug-in belongs is displayed in the title bar of the plug-in editor window.

Macintosh only: The floating VST Plug-in editor windows do not receive computer key strokes. If it is
necessary to type into the plug-in window, for instance for entering a serial number or unlock code,
hold down (£ ] while clicking the Plug-In Edit button. The editor window will then appear
as a ‘normal” application window, rather than as a floating window, and receive your typing. Note
that this functionality is intended only as a workaround for a plug-in limitation. We recommend
closing the window after you have finished typing, then reopening it normally before working with
the plug-in parameters.

The Plug-In Edit Button.
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16.3 VST Plug-Ins

16.3.1 The VST Plug-In Folder

When you start Live for the first time, you will need to activate your VST Plug-in sources before
working with VST Plug-ins. Depending on your computer platform, you may also have to tell Live
about the location of the VST Plug-in folder containing the devices you want to use. In order to set
up your VST sources, press the “Activate” button in the Plug-In Device Browser, or go to the Plug-In
Preferences via the Options menu (or the Live menu in Mac 0S X). There you will find the “Active
Sources” section.

Audio MIDI | Sync Plug-in Defaults Misc
Window Handling
Multiple Plug-in Windows
Auto-Hide Plug-in Windows
Active Sources
Re-Scan Plug-ln Database
Use VST Plug-in Custom Folder II'
| VET Flug-In Custom Folder ( Browse
X HD:Users:harb: Deskiop: Plugs:

For Mac 0S 9 and Windows, proceed as follows:

1. Use the VST Plug-In Custom Folder entry to tell Live about the location of your VST Plug-
ins: Click the Browse button to open a folder-search dialog for locating and selecting the
appropriate folder.

2. Once you have selected a VST Custom Folder and Live has scanned it, the path will be dis-
played. Note that, on Windows, Live may have found a path in the registry without the need

Setting up VST Plug-In
Sources for Windows and
Mac 0S 9.
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for browsing.

3. Make sure that the Use VST Plug-In Custom Folder option is set to “On,” so that your selected
folder is an active source for VST Plug-ins in Live. Note that you can choose not to use your
VST Plug-ins in Live by turning off the Use VST Plug-In Custom Folder option.

Use VST Plug-In System Folders II'

Use VST Plug-in Custom Folder II'

V5T Plug-in Custom Folder ."E_.
| X HD:Users:harb: Desklop:Plugs:

Setting up VST Plug-In
Sources for Mac 0S X.

Set up your VST Plug-ins under Mac 0S X by doing the following:

1. Your VST Plug-ins will normally be installed in the following folder in your home and local
directories: /Library/Audio/Plug-Ins/VST. You can turn Live’s use of these plug-ins on or off
with the Use VST Plug-ins in System Folders option.

2. You may have an alternative folder in which you store your VST Plug-ins (perhaps those that
you use only with Live). You can use VST Plug-ins in this folder in addition to, or instead of,
those in the System folders. To tell Live about the location of this folder, click the Browse
button next to the VST Plug-In Custom Folder entry to open a folder-search dialog for locating
and selecting the appropriate folder.
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3. Note that you can turn off your VST Plug-ins in this folder using the Use VST Plug-In Custom
folder option.

Once you have configured your Plug-In Preferences, the Plug-In Device Browser will display all
plug-ins it finds in the selected VST Plug-in folder(s) as well as any sub-folders.

Some VST Plug-ins contain errors or are incompatible with Live. During the scanning process, these
may cause the program to crash. When you re-launching Live, a dialog will appear to inform you
about which plug-in caused the problem. Depending on what Live detects about the plug-in, you may
be given the choice between performing another scan or making the problematic plug-in unavailable.
If you choose to re-scan and they crash the program a second time, Live will automatically make
them unavailable, meaning that they will not appear in the Plug-In Device Browser and will not be
re-scanned again until they are reinstalled.

16.3.2 VST Programs and Banks

Every VST Plug-in instance “owns” a bank of programs. A program is meant to contain one complete
set of values for the plug-in’s controls.

+mzm s N

® & VirSynCUBE
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To select a program from the plug-in's bank, use the chooser below the title bar. The number of
programs per bank is fixed. You are always working “in” the currently selected program, that is, all
changes to the plug-in’s controls become part of the selected program.

Please don’t mistake the VST Plug-In Program chooser for the Live device preset chooser (see Live
Device Presets). Whereas the presets for a Live device are shared among all instances and Live Sets,
the VST programs “belong” to this specific instance of the VST Plug-in.

The VST Plug-In Program
Chooser.
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To rename the current program, select the VST program chooser and execute the Edit menu’s Rename
Plug-In Preset command. Then type in a new program name and confirm by pressing Return.

L] . ®
1 2 3

B A VirSynCUBE
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VST programs and banks can be imported from files. Clicking the VST Program Load button brings up
a standard file-open dialog for locating the desired file.

Windows only: Please select from the File Type menu whether you want to locate VST Device Program
files or VST Device Bank files.

To save the currently selected program as a file, click the VST Program/Bank Save button to bring up
a standard file-save dialog; select “VST Device Program” from the Format menu (Macintosh) / from
the File Type menu (Windows); select a folder and name. For saving the entire bank as a file, proceed
likewise but choose “VST Device Bank” as a file type/format.

16.4 Audio Units Plug-Ins

Audio Units Plug-ins are only available in Mac 0S X. In most respects, they operate just like VST
Plug-ins (see VST Plug-Ins).

Renaming a VST Plug-In
Program.

The VST Program/Bank
Load Button (Left) and The
VST Program/Bank Save
Button (Right).
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An Audio Units Plug-In.

The first time you open Live, Audio Units Plug-ins will not appear in the Plug-In Device Browser.
In order to activate your Audio Units as a plug-in source, please press the “Activate” button in the
Plug-In Device Browser, or go to the Plug-In Preferences via the Live menu. There you will find the
“Active Sources” section. Turning on the Use Audio Units option activates Audio Units Plug-ins so
that they appear in Live’s Plug-In Device Browser.

Note that you can always turn this option off later if you decide not to use Audio Units.
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Audio MIDI | Sync Plug-in Defaults Misc

Window Handling
Multiple Plug-in Windows

Auto-Hide Plug-in Windows

Active Sources

Re-Scan Plug-in Database Be-Scan
Use Audio Units -
Activating Audio Units
Plug-Ins.
Audio Units Plug-ins sometimes have a feature that allows choosing between different modes for
the device. You might be able to choose, for example, between different levels of quality in the
rendering of a reverb. Choosers for these device modes can only be accessed through the original
plug-in panel, which is opened using the Plug-In Edit button.
NUMatrixReve [+ W
ii ii
e e Opening an Audio Units

Plug-In Window.
Audio Units have presets that function just like those for the Live effects (see Live Device Presets).

Audio Units presets have an .aupreset extension and are stored in the following directory according
to their manufacturer’s name: [Home]/Library/Audio/Presets/[Manufacturer Name]/[Plug-in Name].
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Automation and Editing Envelopes

Often, when working with Live’s mixer and devices, you will want the controls’ movements to become
part of the music. The movement of a control across the song timeline is called automation; a control
whose value changes in the course of this timeline is automated. Practically all mixer and device
controls in Live can be automated, including the song tempo.

17.1 Recording Automation

Creating automation is straightforward: All changes of a control that occur while the Control Bar's
Record switch is on become automation. Try recording automation for a control, for instance a mixer
volume slider. After recording, play back what you have just recorded to see and hear the effect
of the control movement. You will notice that a little “LED” has appeared in the slider thumb to
indicate that the control is now automated. Try recording automation for track panning and the
Track Activator switch as well; their automation LEDs appear in their upper left corners.

202
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17.2 Deleting Automation

To delete automation data, simply select an automated control by clicking on it, and choose the Edit
menu’s Delete Automation command. The automation LED disappears, and the control’s value stays
constant across the entire song. Note that this will not work with controls that are switches, like the
Track Activator switch, because they cannot be selected by clicking. You can only delete automation
for switches by editing their breakpoint envelopes (see Drawing and Editing Automation).

17.3 Overriding Automation

In practice, you will often want to try out new control moves without overwriting existing automa-
tion data. Well, nothing is forever in the world of infinite Undo (see Non-Destructive Editing), but
it's easy to disable a control’s automation temporarily to avoid overwriting existing data: If you
change an automated control’s value while not in Record Mode, the automation LED goes off to
indicate the control’s automation is inactive. Any automation is therefore overridden by the current
manual setting.

2 Audio 3 MDY 4 Moy

Volume, Pan and the Track
Activator Switch Have Been
Automated.

The Back to Arrangement
Button.
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When one or more of the automated controls in your Live Set are not active, the Control Bar’s Back
to Arrangement button lights up. This button serves two purposes:

1. It reminds you that the current state of the controls differs from the state captured in the
Arrangement.

2. You can click on it to reactivate all automation and thereby return to the automation state as
it is written “on tape.”

17.4 Drawing and Editing Automation

In the Arrangement View, automation curves can be viewed and edited as breakpoint envelopes.
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An Automation Envelope in

the Arrangement View.

1. To access a track’s envelope, “unfold” the track by clicking the triangular button next to the
track name.

2. Clicking on one of the track’s mixer or device controls will display this control’s envelope.

3. The envelope appears “on top of” the audio waveform or MIDI display. Its vertical axis
represents the control value and the horizontal axis represents time. For switches and radio
buttons, the value axis is discontinuous.
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4, The Automation Device chooser either selects the track mixer, one of the track’s devices or
“None” to hide the envelope. It also provides you with an overview of what devices actually
have automation by showing an LED next to their labels.

5. The Automation Control chooser selects a control from the device chosen in the Automation
Device chooser. The labels of automated controls have an LED.

17.4.1 Drawing Envelopes

With Draw Mode enabled, you can click and drag to “draw” an envelope curve.

R = |2 1. 1|~ | 3
The Draw Mode Switch.

To toggle Draw Mode, select “Draw Mode” from the Options menu, click on the Control Bar’s Draw

Mode switch, or press (Ctl_]B] (PC) / (Mac).

Drawing an Envelope.

Drawing creates steps as wide as the visible grid, which you can modify using a number of handy
shortcuts (see Using the Editing Grid). For freehand drawing, you can hide the grid using the “Snap
to Grid” Option menu entry.
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17.4.2 Editing Breakpoints

With Draw Mode off, the envelope display looks and works differently. The line segments and the
breakpoints connecting them become draggable objects. Clicking and dragging in the envelope’s
background defines a selection. Here is what you can do:

e Double-click at a position on a line segment to create a new breakpoint there.
® Double-click on a breakpoint to delete it.

® (Click and drag a breakpoint to move it to the desired location. If the breakpoint you are
dragging is in the current selection, all other breakpoints in the selection will follow the
movement.

Your movement is constrained by the neighboring breakpoints unless you hold down the
modifier while dragging, which will eliminate breakpoints as you wipe over them.
Holding down the (PC) / (Mac) modifier while dragging switches to a finer
resolution.

e Click and drag a line segment between two breakpoints to move it vertically, without affecting
the breakpoint’s horizontal position. If the line segment is in the current selection, the
envelope is moved vertically across the selected timespan. Live inserts breakpoints at the
selection’s edges to make sure the move only affects the selected part of the envelope.

To Move all Breakpoints
Within the Selection, Drag
Any One of Them.
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Dragging an Envelope Line
Segment Moves the
Segment Vertically.

17.4.3 Locking Envelopes

When moving clips, Live normally moves all automation with the clip. Sometimes, you might want
to lock the envelopes to the song position rather than to the clips, and the Arrangement View's Lock
Envelopes switch does just that. You can also choose to lock envelopes from the Options menu.

29 [1A
¥ 1.Audio Ll
¥ 2 Audio q The Lock Envelopes Switch.

17.4.4 Edit Menu Commands

There are a number of useful Edit menu commands for editing envelopes. To cut or copy automation
from a track, independent of the associated clip, use the Edit menu’s Cut Envelope and Copy Envelope
commands, respectively. To simultaneously copy and paste a selection of envelope into a track’s
“future,” use the Duplicate Envelope command.

Note that Live allows you to copy and paste envelope movements not only from one point in time
to another, but also from one parameter to another. However, there is obviously no meaningful
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conversion from a pan movement to, say, an equalizer frequency, and all Live can do is somehow
preserve the gesture.

17.4.5 Editing the Tempo Automation
The ability to dynamically stretch and compress audio to track any tempo or tempo variation is one
of Live’s specialties. In Live, the song tempo is just another automated control.

To edit the song tempo envelope, unfold the Master track, choose “Mixer” from the top envelope
chooser and “Song Tempo” from the bottom one.

A Master [

The Tempo Envelope.

When adjusting the tempo envelope, you might want to scale the value axis display, which is the
function of the two value boxes below the envelope choosers: The left box sets the minimum, and
the right box sets the maximum tempo displayed, in BPM.

Note that these two controls also determine the value range of a MIDI controller assigned to the
tempo.
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Clip Envelopes

Every clip in Live can have its own clip envelopes. The aspects of a clip that are influenced by
clip envelopes change depending upon clip type and setup; clip envelopes can do anything from
representing MIDI-controller data to modulating device parameters. In this chapter, we will first
look at how all clip envelopes are drawn and edited, and then get into the details of their various
applications.

209
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18.1 The Clip Envelope Editor
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To work with clip envelopes, bring up the Clip View's “Envelopes” box by activating the rightmost
Clip View Box selector panel. The Envelopes box contains two choosers for selecting an envelope to
view and edit.
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The Clip View's Envelopes
Box.
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The top menu is the Device chooser, which selects a general category of controls with which to work.
Device chooser entries are different for different kinds of clips:

o Audio clips have entries for “Clip” (the clip’s sample controls), every effect in the track’s device
chain and the mixer.

e MIDI clips have entries for “MIDI Ctrl” (MIDI-controller data) and every device in the track’s
device chain.

The bottom menu, the Control chooser, selects among the controls of the item chosen in the top
menu. In both the Device and the Control chooser, you can easily identify the items that have
a non-neutral clip envelope by a little “LED” appearing next to their names. The “quick-chooser”
buttons below the menus select commonly edited controls.

Clicking the menus or the quick-chooser buttons brings up the Envelope Editor showing the selected
envelope, instead of the Sample Display or MIDI Editor. You can toggle the display by clicking on
the title bars of the “Sample”/ “Notes” and “Envelopes” boxes.

The techniques for drawing and editing clip envelopes are the same as those for automation en-
velopes in the Arrangement View (see Drawing and Editing Automation).

If you create a nice section of envelope that you want to have repeat several times, try the following:

1. Enclose the desired selection in the Clip Loop/Region markers, and click the brace that runs
between them. This will execute the Edit menu’s Select Loop command, which selects all
material in the loop/region.

2. Copy the envelope with (Cul )(c] (PC) / (Mac).
3. Shift the loop/region to the right by one loop length with .
4. Paste the envelope with (PC) / (Mac).

Note that you can use the arrow keys to quickly manipulate the Loop/Region markers (see Loop/Region
and Start Markers) in other useful ways to expedite clip envelope editing tasks.
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To delete a clip envelope (i.e., to set it back to its default value), first go to Edit / Select All, then
to Edit / Delete.

Let us now look at some uses of clip envelopes.

18.2 Audio Clip Envelopes

)

Clip envelopes extend Live's “elastic” approach to audio and, in conjunction with Live’s audio effects,
turn Live into a mighty sound-design tool. Using clip envelopes with audio clips, you can create an
abundance of interesting variations from the same clip in real time- anything from subtle corrections
to entirely new and unrelated sounds.

18.2.1 Clip Envelopes are Non-Destructive

Using clip envelopes, you can create new sounds from a sample without actually affecting the sample
on disk. Because Live calculates the envelope modulations in real time, you can have hundreds of
clips in a Live Set that all sound different, but use the same sample.

You can, of course, export a newly created sound by rendering (see Exporting Audio), or by resam-
pling (see Recording New Clips). In the Arrangement View, you can use the Consolidate command
(see Consolidating Clips) to create new samples.

18.2.2 Changing Pitch and Tuning per Note

Drop a sample loop from the Browser into Live and play it. Click on the “Transpose” envelope quick-
chooser button. You can now alter the pitch transposition of individual notes in the sample as you
listen to it. The fast way to do this is by enabling Draw Mode (see Drawing Envelopes) and drawing
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steps along the grid. Deactivate Draw Mode to edit breakpoints and line segments. This is useful for
smoothing the coarse steps by horizontally displacing breakpoints.

Note that the warp settings determine how accurately Live’s time-warping engine tracks the envelope
shape. To obtain a more immediate response, reduce the Grain Size value in Tones and Texture Mode
or choose a smaller value for the Transients control in Beats Mode.

To correct the tuning of individual notes in the sample, hold down the (PC) / (Mac)
modifier while drawing or moving breakpoints to obtain a finer resolution.

To scroll the display, hold down the (PC) / (Mac) modifier while drag-
ging.
Pitch is modulated in an additive way. The output of the transposition envelope is simply added

to the “Transpose” control’'s value. The result of the modulation is clipped to stay in the available
range (-48..48 semitones in this case).

18.2.3 Muting or Attenuating Notes in a Sample

Click on the “Volume” envelope quick-chooser to access an audio clip’s volume envelope. By drawing
steps in Draw Mode or creating shapes with breakpoints, you can impose an arbitrary volume shape
onto the sample.

The Transposition Envelope
with Steps (Left) and
Ramps (Right).
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The volume envelope’s output is interpreted as a relative percentage of the clip volume slider’s
current value. The result of the clip envelope’s modulation can therefore never exceed the absolute
volume setting, but the clip envelope can drag the audible volume down to silence.

18.2.4 Scrambling Beats

One very creative use of clip envelopes is to modulate the sample offset. Sample offset modulation
makes the most sense for rhythmical samples, and is only available for clips that are set up to run
in the “Beats” Warp Mode.

Try sample offset modulation with a one-bar drum loop: Make sure “Beats” Mode is chosen; in the
Envelopes box, choose “Clip” from the Device chooser and “Sample Offset” from the Control chooser.
The Envelope Editor appears with a vertical grid overlay. In envelope Draw Mode (see Drawing
Envelopes), set steps to non-zero values to hear the loop scrambled. What is going on?

Imagine the audio is read out by a tape head, the position of which is modulated by the envelope.
The higher a value the envelope delivers, the farther away the tape head is from its center position.
Positive envelope values move the head towards the “future,” negative values move it towards the
“past.” Fortunately, Live performs the modulation in beats rather than centimeters: A vertical grid
line is worth a sixteenth note of offset and the modulation can reach from plus eight sixteenths to
minus eight sixteenths.

Imposing a Volume
Envelope on a Sample.
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Sample offset modulation is the tool of choice for quickly creating interesting variations of beat
loops. We discourage using this technique for “analytical” cut-and-splice tasks; they are much easier
to perform using Live's Arrangement View, and the results can easily be consolidated into new clips

(see Consolidating Clips).

Some sample offset envelope gestures have a characteristic effect: a downward “escalator” shape,
for instance, effectively repeats the step at the envelope’s beginning. Similarly, a smooth ramp with
a downwards slope is slowing time and can create nice slurring effects when the slope is not quite
exactly 45 degrees; try this with a 1/32 Transients setting.

18.2.5 Using Clips as Templates

As you are making creative use of clip envelopes, the clips containing them develop a life of their
own, independent of the original sample. You might wonder at a point: What does this clip sound
like with a different sample? This is easy to find out by selecting the clip so that it is displayed
in the Clip View and dragging the desired sample from one of the File Browsers, or the Session
or Arrangement View, onto the Clip View. All clip settings, including the envelopes, will remain
unaltered; only the sample will be replaced.

Notice this procedure affects only the selected clip, whereas replacing a sample with the Clip View’s
Replace button (see Replacing the Clip’s Sample) will affect all clips using that sample.

Repeating Steps and
Slowing Time with the
Sample Offset Envelope.
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18.3 Mixer and Device Clip Envelopes

Clip envelopes can be used to modulate mixer and device controls. Since mixer and device con-
trols can also be controlled by the Arrangement’s automation envelopes (see Drawing and Editing
Automation), this is a potential source of confusion. However, clip envelopes differ from automation
envelopes in one important way: Whereas automation envelopes define the value of a control at any
given point in time, clip envelopes can only influence this defined value. This difference allows the
two types of envelopes to work together in harmony when controlling the same parameter.

Imagine that you have recorded volume automation for an audio clip so that it gradually fades
out over four bars. What happens to your fade-out when you create a clip envelope that gradually
increases the mixer volume over four bars? At first, your fade-out will become a crescendo, as the
clip envelope gradually increases the volume within the range allowed by the automation envelope.
But, once the decreasing automated value meets with the increasing clip envelope value, the fade-
out will begin, as automation forces the absolute control value (and the operable range of the clip
envelope) down.

18.3.1 Modulating Mixer Volumes and Sends

Notice that there are actually two volume modulations: Clip Volume and Mixer Volume. The latter
is a modulation for the mixer’s gain stage and therefore affects the post-effect signal. To prevent
confusion, a small dot below the mixer’s volume slider thumb indicates the actual, modulated volume
setting.

Modulating the Mixer
Volume. The Little Dot
Below the Volume Slider
Thumb Represents the
Modulated Volume Setting.
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As you raise and lower the Volume slider, you can observe the dot following your movement in a
relative fashion.

Modulating the track’s Send controls is just as easy. Again, the modulation is a relative percentage:
The clip envelope cannot open the send further than the Send knob, but it can reduce the actual

send value to minus infinite dB. Modulating a Send. The
Send Knob's Position Ring

‘/) b ’b (b @ Indicates the Modulated

Value.

18.3.2 Modulating Pan

The Pan envelope affects the mixer pan stage in a relative way: The pan knob's position determines
the intensity of the modulation. With the pan knob set to the center position, modulation by the
clip envelope can reach from hard left to hard right; the modulation amount is automatically reduced
as you move the pan knob towards the left or right. When the pan knob is turned all the way to the
left, for instance, the pan clip envelope has no effect at all.

18.3.3 Modulating Device Controls

All devices in a clip’s track are listed in the upper clip envelope Device chooser. Modulating the
devices’ controls works just as you would expect. When modulating device controls, it is important
to keep the interaction of clip envelopes and device settings in mind: Unlike a device preset (see
Using the Live Devices), the clip envelope cannot define the values for the devices’ controls, it can
only change them relative to their current setting.
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18.4 MIDI-Controller Clip Envelopes

Whether you are working with a new MIDI clip that was recorded (see Recording New Clips) directly
into Live, or one from your files, Live allows you to edit and create MIDI-controller data for the clip
in the form of clip envelopes.

Choose “MIDI Ctrl” from a MIDI clip’s Device chooser and use the Control chooser below it to select
a specific MIDI controller. You can create new clip envelopes for any of the listed controllers by
drawing steps or using breakpoints. You can also edit clip envelope representations of controller
data that is imported as part of your MIDI files or is created while recording new clips: Names of
controllers that already have clip envelopes appear with a little “LED” in the Control chooser.

Live supports most MIDI-controller numbers up to 119, accessible via the scroll bar on the right-
hand side of the menu. Note that devices to which you send your MIDI-controller messages may
not follow the conventions of MIDI-control channel assignments, so that “Pitch Bend” or “Pan,” for
example, will not always achieve the results that their names imply.
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Many of the techniques described in the following section on unlinking a clip envelope (see Unlink-
ing Clip Envelopes From Clips) from its associated clip can be adapted for use with MIDI-controller
clip envelopes.

A MIDI-Controller Clip
Envelope.
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18.5 Unlinking Clip Envelopes From Clips

A clip envelope can have its own local loop/region settings. The ability to unlink the envelope from
“its’ clip creates an abundance of exciting creative options, some of which we will present in the rest
of this chapter.

18.5.1 Programming a Fade-Out for a Live Set

Let us start with a straightforward example. Suppose you are setting up a Live Set and wish to
program a fade-out over eight bars to occur when a specific clip is launched- but all you have is a
one-bar loop.

ENWWLIE]
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1. Choose the Clip Volume envelope, and unlink it from the sample. The clip envelope’s loop
braces now appear colored to indicate this envelope now has its own local loop/region set-
tings. The loop/region controls in the Envelopes box “come to life.”

Using a Clip Envelope to
Create a Fade-Out Over

Several Repetitions of a
Loop.
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2. Make sure the clip envelope’s Loop switch is off. Notice the Sample box’s Loop switch is not
affected. The sample will keep looping although the envelope is now playing as a “one-shot.”

3. Type ‘8 into the leftmost envelope loop-length value box.

4. Zoom the envelope display out all the way by clicking on the Envelope’s time ruler and dragging
upwards. (It is actually faster to click the “Show Loop” arrow next to the loop/region length
controls.)

5. Insert a breakpoint at the region end and drag it to the bottom (zero percent).
Now, as you play the clip, you can hear the one-bar loop fading out over eight bars.

Please note: toggling Linked Mode changes the envelope data. Toggling back and forth effectively
deletes the envelope data. To return to the previous state, please use the Edit menu’s Undo command.

18.5.2 Creating Long Loops from Short Loops

Let us take this a step further. For a different part of your set, you would like to use the same
one-bar loop - because it sounds great - but its repetition bores you. You would like to somehow
turn it into a longer loop.

We depart from the clip we just set up to fade out over eight bars. Activate the clip volume
envelope’s Loop switch. Now, as you play the clip, you can hear the eight-bar fade-out repeating.
You can draw or edit any envelope to superimpose onto the sample loop. This, of course, not only
works for volume but for any other control as well; how about a filter sweep every four bars?

Note that you can create as much time as needed in the Envelope Editor, either by dragging the loop
braces beyond the view limit, or by entering values into the numeric region/loop controls.

You can choose an arbitrary loop length for each envelope, including odd lengths like 3.2.1. It is
not hard to imagine great complexity (and confusion!) arising from several odd-length envelopes in
one clip.
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To keep this complexity under control, it is important to have a common point of reference. The
Offset Marker identifies the point where sample or envelope playback depart from when the clip
starts.

Note that the region/loop and Offset markers are subject to quantization by the zoom-adaptive grid
(see Using the Editing Grid), as is envelope drawing (see Drawing Envelopes).

18.5.3 Imposing Rhythm Patterns onto Samples

So far, we have been talking about imposing long envelopes onto small loops. You can also think of
interesting applications that work the other way around. Consider a sample of a song that is several
minutes long. This sample could be played by a clip with a one-bar volume envelope loop. The
volume envelope loop now works as a pattern that is repeatedly “punching” holes into the music so
as to, perhaps, remove every third beat. You can certainly think of other parameters that such a
pattern could modulate in interesting ways.

18.5.4 Clip Envelopes as LFOs

If you are into sound synthesis, you may want to think of a clip envelope with a local loop as an LFO.
This LFO is running in sync with the project tempo, but it is also possible to set up a loop period
odd enough to render the envelope unsynchronized. By hiding the grid (see Using the Editing Grid),
you can adjust the clip envelope loop start and end points completely independent of meter grid.

The Sample (Left) and
Envelope (Right) Loop
Offset Marker.



Chapter 19

Live Audio Effect Reference

Live comes with a selection of custom-designed, built-in audio effects. The “Working with Instru-
ments and Effects” chapter (see Working with Instruments and Effects) explains the basics of using
effects in Live.

222



19.1. AUTO FILTER 223

19.1 Auto Filter
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The Auto Filter effect provides classic analog filter emulation. It can be modulated by an envelope
follower and/or an LFO to create moving filter effects.

There are three different filter types: low-pass, high-pass and band-pass. For each type, the X-Y
controller adjusts frequency (to adjust, click and drag on the X-axis) and Q (also called resonance;
to adjust, click and drag on the Y-axis). You can also click on the Freq and Q numeric displays and
type in exact values.

Low Q values create a broad filter curve, while higher values introduce a narrow, resonant peak to
the sound. In Bandpass Mode, Q sets the bandwidth of the passed signal.

The Quantize Beat control applies quantized modulation to the filter frequency. With Quantize
Beat off, frequency modulation follows the control source. Turning this feature on updates the
filter modulation rhythmically with “stepped” changes that track the master tempo. The numbered
buttons represent 16th notes, so, for example, selecting 4 for Beat value produces a modulation
change once per beat.

The EnvelopeMod section controls how the envelope modulation affects the filter frequency. The Mod
control defines the extent to which the envelope affects the filter frequency, while the Attack control

The Auto Filter Effect.
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sets how the envelope responds to rising input signals. Low Attack values cause a fast response to
input levels; high values integrate any changes gradually, creating a looser, slower response. Think
of it as adding inertia to the response.

Lower Release values cause the envelope to respond more quickly to falling input signals. Higher
values extend the envelope’s decay.

The Auto Filter also contains a Low Frequency Oscillator to modulate filter frequency in a periodic
fashion. The Amount control sets how much the LFO affects the filter.

The Rate control specifies the LFO speed.

Available waveform shapes are Sine (creates smooth modulations with rounded peaks and valleys),
and Sample and Hold (generates random positive and negative modulation values).

There are two sine wave LFOs, one for each stereo channel. The Phase and Spin controls define the
relationship between these two LFOs.

Phase keeps both LFOs at the same frequency, but can set the two LFOs” waveforms “out of phase”
with each other, creating stereo movement. At maximum, the LFO outputs are 180 degrees apart, so
that when one LFO reaches its peak, the other is at its minimum.

Spin detunes the two LFOs’ speeds relative to each other. Each stereo channel is modulated at a
different frequency, as determined by the Spin amount.

For sample and hold, the Spin and Phase controls are not relevant and do not affect the sound.
Instead, the Auto Filter offers two kinds of sample and hold: The upper sample and hold type
provides independent random modulation generators for the left and right channels, while the lower
one modulates both channels with the same signal.
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The Chorus effect uses two parallel time-modulated delays to create chorus (thickening) and flanging
effects.

Each delay has its own delay time control, calibrated in milliseconds. Delay 1 has a high-pass filter
that can remove low frequencies from the delayed signal. Greater high-pass values let only very high
frequencies pass through to Delay 1.

Delay 2 can switch among three different modes. When off, only Delay 1 is audible. In Fix Mode,
only Delay 1's delay time will be modulated. When Mod is activated, Delay 2 will receive the same
modulation as Delay 1.

To set both delay lines to Delay 1's delay time, turn on the link button (“= ”). This is especially
useful if you want to change both delays with a single gesture.

The Modulation X-Y controller can impart “motion” to the sounds. To change the modulation rate
for the delay times, click and drag along the horizontal axis. To change the amount of modulation,
click and drag along the vertical axis.

You can also make changes by entering parameter values in the Amount and Rate fields below the
X-Y controller. The Amount value is in milliseconds, while the modulation frequency rate is in Hertz.

The Chorus Effect.
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Clicking the *20 switch multiplies the modulation frequency by 20 to achieve more extreme sounds.

The Feedback control determines how much of the output signal feeds back into the input, while
the Polarity switch sets (surprise!) the polarity. Polarity changes have the most effect with high
amounts of feedback and short delay times.

The Dry/Wet control adjusts the balance between the processed and dry signals. Set it to wet only
if using the Chorus in a return channel.

19.3 Compressor I
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A Compressor reduces gain for signals above a user-settable threshold. Compression reduces the
levels of peaks, opening up more headroom and allowing the overall signal level to be turned up.
This gives the signal a higher average level, resulting in a sound that is subjectively louder and
“punchier” than an uncompressed signal.

The two most important parameters are the Threshold and the compression Ratio:

The Threshold slider sets where compression begins. Signals below the threshold are not processed.
Signals above the threshold are attenuated by an amount specified by the Ratio parameter, which

The Compressor I Effect.
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sets the ratio between the input and output signal. For example, with a compression ratio of 3:1, if
a signal above the threshold increases by 3 dB, the compressor output will increase by only 1 dB. If
a signal above the threshold increases by 6 dB, then the output will increase by only 2 dB.

The red gain-reduction meter shows how much the gain is being reduced at any given moment. The
more reduction, the more audible the effect; a gain reduction above 6 dB or so might produce the
desired loudness, but significantly alters the sound and is easily capable of destroying its dynamic
structure. This is something that cannot be undone in later production steps. Keep this in mind es-
pecially when using a compressor, limiter or sound loudness-maximizing tool in the master channel.
Less is often more here.

Because compression reduces the volume of loud signals and opens up headroom, you can use the
Out(put) slider so that the peaks once again hit the maximum available headroom. The Output meter
shows the output signal’s level.

A second set of two essential parameters defines how fast a compressor reacts to input-level changes:
Attack time and Release time.

Attack defines how long it takes to reach maximum compression once a signal exceeds the threshold,
while Release sets how long it takes for the compressor to return to normal operation after the signal
falls below the threshold.

A slight amount of attack time (5 - 10 ms) allows peaks to come through unprocessed, which helps
preserve dynamics. If these peaks cause overloads, you can try shortening the attack time, but
extremely short times take the “life” out of the signal, and may lead to a slight “buzziness” caused
by distortion. Short release times can cause “pumping” as the compressor tries to figure out whether
to compress or not; while generally considered an undesirable effect, some engineers use it on full
drum kits to give unusual “sucking” effects.



19.4. COMPRESSOR II 228

19.4 Compressor II
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Compressor IT is a state of the art compression unit- the tool of choice for a wide range of dynamic
processing applications including limiting and loudness maximization. Compressor II's design is a
lot more sophisticated and capable than Compressor I's. It includes frequency-selective compression
using a sidechain EQ, variable look-ahead times and two response modes, Peak and RMS. Compressor
I is still a valuable sound design tool in spite of, or rather because of, its simplicity and roughness,
which can add interesting flavors to your sounds.

A compressor can only react to an input signal once it occurs. Since it also needs to apply an
attack/release envelope, the compression is always a bit too late. A digital compressor can solve
this problem by simply delaying the input signal a little bit. Compressor II offers three different
predelay times: zero ms, one ms and ten ms. The results may sound pretty different depending on
this setting. Keep in mind that using ten ms of predelay makes the output appear significantly later.
You may have to delay other tracks with a Simple Delay in order to stay in sync.

Compressor II can either react to short peaks within a signal or to something that is more related
to how people perceive loudness. The parameter for this is the “Peak/RMS” switch. If you intend
to use Compressor II as a limiter in the master section, “Peak” is probably better since it reacts
more to the actual signal level, while “RMS” is usually more musical. But as always if it comes to

The Compressor II Effect.
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compression, trust your ears and not the meter!

The most exotic feature of Compressor II is the sidechain EQ. The “sidechain” is the part of the signal
that is used to control the compressor. Normally the sidechain signal is the same as the input signal.
However, it can make sense to apply some filtering here. Imagine a bass drum, a snare and some
chords in the background. The bass drum has a pretty high level and it will normally determine how
the compressor reacts. If you now turn the side chain EQ on and set its Frequency to 100 Hz and the
Gain to -15 dB, the bass drum will not influence the compression anymore and the behavior of the
compressor will be very different. You could also set the Frequency to around 1 kHz and turn up the
gain to make the compressor more responsive to the snare. Since the EQ is only in the sidechain and
not part of the normal signal path, it will not change the sound of the input signal. It only changes
how the compressor reacts to different frequencies of the input.

Unlike Compressor I, Compressor II has a built-in compensation stage that counteracts the gain loss
due to the compression and makes it much easier to adjust the other parameters.

Careful adjustment of attack and release times is essential when it comes to compression of rhyth-
mical sources. If you are not used to working with compressors, play a drum loop and spend some
time adjusting Attack, Release, Threshold and Gain. It can be very exciting!
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If you have ever used a good DJ mixer you will know what this is: An EQ that allows you to adjust
the level of low, mid and high frequencies independently.

Each band can be adjusted from -infinite dB to +6 dB using the gain controls. This means that you
can completely remove, for example, the bass drum or bassline of a track, while leaving the other
frequencies untouched.

You can also turn on or off each band using the On/Off buttons located under the gain controls.
These buttons are especially handy if assigned to computer keys...

EQ Three gives you visual confirmation of the presence of a signal in each frequency band using
three green LEDs. Even if a band is turned off, you can see if there is something going on in it. The
internal threshold for the LEDs is set to -24 dB.

The frequency range of each band is defined via two crossover controls: FreqLo and FreqHi. If Freqlo
is set to 500 Hz and FreqHi to 2000 Hz, then the low band goes from 0 hz to 500 Hz, the mid band
from 500 Hz to 2000 Hz and the high band from 2000 Hz up to what ever your soundcard or sample
rate supports.

A very important control is the 24 dB / 48 dB switch. It defines how sharp the filters are cutting

The EQ Three Effect.
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the signal at the crossover frequency. The higher setting results in more drastic filtering, but needs
more CPU.

Note: The filters in this device are optimized to sound more like a good, powerful analog filter
cascade than a clean digital filter. The 48 dB Mode especially does not provide a perfect linear
transfer quality, resulting in a slight coloration of the input signal even if all controls are set to 0.00
dB. This is typical behavior for this kind of filter, and is part of EQ Three’s unique sound. If you need
a more linear behavior choose 24 dB Mode or use the EQ Four.

19.6 EQ Four
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The EQ Four effect is an equalizer composed of four parametric filters. Equalizers are useful for
changing a sound’s timbre.

Filter One can switch among three responses: bell-curve (boosts or cuts over a range of frequencies),
low-shelf (boosts or cuts frequencies lower than the specified frequency) or low-cut (cuts frequencies
below the specified frequency). Filters Two and Three are always bell-curves. Filter Four can switch
among bell-curve, high-shelf (boosts or cuts frequencies higher than the specified frequency) or

The EQ Four Effect.
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high-cut (cuts frequencies above the specified frequency) modes. Each filter band can be turned on
or off independently. Turn off bands that aren’t in use to save CPU power.

To edit the filter curve, click and drag on one of the filter dots in the XY View. Horizontal movement
changes the filter frequency, while vertical movement adjusts the filter band’s gain. To adjust the
filter Q (also called resonance or bandwidth), hold down the (PC) / (Mac) modifier
while dragging the mouse.

You can also use the numbered filter selector buttons to select a band for editing, then edit param-
eter values with the Freq, Gain and Q dials (and/or type values into the number fields below each
dial).

To achieve really drastic filtering effects, assign the same parameters to two or more filters, or use
more than one EQ Four.

As boosting will increase levels and cutting will decrease levels, use the Gain slider to optimize the
output level for maximum level consistent with minimum distortion.

19.7 Erosion
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The Erosion Effect.



19.8. FILTER DELAY 233

The Erosion effect degrades the input signal by modulating a short delay with filtered noise or a sine
wave. This adds noisy artifacts or aliasing/downsampling-like distortions that sound very “digital.”

To change the sine wave frequency or noise band center frequency, click and drag along the X-axis
in the XY field. The Y-axis controls the modulation amount. If you hold down the (Alt (PC) /
(Mac) modifier key while clicking in the XY field, the Y-axis controls the noise bandwidth.

The Frequency control determines the color, or quality, of the distortion. If the Mode control is
set to Noise, this works in conjunction with the Width control, which defines the noise bandwidth.
Lower values lead to more selective distortion frequencies, while higher values affect the entire
input signal. Width has no effect in Sine Mode.

Noise and Sine use a single modulation generator. However, Wide Noise has independent noise
generators for the left and right channels, which creates a subtle stereo enhancement.

19.8 Filter Delay
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The Filter Delay provides three independent delay lines, each preceded by linked low-pass and high-
pass filters. This allows applying delay to only certain input signal frequencies, as determined by the

The Filter Delay Effect.
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filter settings. The feedback from each of the three delays is also routed back through the filters.

Each of the three delays can be switched on and off independently. The Filter Delay plug-in assigns
delay 1 to the input signal’s left channel, delay 2 to the left and right channels and delay 3 to the
right channel. The Pan controls at the right can override the delay channels” outputs; otherwise
each delay outputs on the channel from which it derives its input.

Each delay channel’s filter has an associated On switch, located to the left of each XY controller.
The XY controllers adjust the low- and high-pass filters simultaneously for each delay. To edit filter
bandwidth, click and drag on the vertical axis; click and drag on the horizontal axis to set the filter
band’s frequency.

To refer delay time to the master tempo, activate the Sync switch, which allows using the Delay
time beat division chooser. The numbered switches represent time delay in 16th notes. For example,
selecting “4” delays the signal by four 16th notes, which equals one beat (a quarter note) of
delay. With Sync Mode active, changing the Delay Time field percentage value shortens and extends
delay times by fractional amounts, thus producing the “swing” type of timing effect found in drum
machines.

If the Sync switch is off, the delay time reverts to milliseconds. In this case, to edit the delay time,
click and drag up or down in the Delay Time field, or click in the field and type in a value.

Feedback controls how much of the output signal returns to the delay line input. Very high values
can lead to runaway feedback and produce a loud oscillation - watch your ears and speakers if you
decide to check out extreme feedback settings!

Each delay channel has its own volume control, which can be turned up to +12 dB to compensate
for drastic filtering at the input.

The Dry control adjusts the unprocessed signal level. Set it to minimum if using the Delay in a return
channel.
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The Gate effect passes only signals whose level exceeds a user-specified Threshold. A gate can
eliminate low-level noise that occurs between sounds (e.g., hiss or hum), or shape a sound by
turning up the threshold to where it cuts off reverb or delay tails or truncates an instrument’s
natural decay.

The Threshold slider sets the gate’s sensitivity. If the gate is open and passing signal (i.e., the
signal exceeds the gate threshold), the green LED lights.

The Floor parameter located above the threshold fader can allow attenuating signals below the
threshold rather than just cutting them off. If set to -inf dB, a closed gate will mute the input
signal. A setting of 0.00 dB means that even if the gate is closed, there is no effect on the signal.
Settings in between these two extremes attenuate the input to a greater or lesser degree when the
gate is closed.

The Attack time determines how long it takes for the gate to switch from closed to open when a
signal goes from below to above the threshold. Very short attack times can produce sharp clicking
sounds, while long times soften the sound’s attack.

When the signal goes from above to below the threshold, the Hold time kicks in. (Note to tech

The Gate Effect.
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heads: the gate has hysteresis, so the release occurs about 3 dB lower than the threshold.) After
the hold time expires, the gate closes over a period of time set by the Release parameter.

19.10 Grain Delay
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The Grain Delay effect slices the input signal into tiny particles (called “grains”) that are then
individually delayed and can also have different pitches compared to the original signal source.
Randomizing pitch and delay time can create complex masses of sound and rhythm that seem to
bear little relationship to the source. This can be very useful in creating new sounds and textures,
as well as getting rid of unwelcome house guests, or terrifying small pets (just kidding!).

To refer delay time to the master tempo, activate the Sync switch, which allows using the Delay
Time beat division chooser. The numbered switches represent time delay in 16th notes. For example,
selecting “4” delays the signal by four 16th notes, which equals one beat (a quarter note) of delay.
With Sync Mode active, changing the Delay Time field percentage value shortens and extends delay
times by fractional amounts, thus producing the “swing” type of timing effect.

If the Sync switch is off, the delay time reverts to milliseconds. In this case, to edit the delay time,
click and drag up or down in the Delay Time field, or click in the field and type in a value.

The Grain Delay Effect.
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You can route each parameter to the XY controller’s horizontal or vertical axis. To assign a parameter
to the X-axis, choose it from the parameter row below the controller. To assign a parameter to the
Y-axis, use the parameter row on the left side.

The Feedback parameter sets how much of the output signal returns to the delay line input. Very
high values can lead to runaway feedback and produce a loud oscillation - watch your ears and
speakers if you decide to check out extreme feedback settings!

You can transpose the grain pitch with the Pitch parameter, which acts much like a crude pitch
shifter.

The Spray control adds random delay time changes. Low values smear the signal across time, which
adds “noisiness” to the sound. High Spray values completely break down the structure of the
source signal, introducing varying degrees of rhythmical chaos. This is the recommended setting for
anarchists.

The Random Pitch control adds random variations to each grain’s pitch. Low values create a sort of
mutant chorusing effect, while high values can make the original source pitch completely unintel-
ligible. This parameter can interact with the main Pitch control, thus allowing degrees of stability
and instability in a sound’s pitch structure.

The size and duration of each grain is a function of the Frequency parameter. The sound of Pitch
and Spray depends very much on this parameter.

Grain Delay now also has a dry/wet control; it can be routed to the vertical axis of the XY controller.
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19.11 Ping Pong Delay

The Ping Pong Delay effect uses a single tapped delay line to create a delay that jumps from the left
to the right output.

The delay is preceded by a low- and high-pass filter that can be controlled with an XY controller. To
define the filter bandwidth, click and drag on the vertical axis. To set the position of the frequency
band, click and drag on the horizontal axis.

To refer delay time to the master tempo, activate the Sync switch, which allows using the Delay
Time beat division chooser. The numbered switches represent time delay in 16th notes. For example,
selecting “4” delays the signal by four 16th notes, which equals one beat (a quarter note) of delay.
This delay time represents the time it takes for the input signal to appear at the left channel. The
delay time between the input and the right channel is twice as long.

If the Sync switch is off, the delay time reverts to milliseconds. In this case, to edit the delay time,
click and drag up or down in the time field, or click in the field and type in a value.

The Feedback parameter controls how much of the right channel output signal returns to the delay
line input. The feedback loop also includes a filter that can color the feedback sound, thus producing
different timbres with successive echoes.

The Ping Pong Delay Effect.
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The Dry/Wet control adjusts the balance between the processed and dry signals. Set it to full wet if
using the Ping Pong Delay in a return channel.

19.12 Simple Delay
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The Simple Delay provides two independent delay lines, one for each channel (left and right).

To refer delay time to the master tempo, activate the Sync switch, which allows using the Delay
Time beat division chooser. The numbered switches represent time delay in 16th notes. For example,
selecting “4” delays the signal by four 16th notes, which equals one beat (a quarter note) of delay.
If the Sync switch is off, the delay time reverts to milliseconds. In this case, to edit the delay time,
click and drag up or down in the Delay Time field, or click in the field and type in a value.

The Feedback parameter defines how much of each channel’s output signal feeds back into the delay
lines” inputs. Internally there are two independent feedback loops, so a signal on the left channel
does not feed back into the right channel and vice versa.

The Dry/Wet control adjusts the balance between the processed and dry signals. Set it to full wet if
using the Simple Delay in a return channel.

The Simple Delay Effect.
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The Vinyl Distortion effect emulates some of the typical distortions that occur on vinyl records during
playback. These distortions are caused by the geometric relationships between the needle and the
recorded groove. The effect also features a crackle generator for adding noisy artifacts.

The Tracing Model section adds even harmonic distortion to the input signal. Adjust the amount
of distortion with the Drive knob, or click and drag vertically in the Tracing Model XY window. To
adjust the distortion’s frequency or “color,” drag horizontally in the XY window or double-click on the
Freq field and type in a value. Holding the (At ] (PC) / (At - (Mac) modifier while dragging
vertically in the XY window changes the frequency band’s Q (bandwidth).

The Pinch Effect section adds odd harmonics to the input signal. These distortions typically occur
180 degrees out of phase, creating a richer stereo image. The Pinch Effect has the same controls as
the Tracing Model, but generates a rather different sound.

The Drive control increases or decreases the overall distortion amount created by both the Tracing
Model and Pinch.

There are two distortion modes: soft and hard. The soft mode simulates the sound of a dub plate,
while hard mode is more like that of a standard vinyl record.

The Vinyl Distortion Effect.
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The stereo/mono switch determines whether the Pinch distortion occurs in stereo or mono. Set it to
stereo for realistic simulation of vinyl distortions.

The Crackle section adds noise to the signal, with noise density set by the Density control. The
Volume control adjusts the amount of gain applied to the noise.

19.14 Redux
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Nostalgic for the famed low-resolution sound quality of the Ensoniq Mirage, Fairlight CMI or Commo-
dore-64 computer? Redux returns us to the Dark Ages of digital by reducing a signal’s sample rate
and bit resolution.

The Downsample section has two parameters: “Downsample” and a downsample Mode switch.

If the downsample dial is set to “1”, every input sample passes to the output and the signal does not
change. If set to “2”, only every second sample will be processed, so the result sounds a bit more
“digital.” The higher the number, the lower the resulting sample rate, and the more “deconstructed”
the sound. Downsampling is like applying a mosaic effect to an image: There’s a loss of information
and sharp edges occur between the blocks.

The Redux Effect.
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The Downsample Mode switch defines if the downsampling either interpolates over a smaller range
(“soft,” down to 20.0 samples) or does not interpolate over a larger range (“hard,” down to 200
samples).

Bit Reduction is similar, but while downsampling superimposes a grid in time, bit reduction does the
same for amplitude.

If the Bit Reduction amplitude dial is set to 8, amplitude levels are quantized to 256 steps (8 bit
resolution). If set to 1, the result is pretty brutal: Each sample contains either a full positive or full
negative signal, with nothing in between.

Bit Reduction defines an input signal of 0dB as 16 bit. Signals above 0dB are clipped, and the red
overload LED will light up.

Turning off Bit Reduction results in modest CPU savings.

19.15 Resonators
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This device consists of five parallel resonators that superimpose a tonal character on the input
source. It can produce sounds resembling anything from plucked strings to vocoder-like effects. The

The Resonators Effect.
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resonators are tuned in semitones, providing a musical way of adjusting them. The first resonator
defines the root pitch and the four others are tuned relative to this pitch in musical intervals.

The input signal passes first through a filter, and then into the resonators. There are four input filter
types to select from: low-pass, band-pass, high-pass and notch. The input filter frequency can be
adjusted with the Frequency parameter.

The first resonator is fed with both the left and right input channels, while the second and fourth
resonators are dedicated to the left channel, and the third and fifth to the right channel.

The Note parameter defines the root pitch of all the resonators ranging from C1 to C5. It can also
be detuned in cents using the Fine parameter. The Decay parameter lets you adjust the amount of
time it takes for the resonators to be silent after getting an input signal. The longer the decay time,
the more tonal the result will be, similar to the behavior of an undamped piano string. As with a
real string, the decay time depends on the pitch, so low notes will last longer than higher ones. The
Const switch holds the decay time constant regardless of the actual pitch.

Resonators provides two different resonation modes. Mode A provides a more realistic sounding
resonation, while Mode B offers an effect that is especially interesting when Resonator I's Note
parameter is set to lower pitches.

The brightness of the resulting sound can be adjusted using the Color control.

All of the resonators have an On/Off switch and a Gain control. A resonator that is turned off does
not need CPU. Turning off the first resonator does not affect the other ones.

Resonators II through V follow the Note parameter defined in Resonator I, but they can each be
individually transposed +/- 24 semitones using the Pitch controls and detuned in cents using the
Detune controls.

The output section features the obligatory Dry/Wet control and a Width parameter that affects only
the wet signal and blends the left and right outputs of Resonators II-V into a mono signal if set to
zero.
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19.16 Reverb
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19.16.1 Input Processing

The input signal passes first through high and low cut filters, whose X-Y controller allows changing
the band’s center frequency (X-axis) and bandwidth (Y-axis). Either filter may be switched off when
not needed to save CPU power.

Predelay controls the delay time, in milliseconds, before the onset of the first early reflection. This
delays the reverberation relative to the input signal. One’s impression of the size of a real room
depends partly on this delay. Typical values for “natural” sounds range from 1ms to 25ms.

19.16.2 Early Reflections

These are the earliest echoes that you hear after they bounce off a room’s walls, before the onset of
the diffused reverberation “tail.” Their amplitude and distribution give an impression of the room'’s
character.

The Reverb Effect.
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The Shape control “sculpts” the prominence of the early reflections, as well as their overlap with the
diffused sound. With small values, the reflections decay more gradually and the diffused sound occurs
sooner, leading to a larger overlap between these components. With large values, the reflections
decay more rapidly and the diffused onset occurs later. A higher value can sometimes improve the
source’s intelligibility, while a lower value may give a smoother decay.

Spin applies modulation to the early reflections. The 2-D control accesses the depth and frequency
of these modulations. A larger depth tends to provide a less-colored (more spectrally neutral) late
diffusion response. If the modulation frequency is too high, doppler frequency shifting of the source
sound will occur, along with surreal panning effects. Spin may be turned off, using the associated
switch, with modest CPU savings.

19.16.3 Global Settings

The Quality chooser controls the tradeoff between reverb quality and performance. Economy mode
uses minimal CPU resources, while First Class delivers the richest reverberation.

The Size parameter controls the “room’s” volume. At one extreme, a very large size will lend a
shifting, diffused delay effect to the reverb. The other extreme, a very small value, will give it a
highly colored, metallic feel.

The Stereo Image control determines the width of the output’s stereo image. At the highest setting
of 120 degrees, each ear receives a reverberant channel that is independent of the other (this is also
a property of the diffusion in real rooms). The lowest setting mixes the output signal to mono.

19.16.4 Diffusion Network

The Diffusion network creates the reverberant tail that follows the early reflections. The decay time
control adjusts the time required for this tail to drop to 1/1000th (-60 dB) of its initial amplitude.
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High and low shelving filters provide frequency-dependent reverberation decay. The high-frequency
decay models the absorption of sound energy due to air, walls and other materials in the room
(people, carpeting and so forth). The low shelf provides a thinner decay. Each filter may be turned
off to save CPU consumption.

The Freeze control freezes the diffuse response of the input sound. When on, the reverberation
will sustain almost endlessly. Cut modifies Freeze by preventing the input signal from adding to
the frozen reverberation; when off, the input signal will contribute to the diffused amplitude. Flat
bypasses the high and low shelf filters when freeze is on. If Flat is off, the frozen reverberation will
lose energy in the attenuated frequency bands, depending on the state of the high and low shelving
filters.

The Echo Density and Scale parameters provide additional control over the diffusion’s density and
coarseness, and, when the room size is extremely small, have a large impact on the coloration
contributed by the diffusion.

The Chorus section adds a little modulation and motion to the diffusion. Like the Spin section, you
can control the modulation frequency and amplitude, or turn it off.

19.16.5 Output

At the reverb output, you can adjust the effect’s overall Dry/Wet mix, and vary the amplitude of
reflections and diffusion with the Reflect Level and Diffuse Level controls.
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19.17 Utility
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Utility can perform some very useful tasks, especially in combination with other effects.

Most obvious is the Gain control, which allows adjusting the level of the input signal from -36 to
+36 dB. The Gain control is located below the Mute button, which simply turns the signal off if
pressed.

Note: The active/mute controls of a track are always placed at the very end of the signal chain.
However, since you can place Utility anywhere in a signal chain, you can use its mute function to
cut the input of a delay line or reverb without turning off the output of these devices.

The Left/Right buttons allow further processing of only the left or right channel of a sample. If,
for example, Left is turned on, the right channel is ignored and the left channel appears on both
outputs. This is especially useful if you have a stereo file that contains different information on
both channels and you want to use only one.

The Width control acts as a continuous mono to stereo controller when set from 0 to 100 percent.
However, beyond 100 percent the output starts to “fold in” on itself. In the full right position the
output contains only the difference between the left and right channels. If either the Left or Right
button is activated, the Width control has no function and is therefore bypassed.

The Utility Effect.
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At the bottom of the device you will find two Phase () controls, one for each channel. As the name
implies they invert the phase of each channel.



Chapter 20

Live MIDI Effect Reference

Live comes with a selection of custom-designed, built-in MIDI effects. The “Working with Instru-
ments and Effects” chapter (see Working with Instruments and Effects) explains the basics of using
effects in Live.
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20.1 Chord
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This effect assembles a chord, as the name implies, from each incoming note and up to six others of
user-defined pitch. The Shift 1 - 6 knobs allow selecting the pitch of the notes that contribute to
the chord from a range of +/- 36 semitones relative to the original. Setting Shift 1 to +4 semitones
and Shift 2 to +7 semitones, for example, yields a major chord in which the incoming note is the
root.

The Velocity control beneath each Shift knob makes further harmonic sculpting possible, given that
the instrument allows for changes in volume or timbre as function of velocity. It is a relative control,
with a range of 1 to 200 percent (100 percent defined as playing at a velocity equal to that of the
incoming MIDI note). Use the Velocity controls to do anything from adding slight overtones to
washing out most of the other chord elements.

The order in which pitches are added to the chord is inconsequential: The effect of a +12 semitone
shift added with the Shift 1 control, for example, is equal in effect to a +12 semitone shift added
with the Shift 6 control.

Note that no two notes of the same pitch can contribute to the chord, and that selecting the same
shift value twice (e.g., +8 semitones on both Shift 2 and Shift 3) will result in the latter control
becoming gray, indicating that it is a duplicate and therefore not in use. Actually, there is no such

The Chord Effect.
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thing as two notes with the same pitch playing at the same time within the entire Live universe.

20.2 Pitch
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The Pitch Effect.

Pitch is a transposition tool that changes incoming note pitch by +/- 48 semitones.

The Range and Lower Limit controls act together to set a pitch range through which notes are
allowed to pass. Notes outside of the defined pitch range will be blocked, and the effect’s LED light
will flash when this happens.

Notes outside of the pitch range are limited based on their untransposed pitch, prior to the trans-
position stage of the effect.
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20.3 Random

() Random (= @
Chance
+
o
20 % )

4
| Choices
E
E

12
Sign

Scale

Random adds an element of the unknown to the otherwise commonplace pitch parameter. The
Chance control defines the likelihood that an incoming note’s pitch will be changed by a random
value. You can think of it as being something like a dry/wet control for randomness.

The random value that determines the pitch change is created by two variables: The Choices control
defines the number of different random notes possible, from a range of 1 to 24; the Scale control
value is multiplied by the Choices control value, and the result dictates the pitches that random
notes are allowed to have relative to that of the incoming note.

For example, with Chance set to 50 percent, Choices set to 1 and Scale set to 12, half of the resulting
notes will play at the original pitch and half will play 12 semitones higher. But, with Chance set to
50 percent, Choices set to 12 and Scale set to 1, half of the resulting notes will play at the original
pitch and half will play at one of any that are 12 semitones higher.

These examples assume Sign buttons that are set to “Add.” The Sign controls decide whether the
random alteration adds to the original note’s pitch, subtracts from it, or does a little of both. The
LEDs below the Sign controls give you a visual idea of how output pitch compares with that of the
original.

The Random Effect.
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Hint: Try using the Scale effect after Random to obtain random values within a specific harmonic
range.

20.4 Scale
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Scale alters incoming note pitch based on a scale mapping. Each incoming note is given an outgoing
equivalent on the X-Y scale map of the effect: All incoming Cs, for example, might be converted to
outgoing Ds.

The X-Y scale map is 12 squares in length and width, corresponding to the 12 notes in a full octave.
Darker squares represent the black keys on a keyboard. The base of the diagonal scale (the lower-left
square) shown on the map can be changed using the Base control. The X-axis of the map shows
incoming note values, and the Y-axis their outgoing equivalents. Use mouse-clicks to move or delete
the yellow squares, which define where an incoming note will be sent on the scale. (Deleting a note
on the scale map means that it will no longer play.)

The Range and Lower Limit controls define the note range within which scale mapping will take
effect. Outside of the range defined by these controls, the Scale effect will be inapplicable, and

The Scale Effect.
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the LED light will flash to indicate that some notes are not being processed by the effect, but are
playing at their unaltered pitch.

20.5 Velocity
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Velocity re-maps the 127 MIDI note velocity values. The Out Low and Out Hi knobs control the
outgoing velocity (from 1 to 127), which is represented by the Y-axis of the X-Y display. Incoming
velocities that are shown in the display are within the range chosen by the In Low and In Hi
choosers, and are represented on the X-axis. The resulting curve shows how velocity is being altered
by the effect.

If In Low and Out Low are both set to 1, and Out Hi and In Hi are set to 127, the display will show
a straight diagonal line that indicates the equivalent of an effect bypass: Softly played notes are
being output quietly and vice versa. If instead, Out Hi is set to 1 and out Low to 127, the slope of
the line will be reversed, and softly played notes will actually produce the loudest output.

What happens to incoming notes that are outside of the range set with the In Low and In High
controls? This depends on which Mode is selected. Clip Mode does just what it says: It clips
incoming note velocities so that they stay within the range. Gate Mode removes incoming notes

The Velocity Effect.
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altogether if their velocities are outside of the range. You will see the little LED in the effect flash
when a note is blocked by gating. In Fixed Mode, the Out Hi velocity defines all outgoing note
velocities, regardless of incoming note velocity.

The Random function adds or subtracts a random value to the all velocities, and is represented by a
gray area on the display curve.

The Drive and Compand controls can be combined to create more complex curves. Compand is a
simultaneous expanding and compressing tool. When set to values greater than 0, it forces incoming
notes to the outer boundaries of the curve, making them play either loudly or softly. Compand values
of less than 0, on the other hand, force outgoing velocity toward the mid-range. Drive pushes all
values in the curve to the outer extremes. Use these two controls together to sculpt or even redefine
the dynamic structure of a piece.



Chapter 21

Live Instrument Reference

Live comes with a selection of custom-designed, built-in instruments. The “Working with Instru-
ments and Effects” chapter (see Working with Instruments and Effects) explains the basics of using
instruments in Live.
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21.1 Impulse
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Impulse is a drum sampler with complex modulative capabilities. The eight drum samples loaded into
Impulse’s sample slots can be time-stretched, filtered and processed by envelope, saturation, pan
and volume components, nearly all of which are subject to random and velocity-based modulation.

21.1.1 Sample Slots

Samples are dragged and dropped into Impulse’s eight sample slots from the Browser or the Session

and Arrangement Views. Samples can be deleted with your computer keyboard’s Backspace/Delete
key.

Imported samples are automatically mapped onto your MIDI keyboard, providing that it is plugged
in and acknowledged by Live. C3 on the keyboard will trigger the leftmost sample, and the other
samples will follow suit in the octave from C3 to C4. Impulse’s eight slots will appear labeled in the
MIDI Editor’s key tracks (see Editing MIDI Notes and Velocities) when the “Fold” button is active,
even if the given key track is void of MIDI notes. Mapping can be transposed from the default by
applying a Pitch device (see Pitch), or it can be rearranged by applying a Scale device (see Scale).

The Impulse Instrument.
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Each of the eight samples has a proprietary set of parameters, located in the area below the sample
slots and visible when the sample is clicked. Adjustments to sample settings are only captured once
you hit a new note- they do not affect currently playing notes. Note that this behavior also defines
how Impulse reacts to parameter changes from clip envelopes or automation, which are applied once
a new note starts. If you want to achieve continuous changes as a note plays, you may want to use
the Simpler (see Simpler).

Slot 8's parameters also include a “Link” button, located in the lower-left corner, which links slot 8
with slot 7. Linking the two slots allows slot 7’s activation to stop slot 8’s playback, and vice versa.
This was designed with a specific situation in mind (but can, of course, be used for other purposes):
Naturalistic closed hi-hat cymbals will shut down open hi-hat cymbals.

Each slot can be played, soloed or muted using controls that appear when the mouse hovers over it.

21.1.2 Start, Tune and Stretch

The Start control defines where Impulse begins playing a sample, and can be set to up to 100 ms
later than the actual sample beginning. The Transposition control adjusts the transposition of the
sample by +/- 48 semitones, and can be modulated by incoming note velocity or a random value, as
set in the appropriate fields.

The Stretch control has values from -100 to 100 percent. Negative values will shorten the sample,
and positive values will stretch it. Two different stretching algorithms are available: Mode A is ideal
for low sounds, such as toms or bass, while Mode B is better for high sounds, such as cymbals. The
Stretch value can also be modulated by MIDI note velocity.

21.1.3 Filter

The Filter section offers a broad range of filter types, each of which can impart different sonic
characteristics onto the sample by removing certain frequencies. The Frequency control defines
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where in the harmonic spectrum the filter is applied; the Resonance control boosts frequencies near
the points in the spectrum where frequencies are excluded by filtering. Filter Frequency can be
modulated by either a random value or by MIDI note velocity.

21.1.4 Saturator and Envelope

The Saturator gives the sample a fatter, rounder, more analog sound, and can be switched on and off
using the appropriate switch. The Drive control boosts the signal and adds distortion. Note: Turning
Drive up makes almost every signal get much louder, and so will usually require that volume be
lowered manually. Extreme Drive settings on low-pitched sounds will produce the typical, overdriven
analog synth drum sounds.

The envelope can be adjusted using the Decay control, which can be set to a maximum of 60.0
seconds. Impulse has two decay modes: Trigger Mode allows the sample to decay with the note;
Gate Mode forces the envelope to wait for a note off message before beginning the decay. This mode
is useful in situations where you need variable decay lengths, as is the case with hi-hat cymbal
sounds.

21.1.5 Pan and Volume

Each sample has Volume and Pan controls that adjust amplitude and stereo positioning, respectively.
Both controls can be modulated, Pan by velocity and a random value, and Volume by velocity only.

21.1.6 Global Parameters

The parameters located to the right of the sample slots are global controls that apply to all samples
within Impulse’s domain. Volume adjusts the overall level of the instrument, and Pitch adjusts the
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transposition of all notes. The Time control governs the time-stretching and decay of all samples,
allowing you to morph between short and stretched drum sounds.

21.1.7 Individual Outputs

When a new instance of Impulse is dragged into a track, its signal will be mixed with those of the
other instruments and effects feeding the audio chain of the track. It can oftentimes make more
sense to isolate the instrument or one of its individual drum samples, and send this signal to a
separate track. Please see the Routing chapter (see Tapping Individual Outs From an Instrument) to
learn how to accomplish this for Impulse’s overall signal or for Impulse’s individual sample slots.

21.2 Simpler
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Simpler is an instrument that integrates the basic elements of a sampler with a set of classic
synthesizer parameters. A Simpler voice plays a user-defined sample section, which is in turn
processed by envelope, filter, LFO, volume and pitch components.

The Simpler Instrument.
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21.2.1 Sample View

The Sample View displays the sample waveform. Samples can be dragged into Simpler either directly
from the Browser, or from the Session or Arrangement Views in the form of clips. In the latter case,
Simpler will utilize only the section of the sample demarcated by the Clip Loop/Region markers.
Samples can be replaced by dragging in a new sample.

21.2.2 Sample Controls

Simpler plays a specific region or loop of the sample, as determined by a group of sample controls.

The Start and Length controls work together to specify where Simpler begins and ends its sweep of
the sample. As the name implies, Start defines where sample playback starts. The sample will play
for the length defined by the Length parameter. Both parameters are defined as a percentage of
the whole region, so setting start to 25 percent and length to 50 percent, for example, will start
playback 1/4 of the way through the sample and stop playback at the 3/4 mark (using 50 percent
of the sample).

Samples are played by Simpler as one-shots or as loops, depending on whether or not the Loop
switch is active. When looping is active, the Loop control dictates the length of the loop, starting
from the end of the playing sample. Simpler will play the first instance of a looped sample beginning
with the Start point, then continue playing only the length of the loop.

It is possible for glitches or pops to occur between a looped sample’s start and end points due
to the discontinuity in waveform amplitude (i.e., the sample’s loudness). The Snap switch will help
mitigate these by forcing Simpler’s loop markers to snap to zero-crossing points in the sample (points
where the amplitude is zero). Note: Snapping is based on the left channel of stereo samples. It is
therefore still possible, even with Snap activated, to encounter glitches in the right channel of a
stereo sample.

You can also smooth the transition from loop end to loop start by using the Fade control, which
crossfades the two points. This method is especially useful when working with long, textural samples.
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21.2.3 Zoom

Quite often, one starts with a longer region of a sample and ends up using only a small part of it.
Simpler's two Zoom buttons (“+” and “-”) allow you to zoom in around the selected length, or zoom
out to access a larger area. When zooming in on small portions of long samples, it will probably
be necessary to repeatedly shrink the highlighted sample region, as Simpler will zoom no further
than the length of this region. Note: After zooming in, the Start, Loop and Length parameters
will be resized so that there is no audible difference. This means that the Start and Length values
are altered by zooming, and automation or clip envelopes utilizing these parameters will behave

differently after the operation.

21.2.4 Envelope

This is a classic a ADSR Envelope section, as seen in most synthesizers, for shaping the dynamic
structure of the sample. Attack controls the time in milliseconds that it takes for the instrument to
play the sample signal at full amplitude after a note is played. Decay controls the amount of time
taken for the sample to drop down to the Sustain level (dB), which is held until the note is released.
Release time is the amount of time after the end of the note that it takes for the sample amplitude
to drop from the Sustain level back down to zero.

The envelope can also be used to modulate the filter frequency.

21.2.5 Filter

The Filter section offers a broad range of filter types, including classic 12 dB or 24 dB low-pass filters,
as well as band-pass, high-pass and notch, each of which can impart different sonic characteristics
onto the sample by removing certain frequencies from the waveform. The most important parameters
are the typical synth controls Frequency and Resonance. frequency determines where in the harmonic
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spectrum the filter is applied; Resonance boosts frequencies near the points in the spectrum where
frequencies are excluded by filtering.

The best way to understand the effects of these controls is to play with them...

The Frequency parameter can be modulated by an LFO, note velocity, note pitch and the Envelope
section- each of which have an amount control in the Filter section. The Key (tracking) control
allows for shifting the filter's frequency according to note pitch.

21.2.6 LFO

The LFO (low-frequency oscillator) section offers square, sine, triangle, sawtooth and random wave-
forms. The main control in this section is the Rate control, which changes the LFO frequency within
a range of 0.05 to 30 Hz. LFOs are applied individually to each voice, or played note, in Simpler.
Square, triangle and sawtooth LFOs restart each time a new voice is played, while sine and random
do not. The Detune parameter changes the definition of each LFQ’s Rate as a function of the pitch
of incoming notes. A high Detune setting assigns higher notes a higher LFO rate. If Detune is set to
zero, all voices’ LFOs have the same rate and may just differ in their phase.

Note: Sawtooth, Square and Random are waveforms that, by nature, create sudden jumps. These
jumps can cause clicks when applied to filters. This effect cannot be avoided without losing the
“bite” of the waveform. However, we may provide smoothied variations of these in future versions
of Simpler.

21.2.7 Pitch, Volume and Voices

Simpler plays back a sample at its original pitch if the incoming MIDI note is (3, however the
Transpose control allows transposing this by +/- 48 semitones. Pitch can also be modulated by an
LFO using the amount control in this section. Simpler reacts to pitch bend MIDI messages with a
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sensitivity of +/- 5 semitones. You can also modulate the Transpose parameter with clip envelopes
and external controllers.

The Voices parameter sets the maximum number of voices that Simpler can play simultaneously. If
more voices are trying to play than what you have allocated with the Voice control, “voice stealing”
will take place, in which the oldest voice(s) will be dropped in favor of those that are new. For
example, if your Voices parameter is set to 8, and ten voices are all vying to be played, the two
oldest voices will be dropped. (Simpler does try to make voice stealing as subtle as possible.) A
small LED near the Voices control flashes when a voice has been stolen.

Finally, the output volume of Simpler is controlled by the Volume control, and can also be dependent
upon note velocity, as adjusted by the Velocity control.

21.2.8 Strategies for Saving CPU Power
Real-time synthesis needs lots of computing power. However, there are strategies for reducing CPU
load. Save the CPU spent on Simpler by doing some of the following:

® Turn off the Filter if it is not needed.

e Use filter types that are less expensive when possible. A filter's cost correlates with the
steepness of its slope- a “LP 24" is more expensive than a “LP 12."

e Turn off the LFO for a slightly positive influence on CPU.

e Stereo samples need significantly more CPU than mono samples, as they require twice the
processing.

e Decrease the number of simultaneously allowed voices with the Voice control.
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21.3 Operator

Operator is an advanced and flexible synthesizer that combines the concept of “frequency modu-
lation” (FM) with classic subtractive synthesis. It utilizes four multi-waveform oscillators that can
modulate each other’s frequencies, creating very complex timbres from a limited number of objects.
Operator includes a filter section, an LFO and global controls, as well as individual envelopes for the
oscillators, filter, LFO and pitch.

Operator is not included with the standard version of Live, but is a special feature available for
purchase separately. For details, please visit the Ableton web shop, where you will be offered the
opportunity to buy Operator online. Once you have purchased Operator, you will need to unlock it
before using it, as described in the chapter on unlocking (see Unlocking Live).

21.3.1 General Overview

The interface of Operator consists of two parts: the display surrounded on either side by the shell.
The shell offers the most important parameters in a single view and is divided into eight sections.
On the left side, you will find four oscillator sections, and on the right side from top to bottom,

The Operator Instrument.
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the LFO, the filter section, the pitch section and the global parameters. If you change one of the
shell parameters, the display in the center will automatically show the details of the relevant section.
When creating your own sounds, for example, you can conveniently access the level and frequency of
all oscillators at once via the shell, and then adjust each individual oscillator’'s envelope, waveform
and other parameters in its display.

Operator can be folded with the triangular button at its upper left. This is convenient if you do not
need to access the display details.
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Each of Operator's oscillators can either output its signal directly or use its signal to modulate
another oscillator. Operator offers nine predefined algorithms that determine how the oscillators are
connected. An algorithm is chosen by clicking on one of the structure icons in the global display,
which will appear if the bottom right (global) section of the shell is selected. Signals will flow from
top to bottom between the oscillators shown in an algorithm icon.

Operator Folded.
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Typically, FM synthesis makes use of pure sine waves, creating more complex waveforms via modula-
tion. However, in order to simplify sound design and to create a wider range of possible sounds, we
designed Operator to produce a variety of other waveforms, including noise. The instrument is made
complete with an LFO, a pitch envelope and a filter section. Note that lots of “classic” FM synthe-
sizers create fantastic sounds without using filters at all, so we suggest exploring the possibilities
of FM without the filter at first, adding it later if necessary.

Operator will keep you busy if you want to dive deep into sound design! If you want to break the
universe apart completely and reassemble it, you should also try modulating Operator’s controls with
clip envelopes (see Clip Envelopes) or track automation (see Automation and Editing Envelopes).

Operator’s Global Display.
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21.3.2 Oscillator Section and Aliasing
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The oscillators can basically play back five waveform types- sine, square, sawtooth, triangle and
noise- as chosen from the Wave chooser in the individual oscillator displays. The first of these
waveforms is a pure, mathematical sine wave, which is usually the first choice for many FM timbres.
Since FM synthesis has a long tradition in hardware synthesizers, we added some variations of the
pure sine wave that allow for more realistic modeling of vintage digital synthesizers. The differences
between these sine waves are very subtle, and whether or not they are audible is highly dependant
upon the individual sound. Another special case is the noise waveform. This is not real noise,
generated by a random generator, but a looping noise sample. For more “statistical” noise, one
could modulate the noise oscillator with another oscillator, or with real noise from the LFO. The
square, triangle and sawtooth waveforms are resynthesized approximations of the ideal shape. The
numbers included in the displayed name (e.g., “Sq6”) define how many harmonics are used for the
resynthesis. Lower numbers sound mellower and are less likely to create aliasing when used on high
pitches.

Aliasing distortion is a common side effect of all digital synthesis and is the result of the finite
sample rate and precision of digital systems. It mostly occurs at high frequencies. FM synthesis is
especially likely to produce this kind of effect, since one can easily create sounds with lots of high
harmonics. This also means that more complex oscillator waveforms, such as “Saw32,” tend to be

Oscillator D’s Display and
Shell Parameters.
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more sensitive to aliasing than pure sine waves. Aliasing is a two-fold beast: A bit of it can be
exactly what is needed to create a cool sound, and a bit too much can make the timbre unplayable,
as the perception of pitch is lost when high notes suddenly fold back into arbitrary pitches. The
Tone parameter in the global section allows for controlling aliasing. Its effect is sometimes similar
to a low-pass filter, but this depends on the nature of the sound itself and cannot generally be
predicted. If you want to familiarize yourself with the sound of aliasing, turn Tone up fully and play
a few very high notes. You will most likely notice that some notes sound completely different from
other notes. Now, turn Tone down and the effect will be reduced, but the sound will be less bright.

The frequency of an oscillator can be adjusted in the shell with its Coarse and Fine controls. An
oscillator’s frequency usually follows that of played notes, but for some sounds it might be useful to
set one or more oscillators to fixed frequencies. This can be done for each individual oscillator by
activating the Fixed option. This allows the creation of sounds in which only the timbre will vary
when different notes are played, but the tuning will stay the same. Fixed Mode would be useful, for
example, in creating live drum sounds. Fixed Mode also allows producing very low frequencies down
to 0.1 Hz. Note that when Fixed Mode is active, the frequency of the oscillator is controlled in the
shell with the Frequency (Freq) and Multiplier (Multi) controls.

Operator includes a special Osc<Vel control for each oscillator that allows altering frequency as a
function of velocity. This feature can be very useful when working with sequenced sounds in which
the velocity of each note can be adjusted carefully. Part of this functionality is the adjacent quantize
control. If this control is activated, the frequency will only move in whole numbers, just as if the
Coarse control were being manually adjusted. If quantize is not activated, the frequency will be
shifted in an unquantized manner, leading to detuned or inharmonic sounds (which very well could
be exactly what you want...).

The amplitude of an oscillator depends on the Level setting of the oscillator in the shell and on its
envelope (see Envelopes), which is shown in its display and can be adjusted from there. It can also
be modified by note velocity and note pitch with the Level<Vel and Level<Key parameters available
in the lower portion of each oscillator’s display.

The phase of each oscillator can be adjusted using the Phase control in its display.
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As explained earlier (see General Overview) oscillators can modulate each other when set up to do
so with the global display’s algorithms. When an oscillator is modulating another oscillator, two
main properties define the result: the amplitude of the modulating oscillator and the frequency ratio
between both oscillators. Note that Oscillator D can modulate itself via the Feedback parameter
available in its display.

21.3.3 LFO Section
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The LFO in Operator can practically be thought of as a fifth oscillator. It runs at an audio rate, and
it modulates the frequency of the other oscillators. It is possible to switch modulation by the LFO
on or off for each individual oscillator using the Destination buttons in the LFQO's display. The LFO
can also be turned off if it is unused.

The LFO offers a choice of classic LFO waveforms, sample and hold (S&H), and noise. Sample and
hold uses random numbers chosen at the rate of the LFO, creating the random steps useful for typical
retro-futuristic sci-fi sounds. The noise waveform is simply bandpass-filtered noise.

Tip: FM synthesis can be used to create fantastic percussion sounds, and using the LFO with the
noise waveform is the key to great hi-hats and snares.

The frequency of the LFO is determined by the LFO Rate control in the shell, as well as the low/high

Operator’s LFO Parameters.
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setting of the adjacent LFO Range switch. The frequency of the LFO can follow note pitch, be fixed
or be set to something in between. This is defined by the Rate<Key parameter in the LFQ’s display.

The intensity of the LFO is set by the LFO Mod control in the shell. This parameter can be modulated
by note velocity via the display’s Amt<Vel control. The LFO’s intensity is also affected by its envelope
(see Envelopes).

21.3.4 Envelopes

Operator has seven envelopes: one for each oscillator, a filter envelope, a pitch envelope and an
envelope for the LFO. All envelopes are constructed similarly and feature some special looping modes.

An envelope’s shape is defined by six parameters: three rates and three levels. A rate is the time
it takes to go from one level to the next. For instance, a typical pad sound starts with the initial
level “-inf dB” (which is silence), moves with an attack rate to its peak level, moves from there
to the sustain level with a decay rate, and then finally, after note-off occurs, back to “-inf dB” at
the release rate. Operator’s display provides a good overview of the actual shape of any particular
envelope and lets you directly adjust the curve by clicking and dragging.

With FM synthesis, it is possible to create spectacular, endless, permuting sounds; the key to doing
this is looping envelopes. Loop Mode can be activated in the lower-left corner of the display. If an
envelope in Operator is in Loop Mode and reaches sustain level while the note is still being held, it
will be retriggered. The rate for this movement is defined by the Loop Time parameter. (Note that
envelopes in Loop Mode can loop very quickly and can therefore be used to achieve effects that one
would not normally expect from an envelope generator.)

While Loop Mode is good for textures and experimental sounds, Operator also includes Beat and Sync
Modes, which provide a simple way of creating rhythmical sounds. If set to Beat Mode, an envelope
will restart after the beat time selected from the Repeat chooser. In Beat Mode, the repeat time is
defined in fractions of song time, but notes are not quantized. If you play a note a bit out of sync,
it will repeat perfectly but stay out of sync. In Sync Mode however, the first repetition is quantized
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to the nearest 16th note and, as a result, all following repetitions are synced to the song tempo.
Note that Sync Mode only works if the song is playing, and otherwise it will behave like Beat Mode.

Note: To avoid the audible clicks caused by restarting from its initial level, a looped envelope will
restart from its actual level and move with the set attack rate to peak level.

The rates of all the envelopes in Operator can be scaled in unison by the Time control in the global
section of the shell. Note that beat-time values in Beat and Sync Modes are not influenced by the
global Time parameter. Envelope rates can be further modified by note pitch, as dictated by the
Time<Key parameter in the global section’s display. The rate of an individual envelope can also be
modified by velocity using the Time<Vel parameter. These modulations in conjunction with the loop
feature can be used to create very, very complex things. ..

The pitch envelope can be turned on or off for each individual oscillator and for the LFO using the
Destination A-D and LFO buttons in its display. It can also be turned off altogether via the pitch
section of the shell. The pitch envelope amount is adjusted with the adjacent Pitch Env control.

Tip: If the pitch envelope is only applied to the LFO and is looping, it can serve as another LFO,
modulating the rate of the first. And, since the envelope of the LFO itself can loop, it can serve as
a third LFO modulating the intensity of the first!
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21.3.5 Filter Section
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As mentioned earlier, the filters are not the main focus of this instrument. However, they can be very
useful for modifying the sonically rich timbres created by the oscillators. And, since the oscillators
also provide you with the classic waveforms of analog synthesizers, you can very easily build a
subtractive synthesizer with them.

The filter section offers 12 dB low-pass, band-pass, high-pass and notch filters. Note that the notch
filter is not of true notch filter design but a bell-shaped curve with very low gain, which removes
more of the frequencies around the center.

Filter cutoff frequency and resonance can be adjusted in the shell. Filter frequency can also be
modulated by note velocity, note pitch and the filter envelope (see Envelopes). The Freq<Vel,
Freq<Key and Envelope controls in the filter's display set these three functions, respectively.

21.3.6 Global Controls

The maximum number of Operator voices (notes) playing simultaneously can be adjusted with the
Voices parameter in the global display. Ideally, one would want to leave this setting high enough

Operator’s Filter Section.
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so that no voices would be turned off while playing, however a setting between 6 and 12 is usually
more realistic when considering CPU power (see Strategies for Saving CPU Power).

Tip: Some sounds should play monophonically by nature, which means that they should only use a
single voice. (A flute is a good example.) In these cases, you can set Voices to 1. If Voices is set to
1, another effect occurs: Overlapping voices will be played legato, which means that the envelopes
will not be retriggered from voice to voice, and only pitch will change.

A high quality setting (HiQ) can be switched on and off in the global display, controlling the inter-
polation algorithm of the oscillators and LFO. This setting will affect the sound of some waveforms
more than others (especially the noise waveform) and also affects CPU resources (see Strategies for
Saving CPU Power).

Global Volume and Transpose controls for the instrument can be found in the global section of the
shell, and a Pan control is located in the global section’s display. Pan can be modulated by a random
factor or by note pitch, using the adjacent Rnd and Key controls, respectively.

MIDI pitch bend messages will affect Operator as defined by the PB Range control in the pitch
section of the display.

21.3.7 Glide and Spread
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Operator’s Pitch Section.
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Operator includes a polyphonic glide function. When this function is activated, new notes will start
with the pitch of the last note played and then slide gradually to their own played pitch. Glide can
be turned on or off and adjusted with the Glide Time control in the pitch display.

Operator also offers a special Spread parameter that creates a rich stereo chorus by using two voices
per note and panning one to the left and one to the right. The two voices are detuned, and the
amount of detuning can be adjusted with the Spread control in the pitch section of the shell.

Tip: Whether or not spread is applied to a particular note depends upon the setting of the Spread
parameter during the note-on event. To achieve special effects, you could, for instance, create a
sequence where Spread is 0 most of the time and turned on only for some notes. These notes will
then play in stereo, while the others will play mono.

21.3.8 Strategies for Saving CPU Power

If you want to save CPU power, turn off features that you do not need or reduce the number of
voices. Specifically, turning off the filter or the LFO if they do not contribute to the sound will save
CPU power.

For the sake of saving CPU resources, you will also usually want to reduce the number of voices to
something between 6 and 12, and carefully use the Spread feature. The high quality setting can also
be turned off to conserve CPU resources.

Note that turning off the oscillators will not save CPU power.

21.3.9 Finally...

Operator is the result of an intense preoccupation with FM synthesis and a love and dedication to the
old hardware FM synthesizers, such as the Yamaha SY77, the Yamaha TX81Z and the NED Synclavier
IT. FM synthesis was first explored musically by the composer and computer music pioneer John
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Chowning in the mid-1960s. In 1973, he and Stanford University began a relationship with Yamaha
that lead to one of the most successful commercial musical instruments ever, the DX7.

John Chowning realized some very amazing and beautiful musical pieces based on a synthesis con-
cept that you can now explore yourself simply by playing with Operator in Live.

We wish you loads of fun with it!

21.3.10 The Complete Parameter List

The function of each Operator parameter is explained in the forthcoming sections. Remember that
you can also access explanations of controls in Live (including those belonging to Operator) directly
from the software by placing the mouse over the control and reading the text that appears in the
Info View (see Using the Info View and Index). Parameters in this list are grouped into sections
based on where they appear in Operator.

Global Shell and Display

Time- This is a global control for all envelope rates.

Tone— Operator is capable of producing timbres with very high frequencies, which can sometimes
lead to aliasing artifacts. The Tone setting controls the high frequency content of sounds. Higher
settings are typically brighter but also more likely to produce aliasing.

Volume- This sets the overall volume of the instrument.

Algorithm—- An oscillator can modulate other oscillators, be modulated by other oscillators, or both.
The algorithm defines the connections between the oscillators and therefore has a significant impact
on the sound that is created.

Voices— This sets the maximum number of notes that can sound simultaneously. If more notes than
available voices are requested, the oldest notes will be cut off.
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High Quality (HiQ)- This changes the interpolation algorithm of the oscillators and the LFO. If turned
off, some timbres will sound more rough, especially the noise waveform. Turning this off will also
save some CPU power.

Time<Key— The rates of all envelopes can be controlled by note pitch. If the global Time<Key
parameter is set to higher values, the envelopes run faster when higher notes are played.

Pan- Use this to adjust the panorama of each note. This is especially useful when modulated with
clip envelopes.

Pan<Key (Key)- If Pan<Key is set to higher values, low notes will pan relatively more to the left
channel, and higher notes to the right. Typically this is used for piano-like sounds.

Pan<Random (Rnd)- This defines the extent to which notes are randomly distributed between the
left and right channels.

Pitch Shell and Display
Pitch Envelope On- This turns the pitch envelope on and off. Turning it off if it is unused saves some
CPU power.

Pitch Envelope Amount (Pitch Env)- This sets the intensity of the pitch envelope. A value of 100%
means that the pitch change is exactly defined by the pitch envelope’s levels. A value of -100%
inverts the sign of the pitch envelope levels.

Spread- If Spread is turned up, the synthesizer uses two detuned voices per note, one each on the
left and right stereo channels, to create chorusing sounds. Spread is a very CPU-intensive effect.

Transpose—- This is the global transposition setting for the instrument. Changing this parameter will
affect notes that are already playing.

Pitch Bend Range (PB Range)— This defines the effect of MIDI pitch bend messages.
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Pitch Envelope Rates<Velocity (Time<Vel)- This parameter exists for filter, pitch, LFO and volume
envelopes. It is therefore listed in the section on envelopes (see Envelope Display).

Glide (G)- With Glide on, notes will slide from the pitch of the last played note to their played pitch.
Note that all envelopes are not retriggered in this case if notes are being played legato.

Glide Time (Time)- This is the time it takes for a note to slide from the pitch of the last played note
to its final pitch when Glide is activated. This setting has no effect if Glide is not activated.

Pitch Envelope to Osc (Destination A-D)- The pitch envelope affects the frequency of the respective
oscillator if this is turned on.

Pitch Envelope to LFO (Destination LFO)- The pitch envelope affects the frequency of the LFO if this
is turned on.

Filter Shell and Display

Filter On- This turns the filter on and off. Turning it off when it is unused saves CPU power.

Filter Type- Low-pass, band-pass and high-pass are second order filters with resonance. Their names
imply the part of the spectrum they affect. The notch filter passes everything apart from its center
frequency and is more audible with low resonance settings.

Filter Frequency (Freq)- This defines the center or cutoff frequency of the filter. Note that the
resulting frequency may also be modulated by note velocity and by the filter envelope.

Filter Resonance (Res)- This defines the resonance around the filter frequency of the low-pass and
high-pass filters, and the width of the band-pass and notch filters.

Filter Frequency<Velocity (Freq<Vel)- Filter frequency is modulated by note velocity according to this
setting.

Filter Frequency<Key (Freqg<Key)- Filter frequency is modulated by note pitch according to this set-
ting. A value of 100% means that the frequency doubles per octave. The center point for this
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function is C3.

Filter Envelope Rates<Velocity (Time<Vel)- This parameter exists for filter, pitch, LFO and volume
envelopes. It is therefore listed in the section on envelopes (see Envelope Display).

Filter Frequency<Envelope (Envelope)- Filter frequency is modulated by the filter envelope according
to this setting. A value of 100% means that the envelope can create a maximum frequency shift of
approximately 9 octaves.

LFO Shell and Display

LFO On- This turns the LFO (low-frequency oscillator) on and off. Turning it off when it is unused
saves some CPU power.

LFO Waveform—- Select from among several typical LFO waveforms. Sample and Hold creates random
steps, and Noise supplies bandpass-filtered noise. All waveforms are band-limited to avoid unwanted
clicks. Cyclic waveforms restart with each note-on message.

LFO Range- The LFO covers an extreme frequency range. Choose Low for a range from 50 seconds to
30 Hz, or Hi for 8 Hz to 12 kHz. Due to the possible high frequencies, the LFO can also function as
a fifth oscillator.

LFO Rate (Rate)- This sets the rate of the LFO. The actual frequency also depends on the setting of
the LFO Range and the LFO Rate<Key controls.

LFO Amount (Mod)- This sets the intensity of the LFO. Note that the actual effect also depends on
the LFO envelope.

LFO to Osc (Destination A-D)- The LFO modulates the frequency of the respective oscillator if this is
turned on.

LFO Envelope Rates<Velocity (Time<Vel)- This parameter exists for filter, pitch, LFO and volume
envelopes. It is therefore listed in the section on envelopes (see Envelope Display).
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LFO Rate<Key (Rate<Key)- The LFQ's frequency can be a function of note pitch. If this is set to
100%, the LFO will double its frequency per octave, functioning like a normal oscillator.

LFO Amount<Velocity (Amt<Vel)- This setting adjusts modulation of the LFO intensity by note veloc-
ity.

Oscillators A-D Shell and Display

Osc On- This turns the oscillator on and off.

Osc Coarse frequency (Coarse)- The relationship between oscillator frequency and note pitch is
defined by the Coarse and Fine parameters. Coarse sets the ratio in whole numbers, creating a
harmonic relationship.

Osc Fine Frequency (Fine)- The relationship between oscillator frequency and note pitch is defined
by the Coarse and Fine parameters. Fine sets the ratio in fractions of whole numbers, creating an
inharmonic relationship.

Osc Fixed Frequency On (Fixed)- In Fixed Mode, oscillators do not respond to note pitch but instead
play a fixed frequency.

Osc Fixed Frequency (Freq)- This is the frequency of the oscillator in Hertz. This frequency is
constant, regardless of note pitch.

Osc Fixed Multiplier (Multi)- This is used to adjust the range of the fixed frequency. Multiply this
value with the value of the oscillator’s Freq knob to get actual frequency in Hz.

Osc Output Level (Level)- This sets the output level of the oscillator. If this oscillator is modulating
another, its level has significant influence on the resulting timbre. Higher levels usually create bright
and/or noisy sounds.

Osc Waveform (Wave)— Choose from a collection of carefully selected waveforms, including slight
derivations of sine waves that are especially useful for creating emulations of vintage digital hard-
ware synthesizers.
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Osc Phase (Phase)- This sets the initial phase of the oscillator. The range represents one whole
cycle.

Osc Frequency<Velocity (Osc<Vel)- The frequency of an oscillator can be modulated by note velocity.
Positive values raise the oscillator’s pitch with greater velocities, and negative values lower it.

Osc Freg<Vel Quantized (Q)- This allows quantizing the effect of the Frequency<Velocity parameter.
If activated, the sonic result is the same as manually changing the Coarse parameter for each note.

Volume Envelope Rates<Velocity (Time<Vel)- This parameter exists for filter, pitch, LFO and volume
envelopes. It is therefore listed in the section on envelopes (see Envelope Display).

Osc Output Level<Velocity (Vel)- This defines how much the oscillator’s level depends upon note
velocity. Applying this to modulating oscillators creates velocity-dependent timbres.

Osc Output Level<Key (Key)- This defines how much the oscillator’s level depends upon note pitch.
The center point for this function is C3.

Osc D Feedback (Feedback)— Osc D can modulate itself. The modulation is dependent not only on the
setting of the feedback control but also on the oscillator level and the envelope. Higher feedback
creates a more complex resulting waveform.

Envelope Display

Envelope Attack Time (Attack)- This sets the time it takes for a note to reach the peak level, starting
from the initial level. The shape of this segment of the envelope is linear.

Envelope Decay Time (Decay)- This sets the time it takes for a note to reach the sustain level from
the peak level. The shape of this segment of the envelope is exponential.

Envelope Release Time (Release)— This is the time it takes for a complete fade-out of a note after a
note-off message is received. The shape of this segment is exponential. The note will fade out from
the value of the envelope at the moment the note-off message occurs, regardless of which segment
is currently active.
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Envelope Initial Level (Initial)- This sets the initial value of the envelope.
Envelope Peak Level (Peak)- This is the peak level at the end of the note attack.

Envelope Sustain Level (Sustain)- This is the sustain level at the end of the note decay. The envelope
will stay at this level until note release unless it is in Loop, Sync or Beat Mode.

Envelope Mode (Mode)- If this is set to Loop, the envelope will start again after the end of the
decay segment. If set to Beat or Sync, it will start again after a given beat-time. In Sync Mode, this
behavior will be quantized to song time.

Envelope Beat/Sync Rate (Repeat)- The envelope will be retriggered after this amount of beat-time,
as long as it is still on. When retriggered, the envelope will move at the given attack rate from the
current level to the peak level.

Envelope Loop Time (Time)- If a note is still on after the end of the decay/sustain segment, the
envelope will start again from its initial value. The time it takes to move from the sustain level to
the initial value is defined by this parameter.

Envelope Rates<Velocity (Time<Vel)- Envelope segments will be modulated by note velocity as defined
by this setting. This is especially interesting if the envelopes are looping. Note that this modulation
does not influence the beat-time in Beat or Sync Modes, but the envelope segments themselves.



Chapter 22

MIDI and Key Remote Control

To liberate the musician from the mouse, most of Live’s controls can be “remote-controlled” with an
external MIDI controller and the computer keyboard. This chapter describes the details of mapping
to the following specific types of controls in Live's user interface:

1. Session View slots. Note that MIDI and computer key assignments are bound to the slots, not
to the clips they contain.

2. Switches and buttons, among them the Track and Device Activator switches, the Control Bar’s
Tap, metronome and transport controls.

3. Radio buttons. A radio button selects among a number of options. One instance of a radio
button is in the crossfader assignment section (see Using Live’s Crossfader) in each track,
which offers three options: The track is assigned to the crossfader’s A position, the track is
unaffected by the crossfader or the track is affected by the crossfader’s B position.

4. Continuous controls, like the mixer’s volume, pan and sends.

283
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22.1 Keyboard Remote Control
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Creating remote-control assignments for your computer keyboard is straightforward:

1. Enter Key Map Mode by pressing the KEY switch in the upper right-hand corner of the Live
screen. Notice that assignable elements of the interface become highlighted when you enter
Key Map Mode.

2. Click on the Live control you wish to assign to a key.
3. Press the key to which you wish to assign the control.
4. Leave Key Map Mode by again pressing the Key Map Mode switch.

Keyboard assignments can be deleted using your computer’s Backspace or Delete key while Key Map
Mode is active.

Keyboard assignments will be implemented by Live in the following ways:

e Clips in Session View slots will be affected by mapped keys according to their Launch Mode
settings (see Launch Modes).

e Keys assigned to switches will toggle switch states.
® Keys assigned to radio buttons will toggle through the available options.

Please be sure not to confuse the Key remote functionality with Live’s ability to use the keyboard as
a pseudo-MIDI device (see Playing MIDI With the Computer Keyboard) that can generate MIDI notes
from computer keystrokes for use with instruments.

The Key Map Mode Switch.
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22.2 MIDI Remote Control

Live can be controlled remotely with an external MIDI device, such as a keyboard or controller box.

Before we explain how remote-control assignments are made and implemented, let us first make the
distinction between MIDI remote control and a separate use of MIDI in Live: input for MIDI tracks.
Let’s say that you are, for instance, using a MIDI keyboard to play an instrument in one of Live's
MIDI tracks (see Working with Instruments and Effects). If you assign F2 on your MIDI keyboard to
a Session View Clip Launch button, that key will cease play F2 on your MIDI track’s instrument, as it
now “belongs” solely to the Clip Launch button.

MIDI keys that become part of remote-control assignments can no longer be used as input for MIDI
tracks.

This is a common cause of confusion that can be easily resolved by looking at the Control Bar's MIDI
indicators (see MIDI In/Out Indicators).

22.2.1 MIDI Remote Input and Output

Before making any MIDI assignments, you must first set up Live to recognize whatever MIDI device(s)
you are using for remote control. This is done in the MIDI/Sync tab of the Live Preferences.
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Audic MIDIJ Sync Plug-in Defaults Misc

Input Qutput

Computer Keyboard FireWire 410
FireWire 410

Input Output

[None

Mone
FireWire 410

The MIDI Remote Control Input Device choosers select the MIDI devices from which Live will receive
MIDI notes and controller messages. Live merges the MIDI coming in through the two devices. When
Live recognizes a MIDI message, the MIDI Map Switch in the Control Bar flashes.

Use the MIDI Remote Control Qutput chooser in the MIDI/Sync Preferences when working with
external controller boxes that use endless knobs or motorized faders. These devices need to be
updated when a control’s value changes in Live, because the position of the motorized faders or
LED chains has to match the new value. After connecting your external device to the computer or
adjusting assigned Live controls via the mouse, use the Send Control Updates Now button in the
MIDI/Sync Preferences to send your external control the current state of all of Live’s controls.

Selecting a MIDI Device for
Remote Control.
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22.2.2 Assigning MIDI Remote Control

T~ v ]

Once your remote-control setup is made in the Preferences, giving MIDI controllers and notes remote-
control assignments is simple:

1. Enter MIDI Map Mode by pressing the MIDI switch in the upper right-hand corner of the Live
screen. Notice that assignable elements of the interface become highlighted.

2. Click on the Live control you wish to assign to MIDI.

3. Send a MIDI message by pressing a keyboard key, turning a knob, etc., on your MIDI controller.
To assign a Session slot to a MIDI note range for chromatic playing, first play the root key
(this is the key that will play the clip at the default transposition), then, while holding down
the root key, press keys below or above the root to define the limits of the range.

4. Leave MIDI Map Mode by again pressing the MIDI Map Mode switch.

MIDI assignments can be deleted using your computer’s Backspace or Delete key while MIDI Map
Mode is active.

22.2.3 Mapping to MIDI Notes

MIDI notes send simple on/off messages to Live’s interface elements. MIDI note-on and note-off
messages have the following effects on controls in Live:

® Session View Slots— Note-on and note-off messages affect clips in the slot according to their
Launch Mode settings (see Launch Modes).

e Switches— A note-on message toggles the switch state.

The MIDI Map Mode Switch.
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® Radio Buttons— Note-on messages toggle through the available options.

22.2.4 Mapping to Absolute MIDI Controllers

Absolute MIDI controllers send messages to Live in the form of absolute values ranging from 0 to
127. These values lead to different results depending on the type of Live control to which they are
assigned. A value message of 127, for example, might turn the Volume control on a Live track all
the way up or play a Session View clip. Specifically, MIDI-controller messages from 0 to 127 have
the following effects on controls in Live:

e Session View Slots— Controller values above 63 are treated like note-on messages. Controller
values below 64 are treated like note-off messages.

e Switches— Controller values 64 and above turn the switch on. Controller values below 64 turn
it off.

® Radio Buttons— The controller's 0...127 value range is mapped onto the range of available
options.

e (ontinuous Controls— The controller’s 0...127 value range is mapped onto the parameter’s range
of values.

Live also supports pitch bend messages and high-precision controller messages with a 0...16383
value range. The above specifications apply to pitch bend and high-precision controllers as well,
except that the value range’s center is at 8191/8192.

22.2.5 Mapping to Relative MIDI Controllers

Some MIDI controllers can send “value increment” and “value decrement” messages instead of ab-
solute MIDI messages. These controls prevent parameter jumps when the state of a control in Live
and the corresponding control on the hardware MIDI controller differ. For example, imagine that
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you have assigned the pan knob on your controller box to the pan control in a Live track. If the
hardware control is panned hard right, and the Live control is panned hard left, a slight movement
in a hardware pan knob that sends absolute messages would tell Live to pan right, causing an abrupt
jump in the track’s panning. A pan knob sending relative messages would prevent this, since its
incremental message to Live would simply say, “Pan slightly left.”

There are several types of relative controllers: Signed Bit, Signed Bit 2, Bin Offset and Twos Com-
plement. Live can recognize the type of relative controller you are working with as you make
remote-control assignments, and you can help this by moving the relative controller knob slowly to
the left when you make the assignment. If you know the relative controller type , you can manually
select it in the chooser that appears in the Status Line at the bottom of the Live screen while
mapping a Live control.

Live will do the following with relative MIDI-controller messages:

o Session View Slots— Value increment messages are treated like note-on messages. Value decre-
ment messages are treated like note-off messages.

® Switches— Increment messages turn the switch on. Decrement messages turn it off.

® Radio Buttons— Increment messages make the radio button jump forward to the next available
option. Decrement messages make it jump backwards.

e (ontinuous Controls— Each type of relative MIDI controller uses a different interpretation of
the 0...127 MIDI-controller value range to identify value increments and decrements:

Convention (Mode) Increment | Decrement
Relative (Signed Bit) 001 - 064 | 065 - 127
Relative (Signed Bit 2) | 065 - 127 | 001 - 064
Relative (Bin Offset) 065 - 127 | 063 - 001
Relative (2's Comp.) 001 - 064 | 127 - 065

Please consult the documentation that came with your MIDI controller if you need further informa-
tion on relative MIDI controllers.
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22.3 Relative Session View Navigation

Notice that you can make not only absolute mappings to individual slots and scenes, but also relative
mappings to move the highlighted scene and operate on the highlighted clips. In Key or MIDI Map
Mode, a strip of assignable controls appears below the Session grid:

[ Jestik_| [ [meieay ]
| |orsiler|t | | |Cc|mnutarl| | | | | |Dlrums | 4
N | | | Stop Clips

> > > 3 D

= >
|| H || H H ™
Ow ¢ O & i O
1. Assign these buttons to keys, notes or controllers to move the highlighted scene up and down.

2. Assign this scene number value box to a MIDI controller, preferably with an endless knob, to
scroll through the scenes. For details, see the discussion of Relative Map Modes (see Mapping
to Relative MIDI Controllers).

ru

3. Assign this button to launch the highlighted scene. If the Misc Preferences’ “Select Next Scene

on Launch” option is checked, you can successively go through the scenes.
4. Assign these buttons to launch the clip at the highlighted scene, in the respective track.

Relative session mapping is useful for navigating a large Live Set, as Live always keeps the high-
lighted scene at the Session View's center.

The Relative Session
Mapping Strip.
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Synchronization and ReWire

23.1 Synchronizing via MIDI

The MIDI protocol defines two ways to synchronize sequencers, both of which are supported by Live.
Both protocols work with the notion of a sync master that delivers a sync signal, which is tracked
by the sync slaves.

e MIDI Clock. MIDI Clock works like a metronome ticking at a fast rate. The rate of the incoming
ticks is tempo-dependent: Changing the tempo at the sync master (e.g., a drum machine) will
cause the slave to follow the change. The MIDI Clock protocol also provides messages that
indicate the song position. With respect to MIDI Clock, Live can act as both a MIDI sync
master and slave.

e MIDI Timecode. MIDI Timecode is the MIDI version of the SMPTE protocol, the standard
means to synchronize tape machines and computers in the audio and film industry. A MIDI
Timecode message specifies a time in seconds and frames (subdivisions of a second). Live will

291
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interpret a Timecode message as a position in the Arrangement. Timecode messages carry no
meter-related information; when slaving Live to another sequencer using MIDI Timecode, you
will have to adjust the tempo manually. Tempo changes cannot be tracked. Detailed MIDI
Timecode preferences are explained later in this chapter (see MIDI Timecode Options). With
respect to MIDI Timecode, Live can only act as a MIDI sync slave, not a master.

23.1.1 Synchronizing External MIDI Devices to Live

Live can send MIDI Clock messages to an external MIDI sequencer (or drum machine). After connect-
ing the sequencer to Live and setting it up to receive MIDI sync, simply select the device to send

sync messages to from the MIDI Sync Output device chooser, which is found in the MIDI Preferences
“Sync” section.

[Out USB Midi 1x1 =
MNone

Oul USB Midi 1x1

MIDI Yoke NT: 1

MPU-401

Choosing a MIDI Slave for
Live.

The lower indicator “LED" next to the Control Bar's EXT button flashes when Live is sending sync
messages to external sequencers.
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23.1.2 Synchronizing Live to External MIDI Devices

Live can be synchronized via MIDI to an external sequencer. After connecting the sequencer to Live

and setting it up to send sync, use Live's MIDI Preferences” “Sync” section to tell Live about the
connection.

input

[None =
None

In USB Midi 1x1 mecode Rate
MPU-401
SB Audigy MIDI-Anschiuss [EBDO)
Dot

& Doty Setting up Live as a MIDI
Slave.

1. The MIDI Sync Input device chooser selects the MIDI device from which Live receives its MIDI
sync messages.

2. Choose what type of sync messages Live will respond to in the MIDI Input Sync Type menu.

3. Activate external sync, either by switching on the EXT button in the Control Bar or using
the External Sync command in the Options menu. The upper indicator “LED” next to the EXT
button flashes if Live receives useable sync messages.

AP | 129 -Z-b@r 1. 1. 1|+-|B|®

W it o | The External Sync Switch.
When Live is synced to an external MIDI device, it can accept song position pointers from this
device, syncing it not only in terms of tempo, but in terms of its position in the song. If the master
jumps to a new position within the song, Live will do the same. However, If the Control Bar’s Loop
switch is activated, playback will be looped, and song position pointers will simply be “wrapped”
into the length of the loop.
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23.1.3 MIDI Timecode Options

The MIDI Timecode Frame Rate setting is relevant only if “MIDI Timecode” is chosen from the MIDI
Input Sync Type menu. The MIDI Timecode Frame Rate chooser selects the type of Timecode to which
Live will synchronize. All of the usual SMPTE frame rates are available. When the Frame Rate is set
to “SMPTE All,” Live auto-detects the Timecode format of incoming sync messages, and interprets
the messages accordingly. Note that you can adjust the Timecode format that is used for display in
the Arrangement View: Go to the Options menu, then access the Time Ruler Format sub-menu.

The MIDI Timecode Start Offset setting is also only relevant if “MIDI Timecode” is chosen from
the Sync Type menu. You can specify a SMPTE time offset using the MIDI Timecode control. Live
interprets this value as the Arrangement’s start time.

23.1.4 Sync Delay

The Sync Delay controls, separately available for the sync input (Live acting as sync slave) and output
(Live acting as sync master), allow you to delay Live’s internal time base against the sync signal.
This can be useful to compensate for delays incurred by the signal transmission. To adjust the Sync
Delay, have both Live and other sequencer play a rhythmical pattern with pronounced, percussive
sounds. While listening to the output from both, adjust the Sync Delay control until both sounds
are in perfect sync.

Sync
Input
MPU-401 Sync Delay
MIDI Timacoda Timecode Rate
MIDI Clock Timecode Offset [ |./o |:[o |0
Qutput
MNome 0.00 ms| Sync Delay

Adjusting Sync Delay.
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23.2 Connecting via ReWire

Live supports the ReWire interface for connecting with another ReWire-compatible audio program
running on the same computer.

The ReWire technology, developed by Propellerhead Software, provides ReWire-compatible programs
with:

e common access to the audio hardware;

shared transport functionality;
e synchronization to audio word clock and song positioning;
¢ exchange of audio streams.

The programs in a ReWire connection play distinct roles: The Relfire master accesses the audio
hardware and provides mixing facilities; the Rellire slaves have no direct link to the audio hardware,
but instead send their audio output into the Master’s mixer.

Common ReWire master applications are Digidesign Pro Tools, Steinberg Cubase and Nuendo, Emagic
Logic Audio, MOTU Digital Performer, Cakewalk Sonar and Cycling 74 Max/MSP. Common ReWire slave
applications are Propellerheads Rebirth, Propellerheads Reason, Arturia Storm, Cakewalk Project 5
and Cycling 74 Max/MSP. Live can act as both a ReWire master and slave.

Note that the ReWire protocol itself does not consume much CPU power. However, as expected,
running two audio-intensive programs on the same computer requires more resources than running
a single program.

23.2.1 Running Live in ReWire Master Mode

The step-by-step procedure for sending MIDI to and receiving audio from a ReWire slave program is
presented in the routing chapter (see ReWire Slave Routing).
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23.2.2 Running Live in ReWire Slave Mode

If you have not used Live yet, please launch Live so that it can install its ReWire engine in your
system.

Live will run in ReWire slave mode if it detects a running ReWire master application at startup time.
Therefore, always start the ReWire master application first, and then start Live.

Likewise, you will first have to quit Live, then the ReWire master application.
Live’s operation in ReWire slave mode differs from the usual operation in some regards:

e Live will not have direct access to the audio interfaces; audio input/output is handled by the
ReWire master application. No audio input will be available to Live.

e The sample rate is determined by the host application rather than by Live.

o External synchronization will be disabled (synchronize to the ReWire master application in-
stead). Live will not send sync or controller messages to the MIDI output. Controlling Live via
MIDI is still possible.

e |ijve will not act as a ReWire master application. For instance, you cannot run Rebirth as a
ReWire slave of Live while Live is running as a ReWire slave of Cubase. You can, however, run
both Live and Rebirth as ReWire slaves of Cubase at the same time.

23.2.3 More on ReWire

You can find tutorials on connecting Live to specific ReWire master programs at the Ableton tutorial
website.

The Ableton FAQ website is the place to go first if you encounter ReWire-related problems.

If you cannot seem to find an answer there, please contact the Ableton support team.


http://www.Ableton.com/index.php?main=tutorials
http://www.Ableton.com/index.php?main=tutorials
http://www.Ableton.com/index.php?main=faq
http://www.Ableton.com/index.php?main=support

Chapter 24

Computer Audio Resources and
Strategies

Real-time audio processing is a demanding task for general-purpose computers, which were likely
designed to run spreadsheets and surf the internet. An application like Live requires a powerful CPU
and a fast hard disk. This section will provide some insight on these issues, and should help you
avoid and solve problems with running audio on a computer.

24.1 Managing the CPU Load

To output a continuous stream of sound through the audio hardware, Live has to perform a huge
number of calculations every second. If the processor can't keep up with what needs to be calculated,
the audio will have gaps or clicks. Factors that affect computational speed include the processor’s
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clock rate (e.g., speed in MHz or GHz), architecture, memory cache performance (how efficiently the
processor can grab data from memory) and system bus bandwidth - the computer’s “pipeline” through
which all data must pass. For this reason, many people involved with pro audio use computers that

are optimized for musical applications.

3.1, 1|~ || - 4. 0. 0 KEY | miDI gﬂ

Master

1

The Control Bar's CPU meter displays how much of the processor’'s computational potential is currently
being used. For example, if the displayed percentage is 10 percent, the computer is just loafing
along. If the percentage is 100 percent, the processor is being maxed out - it's likely that you will
hear gaps, clicks or other audio problems. Note that the CPU meter takes into account only the load
from processing audio, not other tasks the computer performs (e.g., managing Live's user interface).

Audio calculations have the highest priority in Live. Therefore, even if the CPU shows a high
percentage of processor usage, the audio stream should remain uninterrupted. However, non-critical
functions (such as screen redraws) might slow down because these tasks are handled only when the
audio processing “lightens up” a bit.

24.1.1 CPU Load from Multichannel Audio

One source of constant CPU drain is the process of moving data to and from the audio hardware.
This drain can be minimized by disabling any inputs and outputs that are not required in a project.
There are two buttons in the Audio Preferences to access the Input and Output Configuration dialogs,
which allow activating or deactivating individual ins and outs.

Live does not automatically disable unused channels, because the audio hardware drivers usually
produce an audible “hiccup” when there is a request for an audio configuration change.

The CPU Load Meter.
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24.1.2 CPU Load from Tracks and Devices

Generally, every track and device being used in Live incurs some amount of CPU load. However, Live
is “smart” and avoids wasting CPU cycles on tracks and devices that do not contribute anything
useful.

For example, dragging devices into a Live Set that is not running does not significantly increase
the CPU load. The load increases only as you start playing clips or feed audio into the effects.
When there is no incoming audio, the effects are deactivated until they are needed again. (If the
effect produces a “tail,” like reverbs and delays, deactivation occurs only after all calculations are
complete.)

While this scheme is very effective at reducing the average CPU load of a Live Set, it cannot reduce
the peak load. To make sure your Live Set plays back continuously, even under the most intense
conditions, play back a clip in every track simultaneously, with all devices enabled.

24.2 Managing the Disk Load

A hard drive’s access speed (which is related to, but not identical to, rotational speed) can limit
Live’s performance. Most audio-optimized computers use 7200 RPM or faster drives. Laptops, to save
power, often use 5400 RPM or slower drives, which is why projects on laptops usually have lower
track counts. The amount of disk traffic Live generates is roughly proportional to the number of
audio channels being written or read simultaneously. A track playing a stereo sample causes more
disk traffic than a track playing a mono sample.

KEY | MIDI 34 % |

Master

7

The Disk Overload Indicator.
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The Disk Overload indicator flashes when the disk was unable to read or write audio quickly enough.
When recording audio, this condition causes a gap in the recorded sample; when playing back, you
will hear dropouts.

Do the following to avoid disk overload:

e Reduce the amount of audio channels being written by choosing mono inputs instead of stereo
inputs in the Audio Preferences’ Channel Configuration dialog.

® Use RAM Mode (see Clip RAM Mode) for selected clips.

® Reduce the number of audio channels playing by using mono samples instead of stereo samples
when possible. You can convert stereo samples to mono using any standard digital audio
editing program, which can be called up from within Live (see Destructive Sample Editing).
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Live Keyboard Shortcuts

25.1 Showing and Hiding Views

Windows Macintosh
Toggle Full Screen Mode F11 ctl J(F11
Toggle Session/Arrangement View N 5
Toggle Track/Clip View %S % 4 %
Hide/Show Track/Clip View ) F12 ] ) F12
Double-Click Clip / Track | Double-Click Clip / Track
Hide/Show Info View 2] (2]
Hide/Show Overview (cl At ][O @ F A J0)
Hide/Show Clips cul JAt  JP] G WAt JP)
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Hide/Show In/Out (cul JAt 0] (& #®Ar )
Hide/Show Sends (cul )AL ][s) (& ®At ~J[s)
Hide/Show Mixer (cul JAt M) (& )ALt ~JM)
Hide/Show Crossfader | [(Cul (At ][F) & #®At JF)
Open the Preferences | N/A G $) ]

Close the Preferences | N/A (Esc ]

25.2 Accessing Menus
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Under Windows, you can access each menu by pressing and the first letter of the menu

( (At J[F] for “File”, for instance). While a menu is open, you can use:

e (JJ[®) to navigate the menu items;
e [(«J>) to open the neighboring menu;
o to choose a menu item.

25.3 Adjusting Values

Windows Macintosh
Increment/Decrement
Large Increment/Decrement (¥ Page (+ Page) (¥ Page) [+ Page)
Return to Default Delete) =
Type in Value 0] .. 9) 0] .. @]
Go to Next Field (Bar.beat.16th) | [ (] (0]
Abort Value Entry (Esc ) (Esc )
Confirm Value Entry Return) Return
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25.4 Transport
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Windows Macintosh
Play from Start Marker/Stop Space Space)
Continue Play from Stop Point (& ](Space) (0 ](space)
Play Arrangement View Selection Ctrl  )(Space Alt ~-) [Space
Record (Fo ) (Fo )
Back to Arrangement F10 F10 |
Activate/Deactivate Track 1..8 (F1 ] .. (F8 (F1 ] .. (F8
25.5 Editing

Windows Macintosh
Cut cl J(x] S
Copy cl)[C] 3
Paste (Cul ) IS
Duplicate | [Cul ](D] & %Db)
Delete (Delete] (- ]
Undo (cul ] (CIES
Redo (cul (y) G &)
Rename cul ([E] G *8
Select AL | [Ctl [A] CEESIN

By holding down an additional modifier key, some of the above commands can also be applied to:
Windows | Macintosh

Clips and Slots Across all Tracks O £H
Time Across all Tracks ) )
The Selected Part of the Envelope | (Alt




25.6. LOOP/REGION AND START

MARKERS

304

can be used to move from one track or scene to another while renaming.

25.6 Loop/Region and Start Markers

Loop/Region markers must first be selected before any of the following commands will apply to

them.
Windows Macintosh

Move Start Marker to Position ) Click (& ) Click
Nudge Loop/Region Left Right (> (&
Move Loop/Region By Length
Double/Halve Loop/Region (Cul ][4 (CEESIEIE
Shorten/Lengthen Loop/Region | (Cl_ )« 3G
Select Material in Loop Click Loop Brace | Click Loop Brace

25.7 Session View Commands

Windows Macintosh
Launch Selected Clip/Slot Return Return)
Select Neighbouring Clip/Slot | Arrow Keys Arrow Keys
Select all Clips/Slots Ctrl 3 R
Copy Clips (Cl ] Drag (At =] Drag
Add/Remove Stop Button Ctrl G R

Insert MIDI clip

(Curl

(4D (M) or Double-Click Slot

3 H (M] or Double-Click Slot

Insert Scene ctl (1) IS
Insert Captured Scene (crl 1D (1) S (1)
Drop Browser Clips as a Scene Ctrl G R
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25.8 Arrangement View Commands
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The shortcuts for zooming (see Zooming, Display and Selections), snapping/drawing (see Grid Snap-
ping and Drawing) and Loop/Region markers (see Loop/Region and Start Markers) also work in the

Arrangement View.

Windows Macintosh
Split Clip at Selection crl JE G &
Consolidate Selection into Clip | (Ctl (0 G %]
Loop Selection cul L IS
Zoom around Selection += =)
Insert Silence cul (i © R0
Pan Left/Right of Selection Ctrl  J[Alt G FJAIL =
Unfold all Tracks Alt Unfold button | [Alt - Unfold button

25.9 Commands for Tracks

Windows Macintosh
Insert Audio Track Ctrl CEE:
Insert MIDI Track & Jcul ) L )G KT
Insert Return Track Ctrl J(Alt G HAL
Rename Selected Track (cul JE) G B E)
While Renaming, Go to next Track - 5
Arm/Solo Multiple Tracks (Ctul ) Click (& 98 Click
Add Device from Browser Double-Click Double-Click
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25.10 Commands for Breakpoint Envelopes

The shortcuts for zooming (see Zooming, Display and Selections), snapping/drawing (see Grid Snap-
ping and Drawing) and Loop/Region markers (see Loop/Region and Start Markers) also work in the
Envelope Editor and Arrangement View.

Windows | Macintosh
Finer Resolution for Dragging Curl G %
Enable Dragging Over Breakpoints 4N o

25.11 Key and MIDI Map Mode

Windows Macintosh
Toggle MIDI Map Mode | (Ctrl (M) (CRE3Y)
Toggle Key Map Mode ctrl (K] RS

25.12 Zooming, Display and Selections

Windows Macintosh
Zoom In
Zoom Out (-] =)
Drag/Click to Append to a Selection o 4O
Follow (Auto-Scroll) (crl )[F) © BIF)
Pan Left/Right of Selection (Cul )ALt ) & ®Aar
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25.13 Clip View Sample Display

The shortcuts for zooming (see Zooming, Display and Selections) and Loop/Region markers (see
Loop/Region and Start Markers) also work in the Sample Display.

Windows Macintosh
Move Selected Warp Marker
Select Warp Marker (Cul )« G %«

25.14 Clip View MIDI Editor

The shortcuts for zooming (see Zooming, Display and Selections), snapping/drawing (see Grid Snap-
ping and Drawing) and Loop/Region markers (see Loop/Region and Start Markers) also work in the
MIDI Editor.

Windows Macintosh
Quantize (Crl (U] @ U
Scroll Editor Vertically v Page] [ Pagel v Pagel(t Page
Scroll Editor Horizontally (Ctrl)[¥ Page)(* Page G (¥ Pagel [t Page)
Copy Note Ctrl Drag Alt - Drag
Change Velocity From Note Editor | (At ] Drag G % Drag
Add/Delete Note in Edit Mode Double-Click Double-Click




25.15. GRID SNAPPING AND DRAWING

25.15 Grid Snapping and Drawing

Windows Macintosh
Toggle Draw Mode cu © B
Narrow Grid (i ){) (CEEIN
Widen Grid Crl (CIES
Triplet Grid (Ctl (3] @ &#B)

Snap to Grid

Cu Ja] | & Hl)

Bypass Snapping While Dragging

(Al

()

25.16 Working with Sets and the Program

Windows Macintosh
New Live Set Cul (CIES
Open Live Set [l )[0) @ &0
Close Live Set Cul G W
Save Live Set Cul )[s) @ (s]
Save Live Set As. .. 4} cl Js] & ) %
Quit Live [Cul Q) c %
Hide Live Curl (IS
Render to Disk (crl IR G B[R]
Export MIDI file cul )& JE (CHES|
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25.17 Working with Plug-Ins

Windows Macintosh
Show/Hide Plug-In Windows cul [P G HBP)
Open Second/Multiple Windows with Plug-In Edit Button Ctrl 3 R
Open Mac Keystroke Plug-In Window with Plug-In Edit Button | N/A 4N
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